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1 Introduction

1.1 Purpose of the Operating Guide

The purpose of this operating guide is to describe the VLT®Servo Drive System ISD 520/DSD 520.

This operating guide contains information about:

l Installation

l Commissioning

l Programming

l Operation

l Troubleshooting

l Service and maintenance

This operating guide is intended for use by qualified personnel. Read the operating guide in full to use the servo system safely and

professionally, and pay particular attention to the safety instructions and general warnings. Always keep this operating guide available

with the servo system.

Compliance with the information in the guide is a prerequisite for:

l Trouble-free operation

l Recognition of product liability claims

Therefore, read this operating guide before working with the ISD 520/DSD 520 system.

1.2 Additional Resources

Table 1: Additional Resources

Guide Description

VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT® FlexMo-
tion™) Design Guide

Information about the setup of the ISD 520/DSD 520 servo system
and detailed technical data.

VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT® FlexMo-
tion™) Programming Guide

Information about the programming of the ISD 520, DSD 520, and
MSD 520 servo systems.

Advanced Functional Safety for VLT® FlexMotion™ Operating
Guide

Information about operating the advanced functional safety op-
tion for VLT® FlexMotion™.

1.3 Copyright

VLT® and ISD® are Danfoss registered trademarks.

1.4 Document Version

The original language of this guide is English.

Version Remarks

AQ441543733781, version 01 First version
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1.5 Approvals and Certifications

Table 2: Product and System Approvals and Certifications

Certification Description

IEC/EN 61800-3 Adjustable speed electrical power drive systems.

Part 3: EMC requirements and specific test methods.

IEC/EN 61800-5-1 Adjustable speed electrical power drive systems.

Part 5-1: Safety requirements - Electrical, thermal, and energy.

IEC/EN 61800-5-2 Adjustable speed electrical power drive systems.

Part 5-2: Safety requirements - Functional.

IEC/EN 61508-1 Functional safety of electrical/electronic/programmable electronic
safety-related systems.

Part 1: General requirements.

IEC/EN 61508-2 Functional safety of electrical/electronic/programmable electronic
safety-related systems.

Part 2: Requirements for electrical/electronic/programmable elec-
tronic safety-related systems.

EN ISO 13849-1 Safety of machinery - Safety-related parts of control systems.

Part 1: General principles for design.

EN ISO 13849-2 Safety of machinery - Safety-related parts of control systems.

Part 2: Validation.

IEC/EN 60529 Degrees of protection provided by enclosures (IP Code).

UL 61800-5-1 Adjustable speed electrical power drive systems.

Part 5-1: Safety requirements - Electrical, thermal, and energy.

CSA C22.2 No. 274 Standard specifying requirements for adjustable speed drives with
regard to electrical, thermal, and energy safety considerations.

CE

2014/30/EU Electromagnetic Compatibility (EMC) Directive.

2014/35/EU Low Voltage Directive (LVD).

2011/65/EU amended (EU) 2015/863 Restriction of Hazardous Substances (RoHS).

2006/42/EC Machinery Directive (MD).

Ethernet POWERLINK® Ethernet-based fieldbus system.

Ethernet PROFINET® Ethernet-based fieldbus system.

Ethernet PROFIsafe® Safety profile for sending safety-critical data via PROFINET.

Ethernet EtherCAT® Ethernet-based fieldbus system.

EtherCAT® is a registered trademark and patented technology, li-
censed by Beckhoff Automation GmbH, Germany.
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Table 2: Product and System Approvals and Certifications (continued)

Certification Description

Safety over EtherCAT® (FSoE) Safety profile for sending safety-critical data over EtherCAT®.

Safety over EtherCAT® is a registered trademark and patented
technology, licensed by Beckhoff Automation GmbH, Germany.

PLCopen® Technical specification. Function blocks for motion control (for-
merly Part 1 and Part 2) Version 2.0 March 17, 2011.

1.6 Firmware Updates

Updates to the firmware, VLT® Servo Toolbox software, and PLC libraries may be available. When updates are available, they can be

downloaded from the Danfoss website (http://drives.danfoss.com).

Use the VLT® Servo Toolbox software or the PLC libraries to install the firmware on the servo drives or on the PSM 510 and DAM 510.

1.7 Terminology

Table 3: Terminology

Term Description

ACM 510 Auxiliary Capacitors Module

DAM 510 Decentral Access Module that connects the decentral servo drives
(ISD 520 and DSD 520) to the servo system via a hybrid cable.

DSD 520 Decentral Servo Drive

DSD 520 system components Includes DSD 520 servo drives, PSM 510, DAM 510, and the op-
tional ACM 510 and EXM 510.

EXM 510 Expansion module for splitting system modules between 2 control
cabinets.

Feed-in cable Hybrid cable for connection from the DAM 510 to the 1st decen-
tral drive.

ISD 520 Integrated Servo Drive

ISD 520 system components Includes ISD 520 servo drives, PSM 510, DAM 510, and the optional
ACM 510 and EXM 510.

LCP Local control panel

Loop cable Hybrid cable for connecting servo drives in daisy-chain format.

PLC Programmable Logic Controller (external device for controlling the
servo system).

PSM 510 Power Supply Module that generates a 565–680 V DC supply.

System modules Includes PSM 510, DAM 510, and the optional ACM 510 and
EXM 510.

VIN PSM Input of PSM 510 (V AC).

VOUT PSM Output of PSM 510 (V DC).
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2 Safety

2.1 Safety Symbols

The following symbols are used in Danfoss documentation.

  DANGER

Indicates a hazardous situation which, if not avoided, will result in death or serious injury.

  WARNING

Indicates a hazardous situation which, if not avoided, could result in death or serious injury.

  CAUTION

Indicates a hazardous situation which, if not avoided, could result in minor or moderate injury.

  NOTICE

Indicates information considered important, but not hazard-related (for example, messages relating to property damage).

The guide also includes ISO warning symbols related to hot surfaces and burn hazard, high voltage and electrical shock, and referring to

the instructions.

ISO warning symbol for hot surfaces and burn hazard

ISO warning symbol for high voltage and electrical shock

ISO action symbol for referring to the instructions

2.2 Important Safety Warnings

The following safety instructions and precautions relate to the ISD 520/DSD 520 servo system. Read the safety instructions carefully

before starting to work in any way with the servo system or its components. Pay particular attention to the safety instructions in the

relevant sections of this guide.

  WARNING

HAZARDOUS SITUATION

If the servo system components, or the bus lines are incorrectly connected, there is a risk of death, serious injury, or damage to the

unit.

l Always comply with the instructions in this guide and national and local safety regulations.
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  WARNING

HIGH VOLTAGE

The servo system contains components that operate at high voltage when connected to the electrical supply

network. Not all components have indicators that indicate the presence of mains supply. Incorrect installation,

commissioning, or maintenance may lead to death or serious injury.

l Installation, commissioning, and maintenance may only be performed by qualified personnel.

  WARNING

DISCHARGE TIME

The servo system contains DC-link capacitors that remain charged for some time after the mains supply is

switched off at the Power Supply Module (PSM 510). Failure to wait the specified time after power has been

removed before performing service or repair work could result in death or serious injury.

l To avoid electric shock, fully disconnect the Power Supply Module (PSM 510) from the mains and wait

for the capacitors to fully discharge before carrying out any maintenance work on the servo system or

replacing components.

Minimum waiting time (minutes)

15

  DANGER

RISQUE DU CHOC ÉLECTRIQUE

Une tension dangereuse peut être présentée jusqu’à 15 min après avoir coupé l’alimentation.

  WARNING

LEAKAGE/GROUNDING CURRENT HAZARD

Leakage/grounding currents are >3.5 mA. Improper grounding of the ISD 520/DSD 520 servo drives and the

system modules may result in death or serious injury.

l For reasons of operator safety, use a certified electrical installer to ground the system correctly in

accordance with the applicable local and national electrical standards and directives, and the instructions

in this guide.

  WARNING

UNINTENDED START

The servo system contains servo drives, the PSM 510, and DAM 510 that are connected to the electrical supply network and can

start running at any time. This may be caused by a fieldbus command, a reference signal, or clearing a fault condition. Servo drives

and all connected devices must be in good operating condition. A deficient operating condition may lead to death, serious injury,

damage to equipment, or other material damage when the unit is connected to the electrical supply network.

l Take suitable measures to prevent unintended starts.
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  WARNING

UNINTENDED MOVEMENT

Unintended movement may occur immediately when parameter changes are carried out, which may result in death, serious

injury, or damage to equipment.

l When changing parameters, take suitable measures to ensure that unintended movement cannot pose any danger.

  CAUTION

DANGER OF BURNS

The surface of the servo drives can reach high temperatures of over 90 °C during operation.

l Do not touch the servo drives until they have cooled down.

  CAUTION

CONNECTING/DISCONNECTING HYBRID CABLES

Never connect or disconnect the hybrid cable to or from the servo drives when the servo system is connected to mains or auxiliary

supply, or when voltage is still present. Doing so damages the electronic circuitry. Ensure that the mains supply is disconnected

and the required discharge time for the DC-link capacitors has elapsed before disconnecting or connecting the hybrid cables to

the PSM 510.

l To avoid electrical shock, fully disconnect the PSM 510 from the mains and wait for the discharge time to elapse before

disconnecting or connecting the hybrid cables or disconnecting cables from the PSM 510.

  NOTICE

RCD COMPATIBILITY

The servo system contains components that can cause a DC current in the protective earthing conductor, which may result in

malfunction in any devices connected to the system.

l Where a residual current-operated protective (RCD) or monitoring (RCM) device is used for protection if there is direct or

indirect contact, use a type B RCD or RCM device on the supply side of the system components.

2.3 Safety Instructions and Precautions

Compliance with the safety instructions and precautions is necessary at all times.

l Orderly and proper transport, storage, fitting, and installation, as well as careful operation and maintenance, are essential for the

trouble-free and safe operation of the servo system and its components.

l Only suitably trained and qualified personnel may work on the servo system and its components or in its vicinity.

l Only use accessories and spare parts approved by Danfoss.

l Comply with the specified ambient conditions.

l The information in this guide about the use of available components is provided solely by way of examples of applications and

suggestions.

l The plant engineer or system engineer is personally responsible for checking the suitability of the supplied components and the

information provided in this guide for the specific application concerned:

¢ For compliance with the safety regulations and standards relevant to the specific application.

¢ For implementing the necessary measures, changes, and extensions.
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l Commissioning the servo system or its components is not allowed until it has been ascertained that the machine, system, or plant in

which they are installed conforms to the statutory provisions, safety regulations, and standards that apply to the application in the

country of use.

l Operation is only allowed in compliance with the national EMC regulations for the application concerned.

l Compliance with the limit values specified by national regulations is the responsibility of the producer of the plant, system, or

machine.

l Compliance with the specifications, connection conditions, and installation conditions in this guide is mandatory.

l The safety regulations and safety provisions of the country in which the equipment is used must be observed.

l To protect the user against electric shock and to protect the servo system against overload, protective grounding is obligatory and

must be performed in accordance with local and national regulations.

2.4 Operational Safety
l Safety-related applications are only allowed if they are explicitly and unambiguously mentioned in this guide.

l All applications that can cause hazards to people or damage to property are safety-related applications.

l The stop functions implemented in the software of the PLC do not interrupt the mains supply to the Power Supply Module

(PSM 510). Therefore, they must not be used for electrical safety for the servo system.

l The servo system can be brought to a stop by a software command or a zero speed setpoint, however DC voltage remains present

on the servo drives and/or mains voltage in the PSM 510. Also, when the system is stopped, it may start up again on its own if the

circuitry is defective or after the elimination of a temporary overload, a problem with the supply voltage, or a problem with the

system. If personal safety considerations (for example, risk of personal injury caused by contact with moving machine parts after an

unintended start) make it necessary to ensure that an unintended start cannot occur, these stop functions are not sufficient. In this

case, ensure that the servo system is detached from the mains network, and prevent unintended motor starting, for example, by

using the safe torque off (STO) function.

l The servo system may start running unintentionally during parameter configuration or programming. If this poses a risk to personal

safety (for example, risk of personal injury due to contact with moving machine parts), prevent unintended motor starting, for

example by using the safe torque off (STO) function, or by safe disconnection of the servo drives.

l In addition to the L1, L2, and L3 supply voltage inputs on the PSM 510, the servo system has other supply voltage inputs, including

external auxiliary voltage. Before commencing repair work, check that all supply voltage inputs have been switched off and that the

necessary discharge time for the DC-link capacitors has elapsed.

2.5 Qualified Personnel

Installation, commissioning, and maintenance may only be carried out by qualified personnel. For the purposes of this guide and the

safety instructions in this guide, qualified personnel are trained personnel who are authorized to fit, install, commission, ground, and

label equipment, systems, and circuits in accordance with the standards for safety technology and who are familiar with the safety

concepts of automation engineering.

Also, the personnel must be familiar with all the instructions and safety measures described in this guide. They must have suitable safety

equipment and be trained in first aid.

2.6 Due Diligence

The operator and/or fabricator must ensure that:

l The servo system and its components are used only as intended.

l The components are operated only in a perfect operational condition.

l The operating instructions are always available near the servo system in complete and readable form.

l The servo system and its components are fitted, installed, commissioned, and maintained only by adequately qualified and

authorized personnel.
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l These personnel are regularly instructed on all relevant matters of occupational safety and environmental protection, as well as the

contents of the operating instructions and the instructions it contains.

l The product markings and identification markings applied to the components, as well as safety and warning instructions, are not

removed and are always kept in a legible condition.

l The national and international regulations regarding the control of machinery and equipment, that are applicable at the place of use

of the servo system, are complied with.

l The users always have all current information relevant to their interests about the servo system and its use and operation.

2.7 Intended Use

The components of the servo system are intended to be installed in machines used in industrial environments in accordance with local

laws and standards.

  NOTICE

l In a domestic environment, this product may cause radio interferences, in which case supplementary mitigation measures

may be required.

To ensure that the product is used as intended, the following conditions must be fulfilled before use:

l Everyone who uses Danfoss products in any manner must read and understand the corresponding safety regulations and the

description of the intended use.

l Do not alter hardware from its original state.

l Do not reverse-engineer software products or alter their source code.

l Do not install or operate damaged or faulty products.

l Ensure that the products are installed in conformance with the regulations mentioned in the documentation.

l Observe any specified maintenance and service intervals.

l Comply with all protective measures.

l Only fit or install the components described in this operating guide. Third-party devices and equipment may be used only in

consultation with Danfoss.

2.7.1 Prohibited Application Areas

The servo system may not be used in the following application areas:

l Areas with potentially explosive atmospheres.

l Mobile or portable systems.

l Floating or airborne systems.

l Inhabited facilities.

l Sites where radioactive materials are present.

l Areas with extreme temperature variations or in which the maximum rated temperatures may be exceeded.

l Under water.

2.8 Foreseeable Misuse

Any use not expressly approved by Danfoss constitutes misuse. This also applies to failure to comply with the specified operating

conditions and applications. Danfoss assumes no liability of any sort for damage attributable to improper use.

2.9 Service and Support

Contact the local service representative for service and support.
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3 System Description

3.1 Overview of the ISD 520/DSD 520 Servo System
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Figure 1: Overview of the ISD 520/DSD 520 System

1 AC line choke

The VLT® Servo Drive System ISD 520/DSD 520 is a high-performance decentral servo motion solution. In this decentral system,

the ISD 520/DSD 520 servo drives are operated in a DC group, controlled by a PLC, and supplied by PSM 510 and DAM 510. The

decentralization of the drive unit offers benefits in mounting, installation, and operation.

Hybrid cables are used to connect the ISD 520/DSD 520 servo drives, making installation fast and simple. These hybrid cables contain the

DC-link supply, the Real-Time Ethernet, UAUX, and STO signals.

The ISD 520/DSD 520 system is designed to accommodate various servo drives and consists of:

l VLT® Integrated Servo Drive ISD 520

l VLT® Decentral Servo Drive DSD 520

l Power Supply Module (PSM 510)

l Decentral Access Module (DAM 510)

l Auxiliary Capacitors Module (ACM 510), optional

l Expansion Module (EXM 510), optional

l Cabling infrastructure

l Blind caps
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l Software

¢ Firmware for the servo drive

¢ Firmware for the PSM 510, DAM 510, and ACM 510

¢ Pc software tool: VLT®Servo Toolbox

¢ PLC libraries

n Danfoss Motion library for ISD 520/DSD 520 system for AutomationStudio®.

n Danfoss Motion library for ISD 520/DSD 520 system for TwinCAT 3.

n Danfoss Motion library for ISD 520/DSD 520 system for TiA Portal.

The system modules PSM 510, DAM 510, and ACM 510 are mounted to a backplate located in the control cabinet. DC link and the control

voltage supply are integrated in the backplate. The 'click and lock' backplate concept offers easy mounting and installation.

The ISD 520 servo drives are self-contained distributed drives, whereby the drive electronics are housed together with the motor in the

same casing. The DSD 520 servo drives are decentral servo drives for mounting close to the servo motor.

Options available for ISD 520/DSD 520:

l Standard I/O board

l VLT® FlexSafety™ (FS Control board)

l Safe I/O board (only in combination with FS Control board)

The motion control is integrated into the servo drive so that the motion sequences can take place independently. This reduces the

required computing power of the central PLC and offers a highly flexible drive concept. Danfoss offers libraries for various IEC 61131-3

programmable PLCs. Due to the standardized and certified fieldbus interfaces of the devices, any PLC with an EtherCAT® master

functionality, or Ethernet POWERLINK® or PROFINET® managing node functionality according to the standards can be used.

  NOTICE

l The ISD 520/DSD 520 servo drives cannot be used in servo systems from other manufacturers without changing the cabling

infrastructure.

l Drives from other manufacturers cannot be used in the ISD 520/DSD 520 servo system.

l Only the components described in this guide may be fitted or installed. Third-party devices and equipment may be used only

in consultation with Danfoss.

l For security reasons, do not connect the ISD 520/DSD 520 servo drive to the internet.

l Only configure the ISD 520/DSD 520 using the specified HMI or the VLT® Servo Toolbox software.

l Contact Danfoss for further information.

3.2 VLT® Integrated Servo Drive ISD 520

3.2.1 Overview of the ISD 520 Servo Drive

ISD is the abbreviation of integrated servo drive, which is a compact drive with an integrated permanent magnet synchronous motor

(PMSM). This means that the entire power drive system consisting of motor, position sensor, mechanical brake, and also power and

control electronics is integrated into 1 housing. Additional circuits, such as low voltage supply, bus drivers, and functional safety are

implemented within the servo drive electronics. All ISD 520 servo drives have 2 hybrid connectors (M23) that connect power and

communication signals from a hybrid cable. There are 3 additional interfaces for external encoder or I/Os, fieldbus devices, and for the

local control panel (LCP) to be connected directly. Indicator lights (LEDs) on the top of the ISD 520 servo drive show the current status.

Data transfer takes place via Real-Time Ethernet.
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Figure 2: Overview of the ISD 520 Servo Drive

1 Operating indicator lights (LEDs) 2 Connectors

3.2.2 Motor and Flange Sizes

Table 4: Motor and Flange Sizes

Enclosure
size

E0 E1 E2

Drive size 1 2 1 2 3 4 5

Rated
torque [Nm]

1.5 2.5 1.5 2.5 3.5 4.0 5.0 6.5 9.0 12.0 14.0 16.5 19.0

Flange size
[mm]

70 87 70 91 100 116 142

Shaft size
[mm]

11 19 11 14 19 24 32

Rated
speed [nN]

3000 2000 3000 2200

3.2.3 ISD 520 Servo Drive Types

  NOTICE

l The type code defines the specification of the ISD 520 servo drive included in the delivery. It is shown on the product label

and the package label.

l The type code is made of standard codes and plus codes. Each part of the type code corresponds to the data in the order.

l The Drive Configurator shows the valid configuration of servo drive variants.

l Only selected options are visible in the type code. Standard characteristics do not appear.
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Table 5: Type Code for ISD 520 Servo Drive
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ISD-520 D6 –01T5

–02T5

–03T5

–04T0

–04T5

–05T0

–06T5

–09T0

–12T0

–14T0

–16T5

See Table 6.
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Table 6: Legend to Type Code

1 Product group + Technical docu-
mentation

+ Flange size (con-
tinued)

ISD-520 VLT® Integrated
Servo Drive 520

+EGXX None (standard) +FG100 100 mm

2 Mains voltage +EGIN Installation guide +FG116 116 mm

D6 600 V DC + Documentation
language

+FG142 142 mm

3 Torque level
(rated)

+EHXX Multilanguage
(standard)

+ Gear

–01T5 1.5 Nm + Customer-specific
label

+FHXX Without gear (stan-
dard)

–02T5 2.5 Nm +EJXX None (standard) + Rated speed

–03T5 3.5 Nm + Mechanical brake +FN04 400 RPM

–04T0 4.0 Nm +FAXX Without holding
brake (standard)

+FN10 1000 RPM

–04T5 4.5 Nm +FAHB With holding brake +FN20 2000 RPM

–05T0 5.0 Nm + Motor shaft +FN22 2200 RPM

–06T5 6.5 Nm +FCSS Smooth shaft +FN30 3000 RPM

–09T0 9.0 Nm +FCKS Fitted key +FN45 4500 RPM

–12T0 12.0 Nm + Motor shaft size +FN60 6000 RPM

–14T0 14.0 Nm +FD11 11 mm + Shaft seal

–16T5 16.5 Nm +FD14 14 mm +FSXX Without shaft seal

4 Communication in-
terface

+FD19 19 mm +FSSS With shaft seal

PL Ethernet POWER-
LINK®

+FD24 24 mm + Shipping package

EC EtherCAT® +FD32 32 mm +TACB Individually pack-
aged (standard)

PN PROFINET® + Feedback type +TAMP All products
shipped in 1 pack-
age

+ Functional Safety +FFS0 Single-turn 17-bit
BISS-C

+BEF1 Hard-wired STO
(standard)

+FFS1 Single-turn 17-bit
HIPERFACE® DSL

+BEFS VLT® FlexSafety™

over fieldbus
+FFM1 Multi-turn 17-bit

HIPERFACE® DSL

+ Option board +FFM3 Safety multi-turn
20-bit HIPERFACE®
DSL

+CTXX Without option
board (standard)

+ Flange size
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Table 6: Legend to Type Code (continued)

+CTIO Standard I/O option
board

+FG070 70 mm

+CTSO Safe I/O option
board

+FG087 87 mm

+FG091 91 mm

3.2.4 Motor Components

3.2.4.1 Shaft

The shaft transfers the motor force (torque) to the machine coupled to the shaft. The shaft material is C45+C or equivalent according to

EN 10277-2. The ISD 520 servo drives are sealed by a shaft seal to achieve IP65 on the A-side of the motor (see 11.12.1 Protection Ratings

for ISD 520 Servo Drive).

3.2.4.2 Brake (Optional)

The optional mechanical holding brake is designed as a single-disc brake. The emergency stop function can be initiated at most once

every 3 minutes and up to 2000 times in total, depending on the load.

The brake operates as a holding brake according to the fail-safe principle closed when no current is present. It is powered from the DC

auxiliary supply. This enables low-backlash load holding when no current is present.

If a mechanical brake is connected, always supply the servo system with 48 V auxiliary voltage.

See the tables in 11.2.1 Characteristic Data for ISD 520 Servo Drive  for brake weight, inertia, power, and holding torque.

  NOTICE

l Do not misuse the holding brake as a working brake because this causes increased wear, resulting in premature failure.

l Using ISD 520 servo drives with brakes can reduce the number of drives allowed, depending on the total length of each

hybrid line.

3.2.4.3 Cooling

The ISD 520 servo drives are self-cooling. Cooling (heat dispersal) is primarily via the flange, with a small amount dispersed by the

housing.

3.2.4.4 Thermal Protection

Thermal sensors monitor the maximum allowable temperature of the motor winding and switch the motor off if the limit of 140 °C is

exceeded. Thermal sensors are also present in the drive to protect the electronics against overtemperature. An error message is sent via

Real-Time Ethernet to the higher-level PLC and is also shown on the LCP.

3.2.4.5 Built-in Feedback Devices

The built-in feedback device measures the rotor position.

There are 3 feedback variants available:

l BiSS-C 17-bit single-turn encoder

l HIPERFACE® DSL 17-bit encoder, single-turn or multi-turn

l HIPERFACE® DSL 22-bit encoder, single-turn or multi-turn
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Table 7: Built-in Feedback Devices

Data/type Single-turn encoder Single-turn encoder Multi-turn encoder Single-turn encoder Multi-turn encoder

Signal Biss-C HIPERFACE® DSL HIPERFACE® DSL HIPERFACE® DSL HIPERFACE® DSL

Accuracy ±6 arcmin ±6 arcmin ±6 arcmin ±1.6 arcmin ±1.6 arcmin

Resolution 17 bit 17 bit 17 bit 20 bit 20 bit

Multiturn No No Yes, –4096 (12 bit) No Yes, –4096 (12 bit)

Safety No No No Yes Yes

3.2.5 Drive Components

3.2.5.1 Connectors on the ISD 520 Servo Drives

There are 5 connectors on the ISD 520 servo drives.

e3
0b

l1
00

.1
0

Figure 3: Connectors on the ISD 520 Servo Drive

Table 8: Connectors on the ISD 520 Servo Drive

Connector Description

X1 M23 connector for feed-in or loop hybrid cable input

X2 M23 connector for loop hybrid cable output or fieldbus extension

X3 M12 connector for Safe/Standard I/O (channel A)

X4 M12 connector for Safe/Standard I/O (channel B)

X5 M8 connector for LCP cable (shielded)

3.3 VLT® Decentral Servo Drive DSD 520

3.3.1 Overview of the DSD 520 Servo Drive

DSD is the abbreviation of decentral servo drive, which is a servo drive for mounting close to the servo motor. In this way, the servo

motor has no impact to the DSD 520 servo drive from a thermal point of view.

The DSD 520 servo drive extends the selection of a decentral servo drive concept. It delivers rated power up to 3 kW and can be used

with a wide range of permanent magnet servo motors and motor feedback encoders.
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Indicator lights (LEDs) on the top of the DSD 520 servo drive show the current status. Data transfer takes place via Real-Time Ethernet.
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Figure 4: Overview of the ISD 520 Servo Drive

3.3.2 DSD 520 Servo Drive Types

  NOTICE

l The type code defines the specification of the DSD 520 servo drive included in the delivery. It is shown on the product label

and the package label.

l The type code is made of standard codes and plus codes. Each part of the type code corresponds to the data in the order.

l The Drive Configurator shows the valid configuration of servo drive variants.

l Only selected options are visible in the type code. Standard characteristics do not appear.

Table 9: Type Code for DSD 520 Servo Drive
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DSD-520 D6 –05A0 PL

EC

PN

See Table 10.
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Table 10: Legend to Type Code

1 Product group + Option board + Motor connection

DSD-520 VLT® Decentral
Servo Drive 520

+CTXX Without option
board (standard)

+FITS Terminal box single
connection

2 Mains voltage +CTIO Standard I/O option
board

+FITD Terminal box dual
connection

D6 600 V DC +CTSO Safe I/O option
board

+FIS3 Single plug M23
connection

3 Current rating + Technical docu-
mentation

+FID3 Dual plug M23 con-
nection

–05A0 5.0 A +EGXX None (standard) +FIBE Terminal box bot-
tom entry

4 Communication in-
terface

+EGIN Installation guide + Shipping package

PL Ethernet POWER-
LINK®

+ Documentation
language

+TACB Individually pack-
aged (standard)

EC EtherCAT® +EHXX Multilanguage
(standard)

+TAMP All products
shipped in 1 pack-
age

PN PROFINET® + Customer-specific
label

+ Functional safety +EJXX None (standard)

+BEF1 Hard-wired STO
(standard)

+ Feedback type

+BEFS VLT® FlexSafety™

over fieldbus
+FFMF Multi-feedback in-

terface (standard)(1)

1) Supported feedback systems: BiSS B/C, SSI, Resolver, HIPERFACE®, HIPERFACE® DSL, EnDat 2.1, EnDat 2.2

3.4 Power Supply Module (PSM 510)

3.4.1 Overview of PSM 510

PSM is the abbreviation for Power Supply Module. It is the power supply to the servo system. The PSM 510 supplies a DC power voltage

and guarantees high-density output power. The DC link and 24/48 V DC are distributed via the backlink in the backplates to all system

modules. The PSM 510 can be controlled via Ethernet-based fieldbus.

Indicator lights (LEDs) on the front of the PSM 510 show the operating status and warnings.

  NOTICE

l The system modules are designed for use within a control cabinet. If the STO function is used, the cabinet must be rated at

least IP54.

l The PSM 510 has a protection rating of IP20 according to IEC/EN 60529 (except connectors, which are IP00).

l The PSM 510 may be damaged if exposed to fluids.

All power cables are wired into the PSM 510, therefore at least 1 PSM 510 is required for each system.

The PSM 510 also performs service functions, such as voltage measuring, and is cooled by an internal fan.
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The PSM 510 is available in 3 power sizes and delivers an output power of 10 kW, 20 kW, or 30 kW with 200% overload capacity for 3 s. To

achieve an output power of up to 60 kW, 2 PSM 510 modules can be used in parallel.

An example type code for the PSM 510 is: MSD510PSM510F2P10C0D6E20PLSXXXXXXXXXXXXX.
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Figure 5: PSM 510

1 Backplate 2 24/48 V input connector

3 Cable relief and shielding 4 Connectors: I/O, STO, relay, and Ethernet

5 Operating indicator lights (LEDs) 6 LCP connector

7 PE screws 8 AC mains supply connector

9 Internal/external brake resistor connector

3.5 Decentral Access Module (DAM 510)

3.5.1 Overview of DAM 510

DAM is the abbreviation for Decentral Access Module. The DAM 510 is a central interface/gateway to the decentral servo system. It is

used to connect the Danfoss VLT® Integrated Servo Drives ISD 520 and VLT® Decentral Servo Drives DSD 520 to the servo system via a

hybrid feed-in cable.

The DAM 510 supplies the decentral servo drives with DC link, UAUX, STO, and the Ethernet-based fieldbus via the hybrid feed-in cable.

The DAM 510 provides functions, such as:

l Overcurrent protection of the hybrid cable

l Overvoltage protection

l Charging circuit of the DC link
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l External encoder connection

l DC-link capacitance buffer for the decentral servo drives

The DAM 510 can be controlled via Ethernet-based fieldbus.

Indicator lights (LEDs) on the front of the DAM 510 show the operating status and warnings.

  NOTICE

l The system modules are designed for use within a control cabinet. If the STO function is used, the cabinet must be rated at

least IP54.

l The DAM 510 has a protection rating of IP20 according to IEC/EN 60529 (except connectors, which are IP00).

l The DAM 510 can be damaged if exposed to fluids.

An example type code for the DAM 510 is: MSD510DAM510F1C015AD6E20PLSXXXXXXXXXXXXX.
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Figure 6: DAM 510

1 Connectors: STO, Ethernet, and external encoder 2 Operating indicator lights (LEDs)

3 LCP connector 4 PE screws

5 Connectors: UDC, AUX, STO out, and Ethernet
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3.6 Auxiliary Capacitors Module (ACM 510)

3.6.1 Overview of ACM 510

ACM is the abbreviation for Auxiliary Capacitors Module. The ACM 510 can be connected to the Danfoss system to store energy, enabling

a controlled machine stop in emergency situations.

  NOTICE

l The system modules are designed for use within a control cabinet. If the STO function is used, the control cabinet must be

rated at least IP54.

l The ACM 510 has a protection rating of IP20 according to IEC/EN 60529 (except connectors, which are IP00).

l The ACM 510 can be damaged if exposed to fluids.

An example type code for the ACM 510 is: MSD510ACM510F1E00C8D6E20PLSXXXXXXXXXXXXX.
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CAP ST

NET ST

X1

X2

LCP

LINK/ACT

DEV

STATUS ACM

Figure 7: ACM 510

1 Connectors: I/O, relay, and Ethernet 2 Operating indicator lights (LEDs)

3 LCP connector 4 PE screws

3.7 Expansion Module (EXM 510)

The EXM 510 supports modular machine setup by splitting the system modules into 2 control cabinets. The maximum length of the

cable between the EXM 510 modules is 5 m.

See 5.15 Connecting the Expansion Module EXM 510 for further information.
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Figure 8: EXM 510

1 EMC shielding plate 2 Backplate

3 PE screw 4 Expansion connector

  NOTICE

l The system modules are designed for use within a control cabinet. If the STO function is used, the cabinet must be rated at

least IP54.

l The EXM 510 has a protection rating of IP20 according to IEC/EN 60529.

l The EXM 510 may be damaged if exposed to fluids.

An example type code for the EXM 510 is:

MSD510EXM510F1C062AD6E20XXXXXXXXXXXXXXXX
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3.8 Cables

3.8.1 Hybrid Cable

All dimensions are in mm.

20 ± 10
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Figure 9: Hybrid Loop Cable

Pre-configured hybrid cables are used to connect the ISD 520/DSD 520 servo drives to the Decentral Access Module (DAM 510).

There are 2 types of hybrid cables that are available with both angled and straight M23 connectors:

l Feed-in cable for connecting the 1st ISD 520/DSD 520 servo drive of a group to the connection point on the Decentral Access

Module (DAM 510).

l Loop cable for connecting the ISD 520/DSD 520 servo drives in daisy-chain format in an application.

Both these cables are provided by Danfoss and are available in various lengths. See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520

(VLT® FlexMotion™) Design Guide for further information.

Both ends of the loop cable are fitted with M23 connectors.

The feed-in cable is fitted with an M23 connector at the output end for connection to the 1st ISD 520/DSD 520 servo drive. At the input

end it is pigtailed and the connectors are mounted on the corresponding terminals on the Decentral Access Module (DAM 510).

Table 11: Hybrid Cables

Cable type Shielded/unshielded Notes

Feed-in cable

Loop cable

Shielded Hybrid cable (overall shield with additional
fieldbus and safety section shield).

  NOTICE

l Hybrid cables are available in 2 cross-sections: 2.5 mm2 (15 A) and 4 mm2 (25 A for CE and UL, 20 A for CSA).

l See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT® FlexMotion™) Design Guide for further information.
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VLT® ISD520 Hybrid Cable
175G0554
175r1192             Rev 001
11.08.2023
Loop Cable, 0.5m, 90° <> 90°
(2x2x24 AWG) PN+5G2.5+(2G0.5) C
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1 Article number 2 Specification number

3 Production date 4 Cable configuration

5 Cable specification 6 Approvals

7 Data matrix code containing article number and
production date

8 Cable characteristics, for example, drag chain

Figure 10: Example of a Hybrid Cable Product Label

3.8.1.1 Minimum Bending Radius for Hybrid Cable

Table 12: Minimum Bending Radius

Static cable Dynamic cable

Cable diameter 13.8 mm 15.6 mm

Permanent installation 25 mm bending radius 5 x cable diameter

Flexible installation Not allowed 12 x cable diameter

3.8.2 I/O and/or Encoder Cable

This cable connects the I/O and/or encoder to the ISD 520/DSD 520 servo drive (X4 connector). The cable is not included with the servo

drives.

I/O and/or encoder cables with M12 connectors can be used for the ISD 520/DSD 520 system if they comply with the form factor defined

in IEC 61076-2-101.

3.8.3 Fieldbus Extension Cable

Cable length: 2 m

Maximum length to next port: 100 m

If this cable is not used, fit the M23 metal blind cap to the X2 female connector on the last ISD 520/DSD 520 servo drive in the

application.

3.8.4 LCP Cable

The LCP cable connects the LCP to the ISD 520/DSD 520 servo drive and the system modules via an M8 connector.

The LCP cable can be purchased from Danfoss (see the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT® FlexMotion™) Design Guide

for further information and code numbers).

3.9 Cable Layout and Routing

3.9.1 Standard Cabling Concept for 2 Lines

This cabling concept is for 2 lines, without redundancy for ISD 520/DSD 520 servo drives in an application. For each additional line of

servo drives, 1 additional DAM 510 is required. For cabling concepts with only 1 line, only 1 DAM 510 is required.

Danfoss A/S © 2024.11                                                                                                                                                                        AQ441543733781en-000101 / 130R1298 | 39



  NOTICE

l For cabling with redundancy, see the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT®FlexMotion™) Design Guide.
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Figure 11: Standard Cabling Concept for 2 Lines

1 M23 feed-in cable 2 M23 loop cable

3 AC line choke

3.10 Local Control Panel

3.10.1 Overview of the Local Control Panel

The LCP is the graphical user interface that can be connected to the PSM 510, DAM 510, and ACM 510 for diagnostic and operating

purposes using an optional cable (M8 to LCP D-SUB cable).

The LCP is available as an option and can also be connected to the servo drives using the same optional cable.

The LCP display provides the operator with a quick view of the state of the ISD 520/DSD 520 servo drive or system module, depending

on which device it is connected to. The display shows parameters and alarms/errors and can be used for commissioning and

troubleshooting. It can also be used to perform simple functions, for example activating and deactivating the output lines on the

DAM 510.

The LCP can be mounted on the front of the control cabinet and then connected to the system modules via SUB-D cables. The maximum

cable length is 3 m.
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3.10.2 Layout of the Local Control Panel

The local control panel is divided into 4 functional groups:

l A: Display area

l B: Display menu keys

l C: Navigation keys and indicator lights (LEDs)

l D: Operation keys and reset

To adjust the display contrast, press [Status] and the [▲]/[▼] keys.

3.10.2.1 A: Display area

The values in the display area differ depending on whether the LCP is connected to a Danfoss servo drive or system module.

The display area is activated when the servo drive or module it is connected to receives power from the mains supply, a DC bus terminal,

or UAUX.
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Figure 12: Display Area when Connected to an ISD 520/DSD 520 Servo Drive

Table 13: Legend Table for Display Area when Connected to an ISD 520/DSD 520 Servo Drive

Description

1 Actual torque

2 Temperature drive module

3 Position

4 Speed

5 Current
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Figure 13: Display Area when Connected to PSM 510 and DAM 510

Table 14: Legend Table for Display Area when Connected to PSM 510 and DAM 510

Description

1 UAUX mains voltage

2 Temperature power board

3 Actual UDC (current)

4 Power consumption

5 Actual UDC (voltage)
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Figure 14: Display Area when Connected to ACM 510

Table 15: Legend Table for Display Area when Connected to ACM 510

Description

1 Temperature power board

2 Temperature capacitor bank 1

3 Temperature capacitor bank 2

4 UAUX voltage

5 Actual UDC (voltage)

3.10.2.2 B: Display menu keys

Menu keys are used for menu access for parameter setup, toggling through status display modes during normal operation, and viewing

fault log data.
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Table 16: Display Menu Keys

Key Function

6 Status Shows operational information.

7 Quick Menu Allows access to parameters.

8 Main Menu Allows access to parameters.

9 Alarm Log Shows the last 10 alarms.

3.10.2.3 C: Navigation keys and indicator lights (LEDs)

Navigation keys are used for moving the display cursor and provide operation control in local operation. There are also 3 status indicator

lights (LEDs) in this area.

Table 17: Navigation Keys

Key Function

10 Back Reverts to the previous step or list in the menu struc-
ture.

11 Cancel Cancels the last change or command as long as the
display mode is not changed.

12 Info Press for a definition of the function being shown.

13 Navigation keys Use the 4 navigation keys to move between items in
the menu.

14 OK Use to access parameter groups or to enable a selec-
tion.

Table 18: Indicator Lights (LEDs)

LED Color Function

15 On Green The On LED activates when the servo drive
or module it is connected to receives power
from UAUX.

16 Warn Yellow When warning conditions are met, the yel-
low Warn LED is activated and text appears
in the display area identifying the problem.

17 Alarm Red A fault condition causes the red Alarm LED
to flash and an alarm text is shown.

3.10.2.4 D: Operation keys and reset

The operation keys are at the bottom of the LCP.
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Table 19: Operation Keys and Reset

Key Function

18 Hand On Enables the connected ISD 520/DSD 520
servo drive or PSM 510/DAM 510/ACM 510
to be controlled via the LCP.

19 Off Puts the ISD 520/DSD 520 servo drive into
state Switch on Disabled and the PSM 510/
DAM 510/ACM 510 into state Standby.

This only works in Hand On mode.

Off mode enables transition from Hand On
mode to Auto On mode.

20 Auto On Puts the system in remote operational
mode.

In Auto On mode, the device is controlled
by fieldbus (PLC). Switching between
Auto On and Hand On modes is only pos-
sible when the drive is in state Switch on
Disabled and/or the PSM 510/DAM 510/
ACM 510 is in state Standby.

21 Reset Resets the ISD 520/DSD 520 servo drive or
PSM 510/DAM 510/ACM 510 after a fault
has been cleared.

The reset is only possible when in Hand On
mode.

3.11 Software

The software for the servo system comprises:

l The firmware of the ISD 520/DSD 520 that is already installed on the device.

l The firmware of the system modules that is already installed on the modules.

l A package of PLC libraries for Automation Studio™ for operating the ISD 520/DSD 520 servo drives and the system modules (see

6.10.2 Creating an Automation Studio™ Project for further information).

l A PLC library for TwinCAT® 3 for operating the ISD 520/DSD 520 servo drives and the system modules (see 6.11.2 Creating a

TwinCAT® Project for further information).

l A PLC library for TIA Portal for operating the ISD 520/DSD 520 servo drives and the system modules.

l VLT® Servo Toolbox: A Danfoss PC-based software tool for commissioning and debugging the devices.

3.12 Fieldbus

3.12.1 Overview

The servo system has an open system architecture realized by fast Ethernet (100BASE-T) based communication. The system supports

EtherCAT®, Ethernet POWERLINK®, and PROFINET® fieldbuses.

In productive environments, communication to the devices always takes place via a PLC that acts as a master. The ISD 520/DSD 520 servo

drives and the system modules can be controlled by these communication methods:

l Using the VLT® Servo Motion libraries (available for TwinCAT®, Automation Studio™and TiA Portal).

l Using the NC axis functionality of TwinCAT® (ISD 520/DSD 520 only).
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l Using the CANopen® CiA DS 402 standard by reading and writing to objects.

l Using application class 1 (AC1) and PROFINET® only.

The ISD 520/DSD 520 servo drives and the system modules can be operated with the following cycle times:

l EtherCAT® and Ethernet POWERLINK® fieldbuses:

¢ 400 μs and multiples of it (for example, 800 μs and 1200 μs).

¢ 500 μs and multiples of it (for example, 1 ms).

l PROFINET® fieldbus

¢ 1 ms, 2 ms, and 4 ms.

When the cycle time is a multiple of 400 μs and 500 μs, the time base of 500 μs is used.

The ISD 520/DSD 520 servo drives and the system modules are certified for fieldbuses according to the corresponding rules and

regulations. The servo drives conform to the CANopen® CiA DS 402 Drive Profile.

3.12.2 EtherCAT®

The ISD 520/DSD 520 servo drives and the system modules support the following EtherCAT® protocols:

l CANopen over EtherCAT® (CoE)

l File Access over EtherCAT® (FoE)

l Ethernet over EtherCAT® (EoE)

The ISD 520/DSD 520 servo drives and the system modules support distributed clocks. To compensate for the failure of a communication

cable section in the system, cable redundancy is available for all fieldbuses. See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520

(VLT® FlexMotion™) Design Guide for further information.
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Figure 15: EtherCAT® Port Assignment for the ISD 520/DSD 520 Servo Drive

X1 M23 hybrid cable connector to Decentral Access Module

(DAM 510) or previous servo drive (EtherCAT IN).

X2 M23 hybrid cable connector to the next servo drive
(EtherCAT OUT 1).

X3 M8 Ethernet cable connector to other EtherCAT® slaves, for
example, EtherCAT® encoder (EtherCAT OUT 2).

The connector is only available on the advanced servo
drives.
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Figure 16: EtherCAT® Port Assignment for the Decentral Access Module (DAM 510)

X1 RJ45 cable connector to the previous slave. X2 RJ45 to M23 hybrid feed-in cable to the 1st ISD 520/
DSD 520 servo drive.

X3 RJ45 cable connector to the PLC (cable redundancy) or
next slave.
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Figure 17: EtherCAT® Port Assignment for the Power Supply Module (PSM 510), Auxiliary Capacitors Module (ACM 510), and ISD 520/DSD 520 Servo
Drives

X1 RJ45 cable connector to the PLC or previous slave
(EtherCAT IN).

X2 RJ45 cable connector to the PLC (cable redundancy) or
next slave (EtherCAT OUT).

3.12.3 Ethernet POWERLINK®

The ISD 520/DSD 520 servo drives and the system modules are certified according to DS 301 V1.1.0 and support the following features:

l Work as controlled node.

l Can be operated as multiplexed stations.

l Support of cross-communication.

l Ring redundancy supported for media redundancy.

l Specific ports are not assigned for Ethernet POWERLINK®.

3.12.4 PROFINET®

The ISD 520/DSD 520 servo drive and system modules support PROFINET® conformance class C as per IEC 61158-5-10:2014, IEC

61158-6-10:2014, IEC 61784-2:2014, and IEC 61784-5-3:2013. All the system components (servo drives and system modules) act as I/O

devices in a PROFINET® network.

The following features are supported:

l I/O-Device: Device that is being controlled by I/O-Controller.

l Dynamic module configuration.

l Net load class II.

l Ring redundancy (MRP) as client.

PROFINET® fieldbus devices are always connected as network components via switches that are integrated in the fieldbus device.
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There are 2 ports on the ISD 520/DSD 520 servo drives, the PSM 510, and the ACM 510. There are 3 ports on the DAM 510. Only 2 can be

used for Isochronous Real-Time (IRT) protocol, whereas all 3 can be used for Real-Time (RT) protocol. If the DAM 510 with IRT is ordered,

an RJ45 cover is mounted to the X3 OUT port. Remove this cover to enable use of the X3 OUT port required for switching to RT protocol.

The wiring concept for the use of multiple DAM 510 modules in a single application is shown in Figure 18.
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Figure 18: Wiring Concept for Multiple DAM 510 Modules

1 AC line choke 2 Customer cable

3 Fieldbus extension cable
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4 Mechanical Installation

4.1 Items Supplied

The items supplied for the ISD 520/DSD 520 servo systems are:

l ISD 520/DSD 520 servo drives

l Power Supply Module (PSM 510) including connectors

l Decentral Access Module (DAM 510) including connectors

l Auxiliary Capacitors Module (ACM 510) including connectors, optional

l Expansion Module (EXM 510), optional

l Local control panel (LCP), optional

l This operating guide

l Feed-in (hybrid) cable

l Loop (hybrid) cable

l LCP cable, optional

l Fieldbus extension cable, optional

l Blind caps for connectors M8, M12, and M23

The packaging unit depends on the number of servo drives delivered. Save the packaging for use in the event of product return.

4.2 Transport
l The servo drives are delivered with plastic M23 protection caps and a shaft protection cap fitted. These plastic protection caps

prevent damage during transport and handling.

l Always use means of transport and lifting gear with sufficient load capacity to transport the servo system components.

l Avoid vibration during transport.

l Avoid heavy impacts and blows.

4.3 Inspection on Receipt
Procedure

1. After receiving the delivery, immediately check whether the items supplied match the shipping documents. Danfoss does not

honor claims for faults registered later.

2. Register a complaint immediately with the carrier if there is visible transport damage.

3. Register a complaint immediately with the responsible representative if there are visible defects or the delivery is incomplete.

4.4 Safety Measures during Installation

Always observe the safety instructions in this guide during installation.

l Ensure that installation is performed by qualified personnel.

l Carry out installation with due care and attention.

l Comply with all safety regulations and protective measures and observe the environmental conditions.

l Ensure that this guide is read and understood.
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4.5 Installation Environment

4.5.1 Overview

The installation must provide the following environmental conditions to allow the ISD 520/DSD 520 system to be operated safely and

efficiently.

Contact Danfoss if it is not possible to comply with these environmental conditions.

4.5.2 ISD 520/DSD 520 Servo Drive

l The allowable operating ambient temperature range, humidity, and vibration levels must not be exceeded. (See 11.11.1 ISD 520/

DSD 520 Servo Drive.)

l Ensure that ventilation to the ISD 520/DSD 520 servo drives is not restricted.

  WARNING

RISK OF COMBUSTION OF THE MOUNTING STRUCTURE

The surface of the drive can exceed 90 °C, which may result in the combustion of the mounting surface, product damage, or

injury.

l Ensure that the mounting structure is suitable for the application, for example, adequately rigid and able to handle

temperatures over 90 °C.

4.5.3 System Modules

The environmental conditions for the PSM 510, DAM 510, and ACM 510 are:

l The allowable operating ambient temperature range, humidity, and vibration levels must not be exceeded (see 11.11.2 System

Modules).

l The minimum space required above and below the system modules is detailed in 4.7.3 Space Requirements for System Modules.

4.6 Preparation for Installation

4.6.1 Preparation for Installation of ISD 520/DSD 520 Servo Drive

Make the following preparations to ensure that the servo system can be installed reliably and effectively.

Always fit couplings and other transfer components in accordance with local regulations.

Procedure

1. Provide a suitable mounting arrangement for the application. This depends on the type, weight, and power size of the ISD 520/

DSD 520 servo drives.

2. For the ISD 520 servo drives, seat the motor flange flush against the mounting surface before fixing the servo drive.

Misalignment shortens the life of the bearings and the coupling components and reduces heat transfer from the servo drive.

Ensure that the seal is not bumped when inserting the drive into the machine as that could damage the seal resulting in

impaired sealing function and reduced service lifetime.

3. For the DSD 520 servo drives, seat the bottom side of the DSD 520 to the mounting surface before fixing the servo drive.

Misalignment reduces heat transfer from the servo drive.

4. Provide contact protection according to local regulations if hot surfaces can be expected during operation.

5. Ground the servo drives (see 5.4.1 Grounding the ISD 520 Servo Drive and 5.4.2 Grounding the DSD 520 Servo Drive).
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  NOTICE

l The motor flange and shaft are vulnerable during storage and assembly. Blows or the use of force can result in damage to the

bearings, shaft, and motor feedback.

l Only use suitable tools to mount or pull off pulleys or couplings.

l Rotors are dynamically balanced with half key, in accordance with standard DIN ISO 8821.

4.6.2 Preparation for Installation of System Modules

Make the following preparations to ensure that the servo system can be installed reliably and effectively.

Always fit the system modules in accordance with local regulations.

Procedure

1. Provide a suitable mounting arrangement for the application. This depends on the type and weight of the modules.

2. To avoid misalignment, ensure that the backplates are perfectly level.

3. To ensure sufficient cooling, pay attention to the specified minimum space requirements (see 4.7.3 Space Requirements for

System Modules).

4. Ground the modules.

4.6.3 Drilling Templates
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Figure 19: Drilling templates for 50 mm (FS1) and 100 mm (FS2) System Modules
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4.7 Installation Procedure

4.7.1 Space Requirements for ISD 520 Servo Drive

In addition to its own dimensions, the servo drive needs space for the hybrid cable.

Figure 20 shows the space required for the straight connector.

Figure 21 shows the space required for the angled connector.

The illustrations show the minimum distance from the servo drive to the next object, and the minimum allowable bending radius Rmin for

permanently installed cable. For cable installation, allow the height of the connector plus an additional 30 mm for the cable.

The minimum distance is measured from the electronic housing as this is the same for all motor variants.
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Figure 20: Minimum Distance for M23 Straight Connector on ISD 520
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Figure 21: Minimum Distance for M23 Angled Connector on ISD 520

4.7.2 Space Requirements for DSD 520 Servo Drive

In addition to its own dimensions, the servo drive needs space for the hybrid cable.

Figure 22 shows the straight connector installed on a DSD 520 servo drive.

Figure 23 shows the angled connector installed on a DSD 520 servo drive.

The illustrations show the minimum distance from the servo drive to the next object, and the minimum allowable bending radius Rmin for

permanently installed cable. For cable installation, allow the height of the connector plus an additional 30 mm for the cable.
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Figure 22: Minimum Distance for M23 Straight Connector on DSD 520
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Figure 23: Minimum Distance for M23 Angled Connector on DSD 520

4.7.3 Space Requirements for System Modules

The modules can be mounted next to each other but require a minimum space at the top and bottom for cooling.
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Figure 24: Minimum Space Required at the Top and Bottom
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Figure 25: Minimum Space Required at the Sides

4.7.4 Installation Aids and Tools Required

For installation of the ISD 520 servo drives, the tools corresponding to the fixings screws (not included) are required (see 4.7.5.4 Fixing

Screws and Tightening Torques).

4.7.5 Fitting Instructions for ISD 520 Servo Drive

4.7.5.1 Overview

The ISD 520 servo drives are delivered with plastic M23 transport protection caps. To ensure IP protection, replace the plastic protection

caps with the M23 metal protection caps (which must be ordered separately). Always mount a metal protection cap if a connector is not

used.

The ISD 520 servo drives are delivered with M8 and M12 protection caps. These protection caps prevent contamination of the servo drive

and are necessary to achieve the relevant IP protection rating. Always mount these caps if the connector is not used.

  NOTICE

l Ensure that the machine surface that comes in contact with the ISD 520 servo drive flange is unpainted to guarantee good

thermal behavior of the servo drive. The surface contact must also provide sufficient grounding protection if the ISD 520

servo drive is grounded using the motor flange.

4.7.5.2 Clamping the ISD 520 Servo Drive

Observe the following fitting instructions to ensure the reliable and effective fitting of the ISD 520 servo drive.
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Procedure

1. Check the mounting surface and ensure that it has sufficient heat dispersion capacity.

2. Remove the protective end cap from the shaft.

3. Fix the servo drive with 4 screws using the 4 mounting holes provided for this purpose in the machine unit as shown.

– Always use the designated mounting holes in the mounting flange to fix the servo drive.

– Do not modify the mounting holes.

– Always use all 4 mounting holes. The motor may run unevenly if fewer mounting holes are used.
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Figure 26: Mounting of ISD 520 Servo Drives

4.7.5.3 Coupling the ISD 520 Servo Drive

Observe the following safety warnings before coupling the ISD 520 servo drive.

  NOTICE

l Do not machine the shaft.

l Do not use the ISD 520 servo drive if the shaft does not match the coupling arrangement.

l Ensure correct alignment of the couplings as incorrect placement will result in unacceptable vibration levels.

  NOTICE

DO NOT USE EXCESSIVE FORCE DURING THE FITTING PROCEDURE:

l Do not exceed the specified vibration limits.

l Do not exceed the specified allowed forces.

l Do not use force to press or hammer the motor shaft into a machine.

Procedure

1. Align the clamping set to the axis of the ISD 520 servo drive.

2. Insert the shaft in the clamping set.

3. Screw the clamping set together.

4.7.5.4 Fixing Screws and Tightening Torques

Always tighten the screws uniformly and crosswise.
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Table 20: Fixing Screws

Flange size

[mm]

Flange thickness

[mm]

Hole size

[mm]

Recommended screw

type(1)

Recommended
tightening torque

[Nm]

70 9.0 5.8 M5, Hexagon socket
head cap screw

3.5

87 42.5 – M6, Hexagon socket
head cap screw(2)

7–8.5

91 11.0 6.5 M6, Hexagon socket
head cap screw

7–8.5

100 10.0 9.0 M8, Hexagon socket
head cap screw

17–21

116 12.0 9.0 M8, Hexagon socket
head cap screw

17–21

142 12.0 12.5 M12, Hexagon socket
head cap screw

57–70

1) Use a screw with a strength class of minimum 8.8.

2) The ISD 520 can be fixed from both sides of the flange. When using the thread on the flange, an M8 screw is required, otherwise an M6 flange screw must be used to fix the ISD 520 to

the mounting plate (see Figure 27).
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Figure 27: M6 Flange Screw Dimensions

  NOTICE

l The fixing screws are not supplied and must be selected according to the machine fixings.

4.7.6 Fitting Instruction for DSD 520 Servo Drive

4.7.6.1 Overview

The DSD 520 servo drives are delivered with plastic M23 transport protection caps. To ensure IP protection, replace the plastic protection

caps with the M23 metal protection caps (which must be ordered separately). Always mount a metal protection cap if a connector is not

used.

The DSD 520 servo drive is delivered with M8 and M12 protection caps. These protection caps prevent contamination of the servo drive

and are necessary to achieve the relevant IP protection rating. Always mount these caps if the connector is not used.

4.7.6.2 Clamping the DSD 520 Servo Drive

Observe the following fitting instructions to ensure the reliable and effective fitting of the DSD 520 servo drive.
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Procedure

1. Check the mounting surface and ensure that it has sufficient heat dispersion capacity. An unpainted surface is mandatory.

2. Drill the holes for mounting the DSD 520 (see 11.3.2 Dimensions of DSD 520 Servo Drive).

3. Mount the DSD 520 to the mounting plate using M4 screws with a minimum strength class of 8.8. The 2 possible mounting

positions are shown in Figure 28.

– The tightening torque is 3 Nm

– Always use all 4 mounting holes for top mounting.

– Always use all 3 mounting holes for side mounting.
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Figure 28: Mounting of DSD 520 Servo Drive

4.7.7 Fitting Instructions for System Modules

Procedure

1. Drill the holes for mounting the backplate as per the drilling template (see 4.6.3 Drilling Templates).

2. Connect the backplates and the end cap via the click and lock method.
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Figure 29: Connecting the Backplates

1 Backplate End Cap

3. Mount the backplates to the mounting plate in the control cabinet using M5 screws with a minimum head diameter or washer

diameter of 9.5 mm. The tightening torque is 3 Nm.
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Figure 30: Mounting the Backplates in the Control Cabinet

4. Slide the module onto the carrier at the bottom of the backplate.

5. Press the 1st module onto the backlink connector at the top of the backplate.
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Figure 31: Pressing the Module onto the Backlink Connector

6. To secure the module, pull down the holding clamp ([1] in Figure 32) at the top of the backplate.
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Figure 32: Pulling Down the Holding Clamp at the Top of the Backplate

1 Holding clamp

7. Repeat steps 4, 5, and 6 for the remaining modules, ensuring that the lip at the left side of the 2nd module is inside the guiding

groove at the right side of the 1st module ([1] in Figure 33).
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Figure 33: Guiding Groove

1 Guiding groove
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5 Electrical Installation

5.1 Warnings for Electrical Installation

During electrical installation, observe the relevant local and national regulations in addition to the information in this guide.

  WARNING

HIGH VOLTAGE

The servo system contains components that operate at high voltage when connected to the electrical supply

network. Not all components have indicators that indicate the presence of mains supply. Incorrect installation,

commissioning, or maintenance may lead to death or serious injury.

l Installation, commissioning, and maintenance may only be performed by qualified personnel.

  WARNING

HIGH VOLTAGE

Potentially lethal voltage is present on the connectors that may lead to death or serious injury.

l Before working on the power connectors (disconnecting or connecting the cable), disconnect the

PSM 510 from the mains and wait for the discharge time to elapse.

  WARNING

LEAKAGE/GROUNDING CURRENT HAZARD

Leakage/grounding currents are >3.5 mA. Improper grounding of the ISD 520/DSD 520 servo drives and the

system modules may result in death or serious injury.

l For reasons of operator safety, use a certified electrical installer to ground the system correctly in

accordance with the applicable local and national electrical standards and directives, and the instructions

in this guide.

5.2 Electrical Environmental Conditions

Compliance with the following electrical environmental conditions is necessary to enable safe and effective operation of the servo

system:

l Only for use in TN-S, TN-C, TN-CS, TT (not corner earthed) supply earthing system

l Prospective short-circuit current: 5 kA

l Protective class I

l Grounded 3-phase mains network, 400–480 V AC ±10%

l 3-phase frequency 44–66 Hz

l 3-phase lines and PE line

l External supply for auxiliary voltage, 24/48 V DC (PELV) ±10%

l AC choke (see 5.11.1 AC Line Choke)

l Observe the national statutory provisions.

l The leakage current is >3.5 mA.
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  NOTICE

RCD COMPATIBILITY!

The servo system contains components that can cause a DC current in the protective earthing conductor, which may result in

malfunction in any devices connected to the system.

l Where a residual current-operated protective (RCD) or monitoring (RCM) device is used for protection in case of direct or

indirect contact, use a type B RCD or RCM device on the supply side of the system components.

  NOTICE

l The PSM 510, DAM 510, and optional ACM 510 and EXM 510 must be mounted in a control cabinet.

5.3 EMC-Compliant Installation

To achieve an EMC-compliant installation, follow the instructions provided in 5.5 Grounding for EMC-Compliant Installation and the steps

defined for connecting the servo drives, PSM 510, DAM 510, and ACM 510.

5.4 Grounding for Electrical Safety

5.4.1 Grounding the ISD 520 Servo Drive

ISD 520 can be grounded using the flange or the PE screws.

5.4.1.1 Grounding using the Flange

1. Ensure a proper PE connection on the flange surface.
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Figure 34: PE Area on the Flange Surface

1 PE (motor grounding) area on the ISD 520 servo drive
flange

2. Connect the PE yellow/green wire of the feed-in cable to 1 of the PE screws on the front of the DAM 510, as depicted in Figure 35
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Figure 35: Connecting the PE Wire of the Feed-in Cable

1 PE screws on DAM 510 2 PE yellow/green wire (fork lug)

5.4.1.2 Grounding using the PE Screws
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Figure 36: PE Screws on the ISD 520 Servo Drive

1 PE screws

1. ISD 520 (E0 and E1): Ensure that the machine frame has a proper electrical connection to 1 of the 2 dedicated PE screws (see

Figure 36).
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2. ISD 520 (E2): Ensure that the machine frame has a proper electrical connection to the 2 dedicated PE screws (both are needed).

As an alternative, a cable with a cross-section of 10 mm2(Cu) can be used.

3. For the ISD 520 servo drives, ensure a minimum ground wire cross-section of at least 4 mm2 (minimum 70 °C, Cu).

4. Keep the ground wire connections as short as possible.

5. Connect the PE yellow/green wire of the feed-in cable to 1 of the PE screws on the front of the DAM 510, as depicted in Figure

35.

5.4.2 Grounding the DSD 520 Servo Drive
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Figure 37: Grounding DSD 520

1 PE screws on the DSD 520 housing 2 PE screws on the DSD 520 adapter

1. Ensure that the machine frame has a proper electrical connection to 1 of the 2 dedicated PE screws on the housing or on the

DSD 520 adapter.

2. For the DSD 520 servo drives, ensure a minimum ground wire cross-section of at least 4 mm2 (minimum 70 °C, Cu).

3. Keep the ground wire connections as short as possible.

4. Connect the PE yellow/green wire of the feed-in cable to 1 of the PE screws on the front of the DAM 510 (see Figure 35).

5.4.3 Grounding the System Modules

Do not ground the system modules in daisy-chain format. Use the grounding method shown in Figure 38.
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Figure 38: Grounding for Electrical Safety

l To comply with CE requirements, ensure a minimum ground wire cross-section of at least 16 mm2 (minimum 70 °C, Cu). To comply

with UL requirements, ensure a minimum ground wire cross-section of 6 AWG (minimum 60 °C, Cu).

¢ If a PSM 510 module with 10 kW is used, the cable cross-section can be reduced to 10 mm2 (minimum 70 °C, Cu) to comply with

CE requirements and 8 AWG (minimum 60 °C, Cu) to comply with UL requirements.

l Keep the ground wire connections as short as possible.

l Follow the wiring requirements in the VLT® Multiaxis Servo Drive System MSD 510 Operating Guide.

  NOTICE

l If 2 separate backlinks are used (connected via 1 or 2 pairs of EXM 510 modules), the 2 grounding bars must also be

connected together with a 16 mm2 (6 AWG) cable cross-section.
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5.5 Grounding for EMC-Compliant Installation
l Establish an electrical connection between the cable shield and the enclosure using the I/O shielding plate on each module.
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Figure 39: Cable Shielding on the Top of the System Modules

1 Cable 2 Cable tie

3 I/O shielding plate
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Figure 40: Cable Shielding on the Bottom of the System Modules

1 Cable tie 2 EMC metal shielding plate

3 EMC plate screw

l Use a cable with a shielding that has high coverage to reduce electrical interference.

l Do not use pigtails to connect the shielding. A 360° wire connection is recommended.
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  NOTICE

POTENTIAL EQUALIZATION

l There is a risk of electrical interference when the ground potential between the servo system and the machine is different.

Install equalizing cables between them. The recommended cable cross-section is 16 mm2.

  NOTICE

EMC INTERFERENCE

l Use shielded cables for control wiring and separate cables for power and control wiring. Failure to isolate power and control

wiring can result in unintended behavior or reduced performance.

l Ensure a minimum clearance of 200 mm between signal and power cables.

l Only cross cables at 90°.

5.6 Mains Supply Requirements

Ensure that the supply has the following properties:

l TN-S, TN-C, TN-CS, TT (not corner grounded) supply grounding system

l Prospective short-circuit current: 5 kA

l Protective class I

l Grounded 3-phase mains network, 400–480 V AC ±10%

l 3-phase lines and PE line

l 3-phase frequency: 44–66 Hz

l Maximum input current for 1 PSM 510 at 30 kW: 55 Arms

  NOTICE

l For information on the use of an IT network with transformer, contact Danfoss.

l Ensure that the servo system is protected either by fuses (see 5.6.1 Fuses) or by a circuit breaker (see 5.6.2 Circuit Breakers).

5.6.1 Fuses

  NOTICE

l Use fuses on the supply side of the Power Supply Module (PSM 510) that comply with CE and UL requirements (see Table 21).

l When 2 PSM 510 modules are used, each PSM 510 must have its own dedicated set of fuses.

Table 21: Fuses

Model and power rating CE Compliance (IEC 60364) UL Compliance (NEC 2014)

Maximum fuse type Maximum fuse type

PSM 510 (10 kW) gG 25 A 30 A (class T or J only)

PSM 510 (20 kW) gG 50 A 50 A (class T or J only)

PSM 510 (30 kW) gG 63 A 80 A (class T or J only)
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5.6.2 Circuit Breakers

Use a type B or type C circuit breaker with a capacity of 1.5 times the rated current of PSM 510 to fulfill CE requirements.

  NOTICE

l Circuit breakers are not allowed in installations where C-UL is required. Only UL-recommended fuses are allowed.

5.6.3 Additional Specifications

Table 22: Additional Specification

Maximum imbalance temporary between mains phase 3% of the rated supply voltage

True power factor [λ] ≥0.9 at rated current

Switching on input supply Maximum 2 times per minute

Mains dropout During low mains or a mains dropout, the PSM 510 and the servo
drives keep running until the DC-link voltage drops below 373 V.
Full torque of the servo drives cannot be expected at a mains volt-
age 10% below the rated supply voltage.

5.7 Auxiliary Supply Requirements

Supply the Power Supply Module (PSM 510) with a power supply unit with an output of 24/48 V DC ±10%. The output ripple of the

power supply unit must be <250 mVpp.

  NOTICE

l Only use supply units that conform to the PELV specification.

l Use a supply that is CE-marked according to the standards EN 61000-6-2 and EN 61000-6-4 or similar for industrial use.

l Ensure that the secondary circuit is supplied from an external isolated source.

The power supply unit must be dedicated to the ISD 520/DSD 520 servo system, meaning that the supply is used exclusively for

powering the PSM 510. The maximum allowed cable length between the supply unit and the PSM 510 is 3 m.

  NOTICE

l For cable lengths <10 m, use 24 V auxiliary voltage. For cable lengths ≥10 m, use 48 V auxiliary voltage.

l If a mechanical brake is connected, always supply the servo system with 48 V auxiliary voltage.

5.7.1 Fuses

UL listed fuses are recommended to protect the wiring on 24/48 V DC.

Table 23: Fuses

CE Compliance (IEC 60364) UL Compliance (NEC 2014)

Maximum fuse type Maximum fuse type

50 A(1) 63 A(2)

1) If the maximum current is lower, a fuse with a lower current rating can be used. Rating of IEC fuses: according to 100% of maximum current. Use a time delay fuse rated according to

the DC voltage used.

2) If the maximum current is lower, a fuse with a lower current rating can be used. Rating of UL fuses: according to 125% of maximum current. Use a time delay fuse rated according to

the DC voltage used.
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5.8 Safety Supply Requirements

Supply the STO line with a 24 V DC supply with the following properties:

l Output range: 24 V DC ±10%

l Maximum current: 1 A

The maximum current is the maximum allowed current throughout the system. The typical current depends on the system topology and

dimensioning.

Use a 24 V supply unit that is CE-marked for industrial use. Ensure that the supply fulfills the PELV specification and is only used for the

system safety input.

A common supply for auxiliary and safety supply can be used, however the only connection point of the 2 circuits must be near to the

supply to avoid interference from a common voltage drop. The maximum cable length between the 24 V supply unit and the servo

system is 3 m.

The safety supply can be looped from PSM 510 to the other system modules except for ACM 510. The cable for this is not provided. See

8.6 Installation for further information.

  NOTICE

l Ensure that there is reinforced isolation between safety signals and other signals, supplies (mains supply), and exposed

conductive parts.

5.9 UL Requirements

  NOTICE

l Integral solid-state short-circuit protection does not provide branch circuit protection. Branch circuit protection must

be provided in accordance with the National Electrical Code/Canadian Electrical Code, and any additional local codes or

equivalent.

l Suitable for use on a circuit capable of delivering not more than 5000 rms symmetrical amperes, 480 V maximum when

protected by maximum 80 A class J or T fuses.

l To meet the UL (Underwriters Laboratories) regulations, use a UL-approved copper cable with a minimum heat-resistance of

60 °C. Use Class 1 wire only. For PSM 510 rated 30 kW and EXM 510, use a minimum heat resistance of 75 °C.

l Control Circuit Overcurrent Protection is required.

5.10 Connecting the ISD 520/DSD 520 Servo Drive

5.10.1 Electrical Installation Warnings for ISD 520/DSD 520 Servo Drive

  WARNING

HIGH VOLTAGE

Potentially lethal voltage is present on the connectors that may lead to death or serious injury.

l Before working on the power or signal connectors (disconnecting or connecting the cable), or performing

any maintenance work, disconnect the Power Supply Module (PSM 510) from the mains and wait for the

discharge time to elapse.
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  WARNING

DISCHARGE TIME

The servo system contains DC-link capacitors that remain charged for some time after the mains supply is

switched off at the Power Supply Module (PSM 510). Failure to wait the specified time after power has been

removed before performing service or repair work could result in death or serious injury.

l To avoid electric shock, fully disconnect the Power Supply Module (PSM 510) from the mains and wait

for the capacitors to fully discharge before carrying out any maintenance work on the servo system or

replacing components.

Minimum waiting time (minutes)

15

  DANGER

RISQUE DU CHOC ÉLECTRIQUE

Une tension dangereuse peut être présentée jusqu’à 15 min après avoir coupé l’alimentation.

  NOTICE

l Use a motor with reinforced insulation between the thermistor and the motor windings (tested with 4300 V DC and

8000 Vpeak impulse).

l Use a motor with reinforced insulation between the brake and the motor windings (tested with 4300 V DC and

8000 Vpeakimpulse).

5.10.2 General Instructions for Cable Installation

Avoid mechanical tension for all cables, especially regarding the range of motion of the installed servo drive.

Secure all cables in accordance with regulations and depending on conditions on site. Ensure that cables cannot come loose, even after

prolonged operation.

If the X3, X4, and X5 connectors are not used, always mount the corresponding blind cap.

  NOTICE

l Never connect or disconnect the hybrid cables to or from the servo drive when the supply voltage is present. Doing so

damages the electronic circuitry. Observe the discharge time for the DC-link capacitors.

l Do not forcefully connect or fit the connectors. Incorrect connection causes permanent damage to the connector.

l Use cables with a suitable insulation (minimum 0.4 mm for power cables and minimum 0.2 mm for signal cables).

Table 24: Tightening Torques

Connector Tightening torque [Nm]

M8 0.2

M12 0.4

M23 0.8
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5.10.3 Connecting Hybrid Cables

Procedure

1. Align the female connector of the M23 feed-in cable to the male input connector (X1) of the 1st ISD 520/DSD 520 servo drive.

2. Fully rotate the threaded ring of the cable connector counterclockwise. Use the marking OPEN as a reference for the cable

connector.

3. Ensure the marking OPEN on the cable connector is facing the servo drive.

4. Press the connector towards the electronic housing on the servo drive until the sealing on the connector is entirely covered.

5. Tighten the M23 feed-in cable connector by rotating the threaded ring clockwise out of the flat area around the OPEN marking.
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Figure 41: Connecting the M23 Feed-In Cable

6. To add more servo drives in daisy-chain format, connect the male connector of the loop cable to the female connector (X2) of

the 1st servo drive.

7. Connect the female connector of the loop cable to the male connector (X1) of the next servo drive, and so on.

8. Tighten the threaded rings by hand as described in step 5.

9. Ensure that there is no mechanical tension on the cables.
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Figure 42: Adding ISD 520 Servo Drives in Daisy-Chain Format

1 X1 Male connector 2 X2 Female connector

3 M23 Metal blind cap

10. Screw the M23 metal blind cap onto the unused M23 female output connector (X2) on the last servo drive in the servo system.

11. Tighten the metal blind cap until the sealing on the connector is covered.
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Figure 43: Mounting the M23 Blind Cap

  CAUTION

RISK OF INJURY AND/OR EQUIPMENT DAMAGE

Failure to use the M23 metal blind cap may result in injury to the operator and/or damage to the ISD 520/DSD 520 servo drive.

l Always fit the M23 metal blind cap as described in steps 10 and 11.

  NOTICE

l A straight version of the M23 connector is also available. The procedure for connecting the straight M23 connector is the

same as for the angled connector.

5.10.4 Disconnecting Hybrid Cables

Procedure

1. Disconnect the Power Supply Module (PSM 510) from its power source (mains network and UAUX).

2. Wait for the minimum discharge time to elapse.

3. Remove the connector of the feed-in cable from the Decentral Access Module (DAM 510).

4. Rotate the threaded ring on the feed-in cable connector on the servo drive counterclockwise until the marking OPEN on the

cable connector is facing the servo drive.

5. Pull the connector away from the electronic housing.

6. Protective metal M23 blind caps are provided for the X1 and X2 connectors. Mount the metal blind caps after removing the

corresponding connector.

5.10.5 Connecting Cables to Ports X3, X4, and X5

5.10.5.1 Cable Routing Recommendations

Avoid mechanical tension for all cables, especially regarding the range of motion of the installed servo drive.

Secure all cables in accordance with regulations and depending on conditions on site. Ensure that cables cannot come loose, even after

prolonged operation.

5.10.5.2 Connecting I/O Cables to Ports X3 and X4

Procedure

1. Align the connector on the cable (not supplied) with the connector marked X3 or X4 on the servo drive.
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2. Press the connector towards the electronic housing of the servo drive and tighten the threaded ring of the connector by

turning it clockwise. The maximum tightening torque is 0.4 Nm.

5.10.5.3 Connecting the LCP Cable to Port X5

Procedure

1. Align the connector on the LCP cable (not supplied) with the LCP connector marked X5 on the ISD 520/DSD 520 servo drive.

2. Press the connector towards the electronic housing of the servo drive and tighten the threaded ring of the connector by

turning it clockwise. The maximum tightening torque is 0.2 Nm.

The LCP cable can be ordered as an accessory.

5.10.6 Disconnecting Cables from Ports X3, X4, and X5

1. Loosen the threaded ring of the connector by turning it counterclockwise.

2. Disconnect the cable from the servo drive.

3. Protective blind caps are provided for the X3, X4, and X5 connectors. Mount the blind caps after removing the respective

connector.

5.10.7 Connecting the Wires on DSD 520
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Figure 44: Connecting the Wires on DSD 520

1 Analog motor feedback connector 2 Digital motor feedback connector

3 Thermistor, mechanical brake, and HIPERFACE® DSL
connector

4 PE screw

5 Motor phase connector

5.11 Connecting the Power Supply Module PSM 510

5.11.1 AC Line Choke

It is mandatory to use a 3-phase AC line choke (see 5.11.1.1 Connecting 1 PSM 510 to the AC Choke and 5.11.1.2 Connecting 2 PSM 510

Modules to the AC Choke).
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Table 25: Line Choke Characteristics for 1 PSM 510

Model Minimum Irms [A] Urms [V] Inductance [mH]

PSM 510 (10 kW) 20 500 Minimum: 0.47

Maximum: 1.47

PSM 510 (20 kW) 40 500 Minimum: 0.47

Maximum: 1.47

PSM 510 (30 kW) 60 500 0.47 ±10%

If 2 PSM 510 modules are installed in parallel, use an AC choke as specified in Table 26. See 5.11.1.2 Connecting 2 PSM 510 Modules to the

AC Choke for further information.

Table 26: Line Choke Characteristics for 2 PSM 510 installed in parallel

Model Minimum Irms [A] Urms [V] Inductance [mH]

PSM 510 (2 x 30 kW) 125 500 0.24 ±10%

Danfoss recommends mounting the AC line choke close to the PSM 510.

The maximum cable length depends on the cross-section, and the required voltage and current at the DC link.

If the AC line chokes are mounted away from the PSM 510, the maximum cable distance is 5 m.

5.11.1.1 Connecting 1 PSM 510 to the AC Choke

Connect the PSM 510 to the electric grid with the correct AC choke for the power size of the PSM 510.
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Figure 45: Connecting 1 PSM 510 to the AC Choke

5.11.1.2 Connecting 2 PSM 510 Modules to the AC Choke

Connect the PSM 510 modules to the same AC choke as shown in Figure 46.

Ensure that the choke used is the correct size based on the combined power of the PSM 510 modules.

When 2 PSM 510 modules are used, the wiring between the AC line choke and each PSM 510 must be the same length within a tolerance

of 0.5 m.

Connect each PSM 510 to the AC choke directly. Parallel wiring is not allowed.
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Figure 46: Connecting 2 PSM 510 Modules to the AC Choke

5.11.1.3 Connecting 2 PSM 510 Modules to the AC Choke with System Splitting

Connect the PSM 510 modules to the same AC choke regardless of the load position (for example, before or after the system splitting) as

shown in Figure 47.

Ensure the choke used is the correct size based on the combined power of the PSM 510 modules.

When 2 PSM 510 modules are used, the wiring between the AC line choke and each PSM 510 must be the same length within a tolerance

of 0.5 m.

Connect each PSM 510 to the AC choke directly. Parallel wiring is not allowed.

78 | Danfoss A/S © 2024.11                                                                                                                                                                        AQ441543733781en-000101 / 130R1298

Operating Guide | VLT Servo Drive System ISD 520/DSD 520                                                                                                          Electrical Installation



Operating Guide | VLT Servo Drive System ISD 520/DSD 520                                                                                                          Electrical Installation

STATUS PSM
DEV
SVS ST
NET ST

LINK/ACT
X1
X2

LCP LCP LCP LCP

STATUS PSM
DEV
SVS ST
NET ST

LINK/ACT
X1
X2

e3
0b

i2
37

.1
0

STATUS DAM
DEV
SVS ST
NET ST
AUX

LINK/ACT
X1
X2
X3

STATUS ACM
DEV
CAP ST
NET ST

LINK/ACT
X1
X2

PS
M

 5
10

PS
M

 5
10

A
CM

 5
10

D
A

M
 5

10

EX
M

 5
10

...

Figure 47: Connecting 2 PSM 510 Modules to the AC Choke with System Splitting

If 2 AC chokes are used (1 per PSM 510) and both PSM 510 modules are mounted at the same side of the system splitting, the setup is

allowed with derating equal to the AC choke's tolerance referred to 60 kW. For example, 10% derating is 54 kW.

If 2 AC chokes are used (1 per PSM 510) where 1 PSM 510 module is mounted before the splitting and 1 after the splitting, the loads must

be balanced equally. Otherwise, the derating of both PSM 510 modules is equal to the AC choke's tolerance. For example, tolerance 10%

+ 10% means –20% derating.

If 2 AC chokes are used (1 per PSM 510) and 1 PSM 510 module is mounted before the splitting and 1 after the splitting and half of

the loads are set before the system splitting and half are set after the system splitting, the setup is allowed with derating equal to the

tolerance of the AC choke referred to 60 kW. For example, 10% derating is 54 kW.

  NOTICE

l Further information on the EXM 510 module and wiring can be found in 11.9.13 Expansion Module Connector.

5.12 Connecting the Cables on the Power Supply Module PSM 510

5.12.1 Connecting the Cables on the Top of the Power Supply Module PSM 510

1 2

34567

e3
0b

g4
65

.1
1

Figure 48: Connectors on the Top of PSM 510

1 Ethernet connector IN (X1 IN) 2 Ethernet connector OUT (X2 OUT)

3 24/48 V IN connector (INPUT 24/48 V) 4 STO connector IN (STO PSM)
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5 STO connector OUT (STO PSM) 6 I/O connector (I/O PSM)

7 Relay connector (REL PSM)

Procedure

1. Connect the Ethernet cable from the PLC to the Ethernet input connector (X1 IN) [1].

2. Connect the Ethernet cable from the Ethernet output connector (X2 OUT) [2] to the next module.

3. Insert the wires into the 24/48 V IN (INPUT 24/48 V) connector.

4. Insert the 24/48 V IN connector [3].

5. Insert the wires into the STO connector IN (STO PSM) connector.

6. Insert the STO connector IN connector [4].

7. Insert the wires into the STO connector OUT (STO PSM) connector.

8. Insert the STO connector OUT connector [5].

9. If I/Os are required, insert the wires into the I/O connector and insert the connector (I/O PSM) [6].

10. If a relay is required, insert the wires into the relay connector and insert the connector (REL PSM) [7].

5.12.2 Connecting the Cables on the Bottom of the Power Supply Module PSM 510
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Figure 49: Connectors on the Bottom of PSM 510

1 Holder for internal brake resistor connector when not in
use

2 AC mains supply connector

3 PE screws 4 Internal/external brake resistor connector

Procedure

1. Insert the wires into the AC mains supply connector.

2. Insert the AC mains supply connector [2].

3. If an external brake resistor is required:

a. Unplug the internal brake resistor connector [4] and insert the external brake connector in its place.

b. Plug the internal brake resistor connector to the internal brake connector holder [1].

4. Connect the PSM 510 to PE using 1 of the PE screws on the front side [3] and a PE wire. The tightening torque is 3 Nm.

5.13 Connecting the Decentral Access Module DAM 510

5.13.1 Connecting the Cables on the Top of the Decentral Access Module DAM 510
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Figure 50: Connectors on the Top of DAM 510

1 Ethernet connector IN (X1 IN) 2 Ethernet connector OUT (X3 OUT)

3 STO connector IN (STO DAM) 4 STO connector OUT (STO DAM)

5 External encoder connector (E DAM)

Procedure

1. Connect the Ethernet cable from the output of the previous module to the input connector (X1 IN) [1].

2. Insert the wires from the STO output of the previous module into the 24 V IN (STO input) connector, see 11.9.9.2.1 STO

Connectors on the Top of DAM 510.

3. Insert the 24 V IN (STO connector IN (STO DAM)) connector [3] into the DAM 510.

4. If required, connect the external encoder connector [5].

5.13.2 Connecting the Feed-In Cable

Prerequisite:

1234

e3
0b

g4
68

.1
0

Figure 51: Connectors on the Bottom of DAM 510

1 Ethernet connector 2 AUX connector

3 STO out connector 4 UDC connector
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Figure 52: Feed-In Cable
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1 Shielded area 2 UDC+ (black, 2.5 mm2/4 mm2)

3 UDC– (gray, 2.5 mm2/4 mm2) 4 STO+ (pink, 0.5 mm2)

5 STO– (gray, 0.5 mm2) 6 AUX+ (red, 2.5 mm2)

7 AUX– (blue, 2.5 mm2) 8 Ethernet/fieldbus (green, RJ45 connector)

9 PE (yellow/green, 2.5 mm2/4 mm2, fork lug)
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Figure 53: Connecting the Feed-In Cable

1 Feed-in cable PE screws 2 Bus connector

3 Cable tie for feed-in cable 4 Cable tie for STO cable

5 EMC plate 6 EMC plate screw

Procedure

1. Insert the wires into the UDC, AUX, and STO connectors.

2. Secure the feed-in cable using the cable ties [3], ensuring that the shielded area is positioned exactly under the cable tie.

3. Secure the STO cable using the cable tie [4], ensuring that the shielded area is positioned exactly under the cable tie.

4. Insert the connectors on the feed-in cable into their corresponding terminal block on the DAM 510.

5. Tighten the screw on the EMC plate [6]. The tightening torque is 3 Nm.

6. Insert the RJ45 bus connector [2].

7. Connect the DAM 510 to PE using one of the PE screws on the front side [1] and a PE wire. The tightening torque is 3 Nm.

8. Connect the PE wire of the feed-in cable to the other PE screw on the DAM 510.

5.14 Connecting the Auxiliary Capacitors Module ACM 510

e3
0b

h3
50

.1
11 2

4

5

3
Figure 54: Connectors on the Top of ACM 510
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1 Ethernet connector IN (X1 IN) 2 Ethernet connector OUT (X2 OUT)

3 I/O connector (I/O ACM) 4 Relay connector (REL ACM)

Procedure

1. Connect the Ethernet cable from the output of the previous system module to the input connector (X1 IN) [1].

2. If I/Os are required, insert the wires into the I/O connector (I/O ACM) and insert the connector [3].

3. If a relay is required, insert the wires into the relay connector (REL ACM) and insert the connector [4].

4. Connect the ACM 510 to PE using one of the PE screws on the front side [5] and a PE wire. The tightening torque is 3 Nm.

5.15 Connecting the Expansion Module EXM 510
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Figure 55: Expansion Module Cable

1 24/48 V 2 GND

3 Functional earth 4 DC–

5 DC– 6 DC+

7 DC+ 8 Shielded area
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Figure 56: Connecting the Expansion Module EXM 510

1 EMC shielding plate screw 2 PE screw

3 DC cables 4 Functional earth cable

5 GND cable 6 24/48 V cable

7 Cable ties
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  NOTICE

l If 2 separate backlinks are used (connected via 1 or 2 pairs of EXM 510 modules), the 2 grounding bars must be also

connected together with a 16 mm2 (6 AWG) cable cross-section.

l For cable cross-sections, see 11.9.13.1 Cable Cross-sections for EXM 510.

1. Insert wires [3], [4], [5], and [6] into the expansion connector.

2. Secure the DC cables [3] using the cable ties [7], ensuring that the shielded area is positioned exactly under the cable tie.

3. Secure the cables [4], [5], and [6] using the cable ties [7].

4. Plug the connectors into the backplate.

5. Tighten the screw on the EMC shielding plate [1]. The tightening torque is 3 Nm.

6. Connect the EXM 510 to PE using the PE screw [2] and a PE wire. The tightening torque is 3 Nm.

5.16 Connecting the Brake Resistor on the PSM 510

The PSM 510 is connected to the internal brake resistor as shown in Figure 57.

Alternatively, the PSM 510 can be connected to an external brake resistor. In this case, the internal brake resistor on the PSM 510 must

remain unconnected and the connector can be placed in the internal brake resistor connector holder.

Paralleling or series of brake resistors is not allowed.
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Figure 57: Connection of Internal Brake Resistor on 1 PSM 510

1 Internal brake resistor
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When using 2 PSM 510 modules, connect each PSM 510 to its own internal brake resistor as shown in Figure 58 (factory setting).

Alternative allowed configurations for 2 PSM 510 modules:

l 1 PSM 510 is connected to the internal brake resistor and the other is connected to an external brake resistor.

l Both PSM 510 modules are connected to an external brake resistor. In this case, the internal brake resistor on the PSM 510 must

remain unconnected and the connector can be placed in the internal brake resistor connector holder (see 5.12.2 Connecting the

Cables on the Bottom of the Power Supply Module PSM 510).

Paralleling or series of brake resistors is not allowed.
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Figure 58: Connection of Brake Resistor on 2 PSM 510 Modules in Parallel

1 Internal brake resistor
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6 Commissioning

6.1 Warnings for Commissioning

  WARNING

UNINTENDED START

The servo system contains servo drives, the PSM 510, and DAM 510 that are connected to the electrical supply network and can

start running at any time. This may be caused by a fieldbus command, a reference signal, or clearing a fault condition. Servo drives

and all connected devices must be in good operating condition. A deficient operating condition may lead to death, serious injury,

damage to equipment, or other material damage when the unit is connected to the electrical supply network.

l Take suitable measures to prevent unintended starts.

6.2 Pre-Commissioning Checklist
Always complete these checks before initial commissioning and before commencing operation after extended downtime or storage.

Procedure

1. Check that all the threaded connectors of mechanical and electrical components are firmly tightened.

2. Check that the free circulation of cooling air (inlet and outlet) is assured.

3. Check that the electrical connections are correct.

4. Ensure that contact protection is in place for rotating parts and surfaces that can become hot.

5. If using the STO functionality, conduct the functional safety concept commissioning test (see 8.8 Commissioning Test).

6.3 EtherCAT® ID Assignment

EtherCAT® needs no special ID assignment (IP address). Special ID assignment is only required when using indirect communication via

the VLT® Servo Toolbox software.

6.4 Ethernet POWERLINK® ID Assignment

6.4.1 Overview

Ethernet POWERLINK® master communication must not be active when using the VLT® Servo Toolbox to assign IDs to the devices.

ID assignment via the VLT® Servo Toolbox is only possible when acyclic Ethernet POWERLINK® communication is used. If Ethernet

POWERLINK® cyclic communication is already started, perform a power cycle to stop it.

Detach the PLC and carry out a power cycle before setting IDs. Alternatively, in the POWERLINK® interface, restart the PLC in Service

Mode while parameter Basic Ethernet in Service Mode is set to Basic Ethernet enabled.

6.4.2 Single Device ID Assignment

When assigning an ID to a single device, use the Device Information window in the VLT®Servo Toolbox (see the VLT® Servo Drive System

ISD 520, DSD 520, MSD 520 (VLT® FlexMotion™) Programming Guide for further information).

Setting an ID to a device can also be done via the LCP.

6.4.2.1 Setting the Node ID Directly on a Servo Drive or on the System Modules

All IP-related parameters are in parameter group 12-0* IP Settings. According to the Ethernet POWERLINK® standard, the IP address is

fixed to 192.168.100.xxx. The last number is the value in parameter 12-60 Node ID. For parameter 12-02 Subnet Mask, the IP address is

fixed to 255.255.255.0 and cannot be changed.

Procedure

1. Attach the LCP to the servo drive or system module for which the Node ID should be changed.
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2. Press [Hand On] for >1 s to make the LCP the controlling interface.

3. Press [Main Menu] then scroll down to parameter group 12-** Ethernet and press [OK].

4. Scroll down to parameter group 12-6* Ethernet POWERLINK and press[OK].

5. Change the PSM 510/DAM 510 node ID to the desired value (1–239).

6. Press [OK] to confirm the selection then wait for the ID assignment procedure to complete.

7. Carry out a power cycle to ensure that all ID changes are in effect and operational on the fieldbus.

6.4.2.2 Setting the Node ID for a Single Servo Drive via the Power Supply Module (PSM 510) or Decentral
Access Module (DAM 510) using the LCP

It is also possible to change the Node ID of a servo drive when the LCP is connected to the PSM 510 or DAM 510. This functionality is

contained in parameter group 54-** ID Assignment in subgroup 54-1* Manual.

Procedure

1. Attach the LCP to the PSM 510/DAM 510 that is connected to the servo drives and system modules for which the Node ID should

be changed.

2. Press [Hand On] for >1 s to make the LCP the controlling interface for the PSM 510/DAM 510.

3. Press [Main Menu] then scroll down to parameter group 12-** Ethernet and press [OK].

4. Scroll down to parameter group 12-6* Ethernet POWERLINK and press [OK].

5. Change the PSM 510/DAM 510 node ID to the desired value (1–239) by pressing [OK].

6. Return to the Main Menu and select parameter group 54-** ID Assignment.

7. Select parameter group 54-1* Manual.

8. PSM 510 only: In parameter 54-01 Epl id assignment line, select either Ethernet port X1 or X2. The PSM 510 assigns IDs to the

selected device via the selected port and the fieldbus network. On DAM 510 port, X2 is used automatically.

9. Select parameter 54-12 Epl ID assignment start id then select a valid value (1–239). The value is assigned to the device at the

specified position index. The PSM 510/DAM 510 connected to the LCP is at position 0 and the 1st reachable device on the

selected port is position index 1 and so on.

10. Select parameter 54-14 Manual Epl ID assignment start and change the status from [0] ready to [1] start.

11. Press [OK] to confirm the selection then wait for the ID assignment procedure to complete.

12. Check that the ID assignment was completed successfully using parameters:

a. Parameter 54-15 Epl ID assignment state

b. Parameter 54-16 Epl ID assignment error code

c. Parameter 54-17 Epl ID assignment device count

13. Carry out a power cycle to ensure that all ID changes are in effect and operational on the fieldbus.

 If an error occurs during ID assignment, the detected error is shown on the LCP. The following errors may be reported:

l Invalid NMT state

l Invalid comment

l Invalid Ethernet port

l Invalid node ID

l ID assignment failed

l Duplicate MAC address

l Invalid SW version

l Incomplete assignment
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l No device found

l Internal error

6.4.3 Multiple Device ID Assignment

When assigning IDs to several devices (for example, when setting up a new network), use the VLT® Servo Toolbox subtool DAM ID

assignment (see the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT® FlexMotion™) Programming Guide for further information).

Setting the IDs of all the servo drives connected to a Decentral Access Module (DAM 510) or Power Supply Module (PSM 510) at the same

time can also be done via the LCP when it is connected to the DAM 510/PSM 510.

6.4.3.1 Setting the Node IDs of all Servo Drives and System Modules on a Decentral Access Module
(DAM 510)/Power Supply Module (PSM 510) Line

The automatic PSM 510/DAM 510 ID assignment is used for automatically setting the Node IDs on all servo drives and system modules for

a specified PSM 510/DAM 510 line. This functionality is contained in parameter group 54- ** ID Assignment in subgroup 54-0* Automatic.

Procedure

1. Attach the LCP to the PSM 510/DAM 510 that is connected to the servo drives and system modules for which the Node ID should

be changed.

2. Press [Hand On] for >1 s to make the LCP the controlling interface for the PSM 510/DAM 510.

3. Press [Main Menu] then scroll down to parameter group 12-** Ethernet and press [OK].

4. Scroll down to parameter group 12-6* Ethernet POWERLINK and press [OK].

5. Change the PSM 510/DAM 510 node ID to the desired value (1–239) by pressing [OK].

6. Return to the Main Menu and select parameter group 54-** ID Assignment.

7. Select parameter group 54-0* Automatic.

8. PSM 510 only: In parameter 54-01 Epl id assignment line, select either Ethernet port X1 or X2. The PSM 510 assigns IDs to the

selected device via the selected port and the fieldbus network. On DAM 510 port, X2 is used automatically.

9. Select parameter 54-02 Epl ID assignment start id then select a valid value (1–239). The value is assigned to the device at the

specified position index. The PSM 510/DAM 510 connected to the LCP is at position 0 and the 1st reachable device on the

selected port is position index 1 and so on.

10. Select parameter 54-03 Automatic Epl ID assignment start and change the status from [0] ready to [1] start.

11. Press [OK] to confirm the selection then wait for the ID assignment procedure to complete.

12. Check that the ID assignment was completed successfully using parameters:

a. Parameter 54-04 Epl ID assignment state

b. Parameter 54-05 Epl ID assignment error code

c. Parameter 54-06 Epl ID assignment device count

13. Carry out a power cycle to ensure that all ID changes are in effect and operational on the fieldbus.

 If an error occurs during ID assignment, the detected error is shown on the LCP. The following errors may be reported:

l Invalid NMT state

l Invalid comment

l Invalid Ethernet port

l Invalid node ID

l ID assignment failed

l Duplicate MAC address
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l Invalid SW version

l Incomplete assignment

l No device found

l Internal error

6.5 PROFINET® ID Assignment

Each PROFINET® device needs a device name and an IP address. The IP address and the device name are assigned by the I/O controller,

when the connection to the I/O device is established.

The IP address and the device name can also be assigned using PRONETA, a free tool that supports in the analysis and configuration of

PROFINET® networks.

6.6 Power-Up Time

The maximum power-up time for the system modules is 15 s. This means the time from supplying the system with auxiliary voltage to

the module being initialized completely.

The power-up time stated is an indicative time. The exact status of the module can be seen via the statusword.

  NOTICE

l Do not operate any of the system modules until they are all powered up correctly.

l If 2 PSM 510 modules are mounted in parallel, power up both PSM 510 modules simultaneously (within a maximum delay of

1 s).

6.7 System Module Charging Time

The charging time of the system is determined by the longest charging time of each individual system module.

The exact status of each module can be seen via the statusword.

  NOTICE

l Do not operate any of the system modules or decentral drives until they are charged up completely. Wait until PSM 510,

DAM 510, and ACM 510 are in state Operation enabled, before bringing the ISD 520/DSD 520 into state Operation enabled.

Table 27: DC link (UDC) Charging Time for PSM 510, DAM 510, and ACM 510

Specification Unit PSM 510 DAM 510 ACM 510

UDC charging time s 2.0 2.0 3.5

6.8 Switching on the ISD 520/DSD 520 System

Complete the cabling of the servo system before applying power to the ISD 520/DSD 520 servo drives. This cabling provides the supply

voltage and the communication signals for the servo system. This is a basic requirement for operation of the ISD 520/DSD 520 servo

drives.

The servo system can be switched on in 2 ways:

l If the Power Supply Module (PSM 510) is supplied with mains, STO, and UAUX, communication to the PSM 510 internal controller is

established and DC link and UAUX are automatically passed on via the backlink to the DAM 510 and then passed on further to the

connected servo drives.
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l If the Power Supply Module (PSM 510) is only powered by UAUX, then the PSM 510, DAM 510, and servo drive control units are

running.

6.8.1 Procedure for Switching on the ISD 520/DSD 520 System

Procedure

1. Switch on UAUX power to enable communication to the PSM 510, DAM 510, and ISD 520/DSD 520 servo drives to be established.

2. Switch on the mains.

3. Set the PSM 510 to state Normal operation.

4. Set the DAM 510 to state Normal operation.

Now the PSM 510, DAM 510, and the ISD 520/DSD 520 servo drives are ready for operation.

6.9 Libraries

The libraries provided for the ISD 520/DSD 520 servo system are:

l TwinCAT® V3

l Automation Studio™ environment (version 4.x, supported platform SG4) to easily integrate the functionality without the need for

special motion run-time on the controller.

l TiA from V17

The provided function blocks conform to the PLCopen® standard. Knowledge of the underlying fieldbus communication and/or the

CANopen® CiA DS 402 profile is not necessary.

The library contains:

l Function blocks for controlling and monitoring the ISD 520/DSD 520 servo drives and the system modules.

l Function blocks for all available motion commands of the ISD 520/DSD 520 servo drives.

l Function blocks for controlling and monitoring the PSM 510, DAM 510, and ACM 510.

l Function blocks and structures for creating Basic CAM profiles.

l Function blocks and structures for creating Labeling CAM profiles.

6.10 Programming with Automation Studio™

6.10.1 Requirements for Programming with Automation Studio™

The following files are required to integrate the ISD 520/DSD 520 servo drives, the PSM 510, and DAM 510 into an Automation Studio™

project:

l Package of libraries for the MSD 510 servo system: VLT_FlexMotion_Automation_Studio_Lib_Vx.y.z.zip

l XDD file (XML Device Description) for the ISD 520/DSD 520 servo drive: 0x0200008D_VLT_[ISD/DSD]_520_zzz_CTyy.xdd

l XDD file (XML Device Description) for the Power Supply Module (PSM 510): 0x0200008D_PSM.xdd

l XDD file (XML Device Description) for the Decentral Access Module (DAM 510): 0x0200008D_DAM.xdd

6.10.2 Creating an Automation Studio™ Project

The procedures described in this chapter apply to Automation Studio™ Version V4.x unless otherwise specified.

Information on how to install Automation Studio™ can be found in detail in the Automation Studio™ help. Open the B&R Help Explorer

and go to [Automation software → Software Installation → Automation Studio].

Information on how to create a project in Automation Studio™ can be found in detail in the Automation Studio™ help.
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Creating a project:

Open the B&R Help Explorer and go to Automation Software → Getting Started → Creating programs with Automation Studio → Example

project for a target system with CompactFlash.

6.10.3 Including the Servo Motion Libraries into an Automation Studio™ Project

1. In the Logical View, open the menu entry File → Import....

2. In the next window, select the Danfoss_VLT_ServoMotion_V_x_y_z.zip file (according to the location on the hard drive).

3. Click on Open.

4. Assign the libraries to the CPU in the next window.

5. Click on Finish. Now the libraries are integrated into the Automation Studio™ project.

 
Table 28: Servo Motion Libraries

Library Description

DDS_Drive • Contains program organization units (POUs) defined by PLCopen® (name starting
with MC_) and POUs defined by Danfoss (name starting with DD_). The Danfoss
POUs provide additional functionality for the axis.

• It is possible to combine POUs defined by PLCopen® with POUs defined by
Danfoss.

• The names of the POUs that target the servo drive all end with _DDS.

• When integrating the DDS_Drive package, some standard libraries are integrated
automatically, unless they are already part of the project.

DDS_PSM • Contains POUs defined by Danfoss (name starting with DD_) and provides the
functionality for the Power Supply Module (PSM 510).

• The names of the POUs that target the PSM 510 all end with _PSM.

DDS_DAM • Contains POUs defined by Danfoss (name starting with DD_) and provides the
functionality for the Decentral Access Module (DAM 510).

• The names of the POUs that target the DAM 510 all end with _DAM.

DDS_ACM • Contains POUs defined by Danfoss (name starting with DD_) and provides the
functionality for the Auxiliary Capacitors Module (ACM 510).

• The names of the POUs that target the ACM 510 all end with _ACM.

DDS_BasCam • Contains POUs for the creation of basic CAMs.

DDS_LabCam • Contains POUs for the creation of labeling CAMs.

DDS_Intern • Contains POUs that are needed internally for the libraries.

• Do not use these POUs in an application.

  NOTICE

l Do not remove these libraries otherwise the Danfoss servo motion libraries will not work.

6.10.4 Constants within the DDS_Drive Library

The constants are defined inside the DDS_Drive library (see Table 29).

Danfoss A/S © 2024.11                                                                                                                                                                        AQ441543733781en-000101 / 130R1298 | 91



Table 29: List of Constants

Constant Description

Danfoss_VLT_ServoMotion • Contains the version information of the library.

DDS_AxisErrorCodes • Constants for error codes of the axis.

• Error codes can be read using the function block MC_ReadAxisError_DDSand/or
DD_ReadAxisWarning_DDS.

DDS_AxisTraceSignals • Constants for the trace signals of the axis.

• Intended to be used with the function block DD_Trace_DDS.

DDS_BasCam • Constants for the creation of basic CAMs.

DDS_CamParsingErrors • Constants for parsing problems of a CAM.

• Error reason is returned by function block MC_CamTableSelect_DDS.

DDS_FB_ErrorConstants • Constants for errors inside POUs.

• The reason is given in an output ErrorInfo.ErrorID that is available in all POUs.

DDS_Intern • Constants which are needed internally for the library.

• They are not intended to be used in an application.

DDS_LabCam • Constants for the creation of labeling CAMs.

DDS_SdoAbortCodes • Constants for errors concerning reading and writing of parameters.

• The reason is given in an output AbortCode that is available in several POUs.

PSM_ErrorCodes • Constants for error codes of the Power Supply Module (PSM 510).

• Error codes can be read using the function block DD_ReadPsmError_PSMand/or
DD_ReadPsmWarning_PSM.

PSM_TraceSignals • Constants for the trace signals of the Power Supply Module (PSM 510).

• Intended to be used with the function block DD_Trace_PSM.

DAM_ErrorCodes • Constants for error codes of the Decentral Access Module (DAM 510).

• Error codes can be read using the function block DD_ReadDamError_DAMand/or
DD_ReadDamWarning_DAM.

DAM_TraceSignals • Constants for the trace signals of the Decentral Access Module (DAM 510).

• Intended to be used with the function block DD_Trace_DAM.

ACM_ErrorCodes • Constants for error codes of the Auxiliary Capacitors Module (ACM 510).

• Error codes can be read using the function block DD_ReadAcmError_ACM and/or
DD_ReadAcmWarning_ACM.

ACM_TraceSignals • Constants for the trace signals of the Auxiliary Capacitors Module (ACM 510).

• Intended to be used with the function block DD_Trace_ACM.

6.10.5 Instantiating AXIS_REF_DDS in Automation Studio™

1. Create 1 instance of function block AXIS_REF_DDS (located in folder DDS_Drive) for every servo drive that has to be controlled or

monitored.

2. To create a link to the physical servo drive, link each instance of AXIS_REF_DDS to 1 physical servo drive. This makes it the logical

representation of 1 physical servo drive.

a. Open the Logical View.

b. Initialize each instance with its node number and the slot name it is connected to (for example, IF3).

c. Initialize each instance of a drive with its DriveType.
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6.10.6 Instantiating PSM_REF in Automation Studio™

1. Create 1 instance of function block PSM_REF (located in folder DDS_PSM) for every Power Supply Module (PSM 510) that has to

be controlled or monitored.

2. To create a link to the physical PSM 510, link each instance of PSM_REF to 1 physical PSM 510. This makes it the logical

representation of 1 physical PSM 510.

a. Open the Logical View.

b. Initialize each instance with its node number and the slot name it is connected to (for example, IF3).

6.10.7 Instantiating DAM_REF in Automation Studio™

1. Create 1 instance of function block DAM_REF (located in folder DDS_DAM) for every Decentral Access Module (DAM 510) that

has to be controlled or monitored.

2. To create a link to the physical DAM 510, link each instance of DAM_REF to 1 physical DAM 510. This makes it the logical

representation of 1 physical PSM 510.

a. Open the Logical View.

b. Initialize each instance with its node number and the slot name it is connected to (for example, IF3).

6.10.8 Instantiating ACM_REF in Automation Studio™

1. Create 1 instance of function block ACM_REF (located in folder ACM_PSM) for every Auxiliary Capacitors Module (ACM 510) that

has to be controlled or monitored.

2. To create a link to the physical ACM 510, link each instance of ACM_REF to 1 physical ACM 510. This makes it the logical

representation of 1 physical PSM 510.

a. Open the Logical View.

b. Initialize each instance with its node number and the slot name it is connected to (for example, IF3).

6.10.9 Importing a Servo Drive into Automation Studio™

  NOTICE

l For each physical servo drive, add 1 entry to the Physical View of Automation Studio™.

6.10.9.1 Version V4.x

1. Select the menu entry Tools → Import Fieldbus Device....

2. Select the XDD file (for example, 0x0200008D_VLT_ISD_520_XXX_CTIO.xdd) from its location on the hard drive. The device is

then known to Automation Studio™.

3. Now add the servo drive to the Ethernet POWERLINK® interface of the controller in the Physical View:

a. Select the menu entry Open → System Designer to show the System Designer.

b. To add a hardware module to the Physical View or System Designer, select the servo drive in the group POWERLINK in the

Hardware Catalog toolbox.

c. Drag the selected module to the desired position to connect it to the selected hardware module, network interface, or slot.

d. To change the node number, right-click on the device and select Node Number → Change Node Number.
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Figure 59: Adding a Servo Drive to the Project

6.10.10 Importing PSM 510, DAM 510, and ACM 510 into Automation Studio™

  NOTICE

l For each physical Power Supply Module (PSM 510), Decentral Access Module (DAM 510), and Auxiliary Capacitors Module

(ACM 510), add 1 entry to the Physical View of Automation Studio™.

6.10.10.1 Version V4.x

Procedure

1. Select the menu entry Tools → Import Fieldbus Device....

2. Select the XDD file for the PSM 510, DAM 510, or ACM 510 from its location on the hard drive. The device is then known to

Automation Studio™.

– Power Supply Module (PSM 510): 0x0200008D_PSM.xdd

– Decentral Access Module (DAM 510): 0x0200008D_DAM.xdd

– Auxiliary Capacitors Module (ACM 510): 0x0200008D_ACM.xdd

3. Now add the PSM 510, DAM 510, or ACM 510 to the Ethernet POWERLINK® interface of the controller in the Physical View:

a. Select the menu entry Open → System Designer to show the System Designer.

b. To add a hardware module to the Physical View or System Designer, select the PSM 510, DAM 510, or ACM 510 in the group

POWERLINK in the Hardware Catalog toolbox.

c. Drag the selected module to the desired position to connect it to the selected hardware module, network interface, or slot.

d. To change the node number, right-click on the device and select Node → Change Node Number.

 
n PSM: Danfoss_VLT_R_PSM

n DAM: Danfoss_VLT_R_DAM

n ACM: Danfoss_VLT_R_ACM
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Figure 60: 1 PSM 510, 1 DAM 510, and 2 ISD 520 Servo Drives Added to the Ethernet POWERLINK® Interface in V4.x
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6.10.11 I/O Configuration and I/O Mapping

Procedure

1. Parameterize the I/O configuration of the ISD 520/DSD 520 servo drives so that the library has access to all necessary objects.

a. Right-click on the entry of the ISD 520/DSD 520 servo drive and select Configuration.

b. In the Channels section, change the Cyclic transmission of the following objects:

 
n All sub-indexes of object 0x5050 (Lib pdo rx_I5050 ARRAY[]) to Write.

n All sub-indexes of object 0x5051 (Lib pdo tx_I5051 ARRAY[]) to Read.

2. Parameterize the I/O configuration of the Power Supply Module (PSM 510), Decentral Access Module (DAM 510), and Auxiliary

Capacitors Module (ACM 510) so that the library has access to all necessary objects.

a. Right-click on the entry of the PSM 510/DAM 510/ACM 510 and select Configuration.

b. In the Channels section, change the Cyclic transmission of the following objects:

 
n All sub-indexes of object 0x5050 (Lib pdo rx_I5050 ARRAY[]) to Write.

n All sub-indexes of object 0x5051 (Lib pdo tx_I5051 ARRAY[]) to Read.

  NOTICE

l These settings configure the cyclic communication with the device. These parameters are required for the library to work.

l It is possible to use copy and paste to apply the same I/O configuration to multiple devices of the same type.

3. Set Module supervised to off for the servo drives and the PSM 510/DAM 510/ACM 510. The parameter is found in the I/O

configuration of the device.
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Figure 61: I/O Configuration of an ISD 520 Device
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Figure 62: I/O Mapping after Successful Configuration

4. Map the inputs and outputs of the instance of the AXIS_REF_DDS function block and the physical data points of the ISD 520/

DSD 520 servo drive (here myAxis is an instance of AXIS_REF_DDS):
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Figure 63: I/O Mapping of an ISD 520 Servo Drive

5. Map the inputs and outputs of the instance of the PSM_REF, DAM_REF, and ACM_REF function blocks and the physical data

points of the PSM 510/DAM 510/ACM 510 accordingly.

6.10.12 Setting the PLC Cycle Time

The minimum cycle time is 400 μs. The servo system devices can run Ethernet POWERLINK® cycle times in multiples of 400 μs and

multiples of 500 μs. The devices are automatically parameterized by the PLC on start-up, depending on the Ethernet POWERLINK®

configuration of the physical interface.

The Ethernet POWERLINK® configuration can be accessed by right-clicking PLK → Configuration in the Physical View.

  NOTICE

l Ensure that the task cycle times of the PLC program and Ethernet POWERLINK® are the same. Otherwise, data could be lost

and performance reduced.
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Figure 64: Ethernet POWERLINK®Configuration Window to Parameterize Ethernet POWERLINK® Cycle Time

Procedure

1. Right-click CPU → Configuration → Timing in the Physical View.

2. Ensure that the PLC cycle time is the same as the Ethernet POWERLINK® cycle time.

6.10.13 Connecting to the PLC

Information on how to connect to the PLC can be found in detail in the Automation Studio™ Help.

Open the B&R Help Explorer and go to Automation Software → Getting Started → Creating programs in Automation Studio → Example

project for a target system with CompactFlash.
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6.11 Programming with TwinCAT®

6.11.1 Requirements for Programming with TwinCAT®

To integrate the ISD 520/DSD 520 servo drives and the PSM 510, DAM 510, or ACM 510 into a TwinCAT® project, the following files are

required:

l Library for the ISD 520 servo system: Danfoss_VLT_ServoMotion_V_x_y_z.compiled-library

l Common ESI file (EtherCAT® Slave Information) Danfoss_Drives.xml with separate device sections for each configuration:

¢ VLT® Integrated Servo Drive ISD 520

¢ VLT® Integrated Servo Drive ISD 520 with VLT® FlexSafety™ option

¢ VLT® Integrated Servo Drive ISD 520 with VLT® FlexSafety™ option and Safe I/O option board

¢ VLT® Integrated Servo Drive ISD 520 with VLT® FlexSafety™ option and Standard I/O option board

¢ VLT® Integrated Servo Drive ISD 520 with Standard I/O option board

¢ VLT® Decentral Servo Drive DSD 520

¢ VLT® Decentral Servo Drive DSD 520 with VLT® FlexSafety™ option

¢ VLT® Decentral Servo Drive DSD 520 with VLT® FlexSafety™ option and Safe I/O option board

¢ VLT® Decentral Servo Drive DSD 520 with VLT® FlexSafety™ option and Standard I/O option board

¢ VLT® Decentral Servo Drive DSD 520 with Standard I/O option board

l ESI file (EtherCAT® Slave Information) for the Power Supply Module: Danfoss_PSM510.xml

l ESI file (EtherCAT® Slave Information) for the Decentral Access Module: Danfoss_DAM510.xml

l ESI file (EtherCAT® Slave Information) for the Auxiliary Capacitor Module: Danfoss_ACM510.xml

6.11.2 Creating a TwinCAT® Project

Information on how to install TwinCAT® can be found in detail in the Beckhoff Information System (https://infosys.beckhoff.com/).

Open the information system and select TwinCAT 3 → Installation.

Information on how to create a project in TwinCAT® can be found by opening the information system and selecting TwinCAT 3 →
TE1000 XAE → PLC.

6.11.3 Including the TwinCAT® Library into a TwinCAT® Project

Before a library can be used in a project, it has to be first installed on the system via the Library Repository:

1. Right-click on the References in the PLC project tree and select Library Repository.

2. Click on Install and select the Danfoss_VLT_ServoMotion_V_x_y_z library file (according to the location on the hard drive). Now

the library can be integrated into the TwinCAT project.

3. Close the Library Repository dialog by clicking on the Close button.

4. Right-click on the References in the PLC project tree and select Add Library.

5. Use the search field in the upper area of the Add Library dialog to filter available library references by name and select the

Danfoss_VLT_ServoMotion library.

6. Click OK to complete the procedure and integrate the library reference into the TwinCAT® PLC project.

 Library references are also shown in the Library Manager, which offers a good overview of the installed PLC libraries and can be

used to integrate and manage libraries in a project, similar to the procedure above.
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Figure 65: Library Manager after Including the ServoMotion Library

Inside the library, the POUs are organized into folders:

l DDS_Drive

¢ Contains program organization units (POUs) defined by PLCopen® (name starting with MC_) and POUs defined by

Danfoss (name starting with DD_). The Danfoss POUs provide additional functionality for the axis.

¢ It is possible to combine POUs defined by PLCopen® with POUs defined by Danfoss.

¢ The names of the POUs that target the servo drives all end with _DDS.

l DDS_PSM

¢ Contains POUs defined by Danfoss (name starting with DD_) and provides the functionality for the Power Supply

Module (PSM 510).

¢ The names of the POUs that target the PSM 510 all end with _PSM.

l DDS_DAM

¢ Contains POUs defined by Danfoss (name starting with DD_) and provides the functionality for the Decentral Access

Module (DAM 510).

¢ The names of the POUs that target the DAM 510 all end with _DAM.

l DDS_ACM

¢ Contains POUs defined by Danfoss (name starting with DD_) and provides the functionality for the Auxiliary Capacitors

Module (ACM 510).

¢ The names of the POUs that target the ACM 510 all end with _ACM.

l DDS_BasCam

¢ Contains POUs for the creation of basic CAMs.
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l DDS_LabCam

¢ Contains POUs for the creation of labeling CAMs.

l DDS_Intern

¢ Contains POUs that are needed internally for the libraries.

¢ Do not use these POUs in an application

When integrating the VLT® Integrated Servo Drive library, some standard libraries are integrated automatically, unless they are already

part of the project.

  NOTICE

l Do not remove these libraries otherwise the DDS libraries will not work.

6.11.4 Constants within the DDS_Drive Library

The constants are defined inside the DDS_Drive library (see Table 30).

Table 30: List of Constants

Constant Description

Danfoss_VLT_ServoMotion • Contains the version information of the library.

DDS_AxisErrorCodes • Constants for error codes of the axis.

• Error codes can be read using the function block MC_ReadAxisError_DDSand/or
DD_ReadAxisWarning_DDS.

DDS_AxisTraceSignals • Constants for the trace signals of the axis.

• Intended to be used with the function block DD_Trace_DDS.

DDS_BasCam • Constants for the creation of basic CAMs.

DDS_CamParsingErrors • Constants for parsing problems of a CAM.

• Error reason is returned by function block MC_CamTableSelect_DDS.

DDS_FB_ErrorConstants • Constants for errors inside POUs.

• The reason is given in an output ErrorInfo.ErrorID that is available in all POUs.

DDS_Intern • Constants which are needed internally for the library.

• They are not intended to be used in an application.

DDS_LabCam • Constants for the creation of labeling CAMs.

DDS_SdoAbortCodes • Constants for errors concerning reading and writing of parameters.

• The reason is given in an output AbortCode that is available in several POUs.

PSM_ErrorCodes • Constants for error codes of the Power Supply Module (PSM 510).

• Error codes can be read using the function block DD_ReadPsmError_PSMand/or
DD_ReadPsmWarning_PSM.

PSM_TraceSignals • Constants for the trace signals of the Power Supply Module (PSM 510).

• Intended to be used with the function block DD_Trace_PSM.

DAM_ErrorCodes • Constants for error codes of the Decentral Access Module (DAM 510).

• Error codes can be read using the function block DD_ReadDamError_DAMand/or
DD_ReadDamWarning_DAM.

DAM_TraceSignals • Constants for the trace signals of the Decentral Access Module (DAM 510).

• Intended to be used with the function block DD_Trace_DAM.
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Table 30: List of Constants (continued)

Constant Description

ACM_ErrorCodes • Constants for error codes of the Auxiliary Capacitors Module (ACM 510).

• Error codes can be read using the function block DD_ReadAcmError_ACM and/or
DD_ReadAcmWarning_ACM.

ACM_TraceSignals • Constants for the trace signals of the Auxiliary Capacitors Module (ACM 510).

• Intended to be used with the function block DD_Trace_ACM.

6.11.5 Instantiating AXIS_REF_DDS in TwinCAT®

Procedure:

1. Create 1 instance of function block AXIS_REF_DDS (located in folder DDS_Drive) for the ISD 520 servo drive that has to be

controlled or monitored.

2. Repeat step 1 for each additional servo drive.
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Figure 66: Instantiation of AXIS_REF_DDS

6.11.6 Instantiating PSM_REF in TwinCAT

Procedure:

1. Create 1 instance of function block PSM_REF (located in folder DDS_PSM) for each Power Supply Module that has to be

controlled or monitored.

2. Repeat step 1 for each additional PSM 510.

6.11.7 Instantiating DAM_REF in TwinCAT

1. Create 1 instance of function block DAM_REF (located in folder DDS_PSM) for each Decentral Access Module that has to be

controlled or monitored.

2. Repeat step 1 for each additional DAM 510.
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6.11.8 Instantiating ACM_REF in TwinCAT

Procedure:

1. Create 1 instance of function block ACM_REF (located in folder DDS_ACM) for each Auxiliary Capacitors Module that has to be

controlled or monitored.

2. Repeat step 1 for each additional ACM 510.

6.11.9 Adding a PLC Project to TwinCAT® System Manager

A PLC project contains the objects required to create a controller program:

l Pure programming blocks, for example, programs, function blocks, functions, GVLs.

l Objects that are also required to run the program on a PLC, for example, referenced tasks, library managers, and visualizations.

A standard PLC project can be created as follows:

1. Select the command New→ Project in the menu File.

2. Select the template TwinCAT Projects → TwinCAT XAE Project, then enter a name (for example, TwinCAT project ) and a storage

location in the file system. Click on OKto confirm.

3. A new solution opens in the Solution Explorer with an empty PLC project.

4. Mark the PLC object in the project tree and select the command Add New Item in the menu Projector in the context menu. The

dialog Add New Item <TwinCAT project name> opens.

5. Select the Standard PLC Project in the category Plc Templates and enter a name (for example, PLC project).

6. Quit the dialog with Add. The following structure is created in the view Solution Explorer.

e3
0b

l7
92

.1
0

Figure 67: Structure of a Standard PLC Project

With the selected template the following basic objects appear automatically under the node PLC Project:

¢ A PLC project (PLC project Project) and a project instance (PLC project Instance).

¢ The PLC project contains:

n A library manager (References).

n The standard program block MAIN and a task reference (PlcTask). The task referenced there (PlcTask) defines the
execution of the program block MAIN.

n In addition, the structure folders External Types, DUTs, GVLs, POUs, and VISUs appear automatically.
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The library manager already contains the standard libraries with basic blocks such as counters, timers, and string functions that

can then be used for programming.

Filling MAIN with error-free code enables it to be loaded to the controller and run without the need for further programming

objects.

6.11.10 Importing Devices to TwinCAT®

The TwinCAT® System Manager and the TwinCAT® EtherCAT Master require the device description files of all EtherCAT devices for

configuration in online and offline mode.

The device descriptions are contained in the so-called ESI files (EtherCAT Slave Information) in XML format, and they should be made

available to TwinCAT® before a device can be imported into the project. Only then can new I/O modules be imported into the TwinCAT®

project.

The whole procedure can be summarized as follows.

1. Copy the Danfoss_Drives.xml ESI file into TwinCAT® installation directory C:\TwinCAT\3.1\Config\Io\EtherCAT on the hard drive*.

2. Right-click on I/O → Devices and select Add New Item.

3. In the following window, select EtherCAT→ EtherCAT Master and click on OK.
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Figure 68: Add an EtherCAT Master to the Project

4. A new entry Device 1 is now available in the tree view of the I/O configuration, with its own input and output modules (boxes)

added below the device’s node. Before it can be used, the correct network adapter should be selected in the Device Found At

window.

5. Right-click on the configured I/O device Device1 (EtherCAT) to open the context menu for adding 1 of the supported I/O

modules. Select menu item Add New Item to open the Insert EtherCAT Device window and select from the available modules.
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6. To add a VLT® Power Supply Module, select Danfoss GmbH → VLT® FlexMotion → VLT® Power Supply Module PSM 510 and click on

OK to confirm I/O device selection and close the window.
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Figure 69: Add a VLT® Power Supply Module PSM 510 to the Project

7. To add a VLT® Decentral Access Module, right-click on Device1 (EtherCAT) and select Add New Item.

8. In the Insert EtherCAT Device window, select Danfoss GmbH → VLT® FlexMotion → VLT® Decentral Access Module DAM 510 and click

on OK to confirm I/O device selection and close the window.

9. To add a VLT® Auxiliary Capacitors Module ACM 510, right-click on Device1 (EtherCAT) and select Add New Item.

10. In the Insert EtherCAT Device window, select Danfoss GmbH → VLT® FlexMotion → VLT® Auxiliary Capacitors Module ACM 510 and

click on OK to confirm I/O device selection and close the window.

11. To add a VLT® Servo Drive Module to the VLT® Decentral Access Module DAM 510, right-click on Box 1 (VLT® Decentral Access

Module 510) and select Add New Item.

12. In the Add EtherCAT Device window, select Danfoss Drives A/S→ VLT® FlexMotion → VLT® Integrated Servo Drive ISD® 520 and click

on OK to confirm I/O device selection and close the window.
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Figure 70: Add a VLT® Integrated Servo Drive ISD® 520 to the Project

13. Answer the question if the servo drive is used as an NC axis with Cancel. If the servo drive is to be used as an NC axis, see 6.11.14

Configuration as a TwinCAT® NC Axis.

 This is the result after appending a new PLC Project and adding some Danfoss devices:

¢ 1 x VLT® Decentral Access Module DAM 510

¢ 2 x VLT® Integrated Servo Drive ISD® 520
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Figure 71: TwinCAT System Manager after Appending the PLC Project and Adding a VLT® Decentral Access Module DAM 510 and

2 VLT® Integrated Servo Drive ISD® 520

  NOTICE

l Add 1 entry to the EtherCAT® master of the TwinCAT System Manager for each physical servo drive, PSM 510, DAM 510, and

ACM 510. Add the servo drive to the correct DAM 510 line.

This step only has to be done once per project because the TwinCAT® System Manager automatically searches for ESI files at this location

on the hard drive during start-up.

6.11.11 I/O Configuration and I/O Mapping

For each EtherCAT device, the TwinCAT® System Manager indicates at which Previous Port it is connected, that is, the name of the

connected port (B to D) of the previous slave. This assignment is required to correctly map an EtherCAT network in TwinCAT® "offline"

configuration.
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Figure 72: Setting the Previous Port of an EtherCAT Device

When connecting >1 ISD 520/DSD 520 servo drive, ensure that port B of the previous servo drive is connected to port C of the next servo

drive. Port assignment is also required for VLT® Decentral Access Modules.
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If the hardware setup is already present, the Scan command of the TwinCAT®  System Manager can be used to automatically add the

connected devices to the configuration in the correct order.

It is also important that the ISD 520/DSD 520 servo drive configuration is optimized so that the process data output (PDO) mapping

matches the requirements of the library.

1. Click on the VLT® ISD 520 drive entry to show the general and terminal-specific dialogs.

2. Select the Slots tab on the right side of the window.

3. Make sure that Library PDO is selected as the PDO mapping module in the Slot box. If not, replace the current module (for

example, CSP PDO configuration) with Library PDO using the available buttons.
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Figure 73: ISD 520 Servo Drive with Correct I/O Configuration

6.11.12 Attaching the Input and Output Variables to the Physical Data Points

Use the TwinCAT® System Manager to attach the input and output variables of the PLC program to the physical inputs and outputs of the

device. This ensures that the library has access to all necessary objects.

  WARNING

l Repeat steps 2–22 for Box 1 (VLT® Power Supply Module) and the instance myPSM.

l Repeat steps 2–22 for Box 2 (VLT® Decentral Access Module) and the instance myDAM.

1. In the tree view of the I/O configuration, select Library TxPDO via menu I/O → Devices → Device 1 (EtherCAT)→ Box 1 (VLT®

Decentral Access Module DAM 510) → Drive 1 (VLT ISD 520 XXX_CTXX) → Module 1 (Library PDO) → Library TxPDO.

2. Select entries from Lib pdo tx 1 to Lib pdo tx 9  that form the transmit PDO (TxPDO).

3. Right-click and select Change Multi Link.

4. In the Attach Variable 36.0 Byte(s) (Input) window, select the variable referencing the servo drive MAIN. → myAxis1. → TPDO.

Ensure that the Matching Size option is selected in the Attach Variable window.
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Figure 74: Attaching Inputs and Outputs to the Physical Data Points

5. Click on OK.

6. In the tree view of the I/O configuration, select Library RxPDO via menu I/O → Devices → Device 1 (EtherCAT) → Box 1 (VLT®

Decentral Access Module DAM 510) → Drive 1 (VLT ISD 520 XXX_CTXX) → Module 1 (Library PDO) → Library RxPDO.

7. Select all entries from Lib pdo rx 1 to Lib pdo rx 9 that form the receive PDO (RxPDO).

8. Right-click and select Change Multi Link.

9. In the Attach Variable 36.0 Byte(s) (Output) window, select the variable referencing the servo drive MAIN. → myAxis1. → RPDO.

Ensure that the Matching Size option is selected in the Attach Variable window.

10. Click on OK.

11. Right-click on the WcState item I/O → Devices → Device 1 (EtherCAT)→ Box 1 (VLT® Decentral Access Module DAM 510) → Drive 1

(VLT ISD 520 XXX_CTXX) → WcState → WcState and select Change Link.

12. In the Attach Variable State (Input) window, select MAIN. → myAxis1. → WcState.

13. Click on OK.

14. Right-click on the State item I/O → Devices → Device 1 (EtherCAT)→ Box 1 (VLT® Decentral Access Module DAM 510) → Drive 1 (VLT

ISD 520 XXX_CTXX) → InfoData → State and select Change Link.

15. In the Attach Variable State (Input) window, select MAIN. → myAxis1. → State.

16. Click on OK.

17. Right-click on the netId item I/O → Devices → Device 1 (EtherCAT) → Box 1 (VLT® Decentral Access Module DAM 510) → Drive 1 (VLT

ISD 520 XXX_CTXX) → InfoData → AdsAddr → netId and select Change Link.

18. In the Attach Variable netId (Input) window, select MAIN. → myAxis1. → AmsNetId.

19. Click on OK.

20. Right-click on the port item I/O → Devices → Device 1 (EtherCAT)→ Box 1 (VLT® Decentral Access Module DAM 510) → Drive 1 (VLT

ISD 520 XXX_CTXX) → InfoData → AdsAddr → port and select Change Link.

21. In the Attach Variable port (Input) window, select MAIN. → myAxis1. → NodeNumber.

22. Click on OK.
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6.11.13 Configuring the Real-Time

The runtime component of TwinCAT 3 (XAR) has to run under real-time conditions so that it will not be pre-empted by other tasks on the

computer while executing machine control logic. The tasks it executes always get priority over normal Windows programs.

To configure the real-time behavior of TwinCAT 3, follow these steps:

1. Double-click on the SYSTEM → Real-Time node in the Solution Explorer to open the Real-Time configuration window.

2. Click the Read from Target button to make TwinCAT 3 read the actual configuration from the PC. The cores are listed in the top

list box and they can be allocated between Windows (like Shared Cores 0–2 with RT-Core option unchecked), the TwinCAT 3

runtime (like Isolated Cores 4–7 with RT-Core option checked), or both (like Shared Core 3, with RT-Core option checked). The

Core Limit column shows how much CPU time is reserved to the TwinCAT 3 runtime when it shares a core with Windows.
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Figure 75: Real-Time Configuration

3. The lower grid allows to configure which tasks run on which core. It also shows the EtherCAT cycle time under the column Base

Time (ms) as well as the cycle time of the task running the PLC program (PlcTask) under column Cycle Time (ms). For optimum

performance, it is essential that these 2 values are equal otherwise data may be lost and performance reduced. The Base Time

can be set under the corresponding column in the upper grid, while the Cycle Time can be indirectly changed via the Tasks node

in the Solution Explorer (System → Tasks → PlcTask), where the number of cycle ticks used by a certain task is defined:
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Figure 76: Task Configuration

4. ISD 520 devices can only run EtherCAT® cycle times in multiples of 400 μs or 500 μs, therefore ensure that a multiple of these

base times is chosen for proper functionality.

  NOTICE

l Set the task cycle time of the PLC program to be the same as the EtherCAT® cycle time. Otherwise data may be lost and

performance reduced.

  NOTICE

l Connect the PSM 510, DAM 510, and ACM 510 to 1 SYNC unit and the ISD 520/DSD 520 servo drives to another. This protects

against interruptions in communication to the PSM 510 and DAM 510 if the UAUX supply to the servo drives is switched off

due to an error.

6.11.14 Configuration as a TwinCAT® NC Axis

The servo drives can be used with the built-in NC functionality of TwinCAT®.

Everything that is related to the PSM 510 and DAM 510 must be done as described in 6.11.2 Creating a TwinCAT® Project.

1. In addition to the Danfoss_VLT_ServoMotion_V_x_y_z.lib file, include the Tc2_MC2 library.

2. Create 1 instance of AXIS_REF (instead of AXIS_REF_DDS) for each ISD 520/DSD 520 servo drive that is used as an NC axis.

3. Append the PLC project into the TwinCAT® System Manager, import the devices, and add them to TwinCAT®, however in the last

step, answer the question if the servo drive is used as an NC axis with Yes. Then an NC task is created automatically.

6.11.14.1 I/O Configuration for Servo Drives used as NC Axes

In the TwinCAT® System Manager, select a different I/O Configuration for the servo drives used as NC axes.

1. Depending on the mode of operation to be used, select either the slot CSP PDO or CSV PDO (see 6.11.11 I/O Configuration and I/

O Mapping for process data output (PDO) mapping details). Per default, CSV PDO is mapped and pre-selected.

2. Map the following variables if the VLT® Integrated Servo Drive servo drive is required to work with CSP PDO:

a. In the Settings Tab of the NC Axis, select MOTION → NC-Task 1 SAF → Axes → Axis 1. Click on the Link To I/O button and select

the servo drive under I/O to be linked with the NC axis.
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b. Click on the Link To PLC button and select the PLC instance of the axis to be linked with the NC axis.

3. In the same tab, select the preferred Unit for the position of the axis.

4. Depending on the selected unit, adjust the Scaling Factor for the axis encoder via menu MOTION → NC-Task 1 SAF → Axes →
Axis 1 → Enc in the Parameter tab.

When the unit Degrees is selected, the scaling factor is 360°/220 = 0.00034332275390625.

5. Set the Reference Velocity in the Parameter tab via menu MOTION → NC-Task 1 SAF → Axes → Axis 1.

6. Set the Output Scaling Factor (Velocity) to 125.

7. Test the functionality and the configuration in the Online  tab of the axis.

6.11.15 Loading the Program Code and Starting the PLC

Information on how to transfer the PLC project to the controller can be found in the Back-end Information System.

Open the information system and go to TwinCAT 3 → TE1000 XAE → PLC → Transfer PLC project to the PLC.

6.12 Programming Guidelines for Automation Studio™ and TwinCAT®

Recommendations for implementation:

l Initialize parameters that usually do not change only once at the beginning of the program. In Automation Studio™, use the _INIT

section.

l Call up function blocks that provide status or error information with Enable input at the beginning of the program.

l Use 1 instance of the function block MC_Power_DDS for every axis to control its power stage. Call up this function block in every PLC

cycle.

l Use 1 instance of the function block DD_Power_PSM for every PSM 510 to control the DC-link voltage on the output. Call up this

function block in every PLC cycle.

l Use 1 instance of the function block DD_Power_DAM for every DAM 510 to control the DC-link voltage on the output. Call up this

function block in every PLC cycle.

l Use 1 instance of the function block DD_Power_ACM for every ACM 510 to control the connection between the DC link and the

ACM 510. Call up this function block in every PLC cycle.

l Call up function blocks that execute (motion) commands at the end of the program.

l Do not use any POUs from the library (folder) DDS_Intern.

l Do not change the reference to the axis on a function block while it is busy.

6.13 Programming with TIA

6.13.1 Requirements for Programming with TIA

The following files are required to integrate the servo system modules into a TIA project. In the filename, 2.xx represents the version

number and yyyymmdd represents the date.
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Table 31: Required Files

System module File required

Whole servo system Package of libraries for the ISD 520/DSD 520 servo system:
Danfoss_VLT_ServoMotion_V_x_y_z.zalxx.

ISD 520/DSD 520 servo drive Common GSDML file (General station description) GSDML-V2.xx-
Danfoss-DDS-yyyymmdd.xml with separate device access points
for the following configurations:

• VLT® Decentral Servo Drive DSD 520

• VLT® Decentral Servo Drive DSD 520 with VLT® FlexSafety™

option

• VLT® Decentral Servo Drive DSD 520 with VLT® FlexSafety™

option and Safe I/O option board

• VLT® Decentral Servo Drive DSD 520 with VLT® FlexSafety™

option and Standard I/O option board

• VLT® Decentral Servo Drive DSD 520 with Standard I/O option
board

• VLT® Integrated Servo Drive ISD 520

• VLT® Integrated Servo Drive ISD 520 with VLT® FlexSafety™

option

• VLT® Integrated Servo Drive ISD 520 with VLT® FlexSafety™

option and Safe I/O option board

• VLT® Integrated Servo Drive ISD 520 with VLT® FlexSafety™

option and Standard I/O option board

• VLT® Integrated Servo Drive ISD 520 with Standard I/O option
board

Power Supply Module PSM 510 GSDML file (General station description):

• GSDML-V2.xx-Danfoss-PSM-yyyymmdd.xml

Decentral Access Module DAM 510 GSDML file (General station description):

• GSDML-V2.xx-Danfoss-DAM-2Port-IRT-yyyymmdd.xml

• GSDML-V2.xx-Danfoss-DAM-3Port-RT-yyyymmdd.xml

Auxiliary Capacitors Module ACM 510 GSDML file (General station description):

• GSDML-V2.xx-Danfoss-ACM-yyyymmdd.xml

6.13.2 Creating a TIA Project

  NOTICE

l TIA V17 or higher must be installed to create a project.

6.13.3 Including the Servo Motion Libraries into a TIA Project
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Figure 77: Including the Servo Motion Libraries

1. Expand the Librarieswindow [1], then select and expand the Global libraries section [2].

2. Right-click on the empty area [3] then select menu entry Retrieve library... [4].

3. Select the Danfoss_VLT_ServoMotion_V_x_y_z.zal1x file (according to the location on the hard drive).

 
Table 32: Servo Motion Libraries

Library Description

DDS_Drive • Contains program organization units (POUs) defined by PLCopen® (name starting
with MC_) and POUs defined by Danfoss (name starting with DD_). The Danfoss
POUs provide additional functionality for the axis.

• It is possible to combine POUs defined by PLCopen® with POUs defined by
Danfoss.

• The names of the POUs that target the servo drive all end with _DDS.

• When integrating the DDS_Drive package, some standard libraries are integrated
automatically, unless they are already part of the project.

DDS_PSM • Contains POUs defined by Danfoss (name starting with DD_) and provide the
functionality for the Power Supply Module (PSM 510).

• The names of the POUs that target the PSM 510 all end with _PSM.

DDS_DAM • Contains POUs defined by Danfoss (name starting with DD_) and provide the
functionality for the Decentral Access Module (DAM 510).

• The names of the POUs that target the DAM 510 all end with _DAM.

DDS_ACM • Contains POUs defined by Danfoss (name starting with DD_) and provide the
functionality for the Auxiliary Capacitors Module (ACM 510).

• The names of the POUs that target the ACM 510 all end with _ACM.

DDS_Intern • Contains POUs that are needed internally for the libraries.

• Do not use these POUs in an application.

  NOTICE

l Do not remove these libraries otherwise the Danfoss servo motion libraries will not work.
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6.13.4 Importing Devices into TIA

  NOTICE

l For each physical servo drive, PSM 510, DAM 510, or ACM 510, add 1 entry to the PROFINET® Ethernet network in the

Hardware Catalog.

Procedure:
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Figure 78: Importing Devices into TIA

1. Open the Hardware Catalog.

2. Select Options → Manage general station description files.

3. In tab Installed GSDs [1], select the Source path [2] where the files are located.

4. To add a servo drive, select 1 of the xml files [3] and click on Install. In the filename, 2.xx represents the version number and

yyyymmdd represents the date.

¢ GSDML-V2.xx-Danfoss-DDS-yyyymmdd.xml

5. Repeat steps 2 and 3 for:

¢ Power Supply Module (PSM 510):

n GSDML-V2.xx-Danfoss-PSM-yyyymmdd.xml

¢ Decentral Access Module (DAM 510);

n GSDML-V2.xx-Danfoss-DAM-2Port-IRT-yyyymmdd.xml

n GSDML-V2.xx-Danfoss-DAM-3Port-RT-yyyymmdd.xml

n GSDML-V2.xx-Danfoss-DAM-yyyymmdd.xml

¢ Auxiliary Capacitors Module (ACM 510):

n GSDML-V2.xx-Danfoss-ACM-yyyymmdd.xml

6.13.5 Creating a Network in TIA
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Figure 79: Creating a Network

Procedure:

1. In the Devices window, select Device configuration [1] and add a PSM 510.

2. Assign the PSM 510 to the PLC_1 by dragging the middle square under the PLC icon [2] onto the square at top left of the

PSM 510 icon [3]. The PN/IE_1 network is created automatically.

3. Assign the PROFINET device name, IP address, and subnet mask to the PSM 510:

a. Right-click on the PSM 510 icon.

b. Select the tab General.

c. Select PROFINET interface [X1] and then Ethernet addresses.

d. Enter the IP address 192.168.101.1 [4].

e. Enter the subnet mask 255.255.255.0 [5].

4. Repeat steps 1–3 to add a DAM 510, ACM 510, ISD 520, or DSD 520.
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5. In the Devices & networks window, select Topology view [1] and connect the devices by dragging and dropping the icons.
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Figure 80: Devices and Networks Window

6. Remove any existing MAIN [OB1] operation block:

a. In the Project Tree, expand the Program blocks entry.

b. Right-click on operation block Main [OB1] [2] then select Delete in the drop-down menu.

7. Add a new MAIN [OB1] operation block [2] and create operation blocks for Startup [OB100] [3], and Synchronous Cycle [OB61] [4]:

a. In the Project Tree, expand the Program blocks entry.

b. Double-click on Add new block.

c. In the Add new block window, select Organization block.

d. Select organization block MAIN [OB1] from the list.

e. Set the language to SCL and activate the radio button Automatic.

f. Click on OK.

g. Repeat for Startup [OB100] and Synchronous Cycle [OB61].

8. Verify SyncDomain:
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Figure 81: Verifying SyncDomain

a. Open Network view [1] and select the Ethernet subnet [2] in which the sync domain is set up.

b. Open the Ethernet subnet properties.

c. In the local navigation [4], select entry Domain management → Sync domains → Sync-Domain_1.

d. In the field Sync Domain [5], change the name as desired.

e. In the field Send clock [6], select the desired value from the drop-down menu.

f. Activate the Default domain checkbox [7] to make this sync domain the default domain.

9. Verify that all system components have the Sync slave role:
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Figure 82: Sync Slave

a. Open Network view [1] and select the Ethernet subnet in which the sync domain is set up.
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b. Open the Ethernet subnet [2] properties.

c. In the local navigation [3], select entry Domain management → Sync domains → Sync-Domain_1 → Device.

d. Select the I/O devices.

e. Verify that all system components are present and set to Sync slave.

10. Select the telegram properties of each system component:
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Figure 83: Telegram Properties

a. Open Device view [1].

b. Select Danfoss Telegram [2].

c. In the Properties window [3], select the General tab [4] and then entry I/O addresses [5].

d. In the Input addresses section, activate the checkbox for Isochronous mode [6] then set field Organization block [7] to

Synchronous Cycle and field Process image [8] to PIP 1.

e. Repeat these settings in the Output addresses section [9].

f. Repeat this procedure for each system component.
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11. Activate the isochronous mode for each system component:
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Figure 84: Isochronous Mode

a. Open Device view [1].

b. In section Device overview [2], click on danfoss-psm-01 [3].

c. In the Properties window [4], select the General tab [5] and then menu entries PROFINET interface [X1] → Advanced options

→ Isochronous mode.

d. Activate the checkbox for Isochronous mode [6].

e. Repeat these settings for each system component.

6.14 Programming Guidelines for TIA

Recommendations for implementation:

l Danfoss system modules do not need a structure declared in global data block FlexMotion_Data. Instead, they can be directly

addressed in each function block via their hardware identifier:
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Figure 85: Parameter_DDS_Program

l Each Danfoss device in the project has a hardware identifier that is assigned automatically by TIA Portal during configuration and

is shown in menu [PLC tags → Show all tags → System Constants]. This hardware identifier can be used to address and identify the

module and must be assigned to the HardwareId input parameter of the appropriate function block for proper communication with

the device:
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Figure 86: HardwareId

¢ Power modules (PSM 510, DAM 510, ACM 510) use the hardware id (numerical value or name) of the Danfoss

Telegramsubmodule, for example danfoss-psm~PSM_object_1~Danfoss_Telegram.

¢ Drive devices (ISD 520, DSD 520) use the hardware id (numerical value or name) of the Module Access Point submodule, for

example danfoss-isd~Device_object_1.

Only assign this variable in the 1st PLC cycle for initialization. The structures to be used for each type of device are:

¢ ISD 520 and DSD 520: AXIS_REF_DDS

¢ PSM 510: PSM_REF

¢ DAM 510: DAM_REF

¢ ACM 510: ACM_REF

l Initialize parameters that usually do not change only once at the beginning of the program.

l Call up function blocks that reference the drive devices (AXIS_REF_DDS) in a cyclic task (for example, OB 1) to ensure that data

transfer can take place without delays or conflicts.

l Function blocks that reference the power modules (PSM_REF, DAM_REF, ACM_REF) can be called in a cyclic task (for example, OB 1),

but this is not required.

l Processing of incoming and outgoing telegrams is integrated into function blocks operating on power modules, meaning that

explicit update of process inputs/outputs is not required.

l Call up function blocks that provide status or error information with Enable input at the beginning of the program.

l Use 1 instance of function block MC_Power_DDS for every axis to control its power stage. Call up this function block in every PLC

cycle.

l Use 1 instance of function block DD_Power_PSM for every PSM 510 to control the DC-link voltage on the output lines. Call up this

function block in every PLC cycle.

l Use 1 instance of function block DD_Power_DAM for every DAM 510 to control the DC-link voltage on the output lines. Call up this

function block in every PLC cycle.
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l Use 1 instance of function block DD_Power_ACM for every ACM 510 to control the DC-link voltage on the output lines. Call up this

function block in every PLC cycle.

l Call up function blocks that execute (motion) commands at the end of the program.

l Do not use any UDTs, POUs, enumerations, or constants starting with the prefix iDD_.

l Do not change the reference to the axis on a function block while it is busy.

6.15 VLT® Servo Toolbox Software

6.15.1 Overview

The VLT® Servo Toolbox is a standalone PC software designed by Danfoss. It is used for parameterization and diagnostics of the system

modules. It is also possible to operate the devices in a non-productive environment.

  NOTICE

l The VLT® Servo Toolbox software must be allowed for every firewall profile (private/public/domain).

The VLT® Servo Toolbox contains several subtools that provide various functionalities.

Table 33: Important Subtools

Subtool Description

Scope For visualization of the tracing functionality of the servo drives, the Power Supply Module (PSM 510),
the Decentral Access Module (DAM 510), and the Auxiliary Capacitors Module (ACM 510).

Parameter list For reading/writing parameters.

Firmware update For updating the firmware on the devices.

Drive control For operating the servo drives for testing purposes.

PSM control For operating the Power Supply Module (PSM 510) for testing purposes.

DAM control For operating the Decentral Access Module (DAM 510) for testing purposes.

ACM control For operating the Auxiliary Capacitors Module (ACM 510) for testing purposes.

CAM editor For designing CAM profiles for the servo drives.

Configuration parameter For setting up the motor and feedback parameters, and PID settings.

Drive commissioning For motor feedback adjustment and inertia measurement.

Safety subtool For setting up safety parameters for the servo drives with VLT®FlexSafety™ option.

The detailed description of the VLT® Servo Toolbox functionality and the full parameter lists can be found in the VLT® Servo Drive System

ISD 520, DSD 520, MSD 520 (VLT® FlexMotion™) Programming Guide.

6.15.2 System Requirements

To install the VLT® Servo Toolbox software, the PC must meet the following requirements:

l Supported hardware platforms: 32 bit, 64 bit

l Supported operating systems: Windows 10, Windows 11

l .NET framework version: 4.7

l Minimum hardware requirements: 512 MB RAM, Intel Pentium 4 with 2.6 GHz or equivalent, 20 MB hard disk space

l Recommended hardware requirements: Minimum 1 GB RAM, Intel Core i5/i7 or compatible
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6.15.3 Installing the VLT® Servo Toolbox Software

Administrator rights are required to install the software with the Windows operating system. If necessary, contact a system administrator.

Procedure

1. Check that the system meets the system requirements specified in 6.15.2 System Requirements.

2. Download the VLT® Servo Toolbox installation file from the Danfoss website (http://drives.danfoss.com).

3. Right-click on the .exe file and select Run as administrator.

4. Follow the on-screen instructions to complete the installation process.

6.15.4 VLT® Servo Toolbox Communication

6.15.4.1 Overview

This section describes the Ethernet-specific network interface settings needed by the VLT® Servo Toolbox. There are 2 basic

communication methods: direct communication and indirect communication. Their particular network settings are described in the

respective subchapters.

Read and perform the steps with care. Incorrect network configurations can lead to loss of connectivity of a network interface.

6.15.4.2 Firewall

Depending on the firewall settings and the fieldbus used, the messages sent and received by the VLT® Servo Toolbox may be blocked by

the firewall on the VLT®Servo Toolbox host system. This may lead to a loss of communication and the inability to communicate with the

devices on the fieldbus. Therefore, ensure that the VLT® Servo Toolbox is allowed to communicate through the firewall on the VLT® Servo

Toolbox host system. Inappropriate changes to firewall settings may lead to security issues.

  NOTICE

l When using a dedicated network interface, the VLT® Servo Toolbox must be allowed to communicate specifically through this

network interface.

6.15.4.3 Indirect Communication

6.15.4.3.1 Overview

Communication between ISD 520/DSD 520 devices and the VLT® Servo Toolbox through a PLC is called indirect communication.

Ethernet-based fieldbus communication (marked A in the graphic) takes place between the PLC and the ISD 520/DSD 520 devices.

However, there is non-fieldbus communication between the PLC and the VLT® Servo Toolbox host system.

In the scenario shown, the PLC has the master function and uses cyclic communication with the devices. Therefore, not all functionalities

of the VLT® Servo Toolbox, for example, the drive control, can be used.

The restrictions when using indirect communication are detailed in the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT®

FlexMotion™) Programming Guide.
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Figure 87: Logical View of Indirect Ethernet-based Fieldbus Communication (Communication via PLC)

A Fieldbus B VLT® Servo Toolbox host system

  NOTICE

l The logical view only shows the connectivity from a high-level software perspective and does not reflect the actual physical

topology of the network.

6.15.4.3.2 Network Settings for Indirect Communication

Any network interface can be used to communicate through a PLC. A dedicated network interface is not required.

When establishing the communication through a PLC, the VLT® Servo Toolbox configures a routing table using the selected Network

Address Translation (NAT). Adding a route to the Windows routing table requires administrator privileges. Therefore, administrator

credentials may be requested when initializing the connection.

6.15.4.3.3 Enabling Indirect Communication

Carry out the following steps to enable indirect communication.

  NOTICE

When observing the network packets via Wireshark®, checksum offloading often causes confusion as the network packets to

be transmitted are handed over to Wireshark® before the checksums have been calculated. Wireshark® shows these empty

checksums as invalid, even though the packets contain valid checksums when they leave the network hardware later. Use 1 of

these 2 methods to avoid this checksum offloading problem:

l Turn off the checksum offloading in the network driver if possible.

l Turn off the checksum validation of the specific protocol in the Wireshark®preferences.

Disable IPv6 on the network interfaces used for communication on the PC:

1. Open the Network and Sharing Center.

2. Select Change adapter settings.

3. Right-click on the network interface used for fieldbus communication and select Properties.

4. If the TCP/IPv6 is available for the network interface, disable it.
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6.15.4.3.4 Additional Settings for Indirect Communication with EtherCAT®

Set the IP address of the EtherCAT® Master:

Procedure

1. Open the TwinCAT® System Manager.

2. Select I/O-Configuration → I/O Devices → Device1 (EtherCAT®) and check the IP-address in the Adapter tab. The IP-address of the

PLC's network adapter may not be a link-local address (so not in the range of 169.254.0.1 to 169.254.255.254).

3. If necessary, change the IP-address inside the IPv4 Protocol properties according to the given operating system. This can be

done on the controller locally or via Remote Desktop.

6.15.4.3.5 Activating the IP Routing in the EtherCAT® Master

The procedure described here may vary depending on the type of PLC and operating system installed.

Procedure

1. Open the TwinCAT® System Manager.

2. Click on Advanced Settings... via menu I/O-Configuration → I/O Devices → Device1 (EtherCAT) in the EtherCAT tab.

3. Select EoE Support in the Advanced Settings window.

4. Enable Connect to TCP/IP Stack in the Windows Network section.

5. Enable IP Enable Routerin the Windows IP Routing section.

6. Reboot the PLC for the changes to take effect.

6.15.4.3.6 Setting the IP Address of the EtherCAT®Slave

The procedure for setting the IP Address of the EtherCAT® slave is valid for:

l ISD 520/DSD 520 servo drives

l Power Supply Module (PSM 510)

l Decentral Access Module (DAM 510)

l Auxiliary Capacitors Module (ACM 510)

  NOTICE

l The last number of the IP address is the ID that is used in the VLT® Servo Toolbox to identify the device.

Procedure

1. Open the TwinCAT® System Manager.

2. Click on Advanced Settings... under I/O-Configuration → I/O Devices → Device1 (EtherCAT) → Box 1 (VLT® Decentral Access Module →
Drive 2 (VLT® Integrated Servo Drive ISD 520) in the EtherCAT® tab.

3. Select Mailbox → EoE in the Advanced Settings window.

4. Enable Virtual Ethernet Port and enter a valid IP-address.

5. Each slave in the configuration requires an IP-address. This address is reassigned with every transition from INIT to Pre-

Operational state of the slave state machine. The IP communication of the slaves is deactivated per default.

6.15.4.3.7 Additional Settings for Indirect Communication with PROFINET®

Overview

Each PROFINET® device needs a device name and an IP address. The IP address and the device name are assigned by the I/O controller,

when the connection to the I/O device is established.
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For the automatic detection of accessible nodes via a PG/PC interface with TCP/IP, connect the nodes to the same physical Ethernet

subnet as the PG/PC. If a node is located in a different physical Ethernet subnet, the IP address of the sought node can be specified.

To reach further nodes, accessible nodes provide the capability of adding IP addresses and subnets to the PG/PC interface. The new IP

addresses and subnets are then added to the Ethernet interface of the PG/PC.

  NOTICE

l If >1 Danfoss servo drive is used in the same PROFINET® network, each servo drive must have a different name and IP address.

l The last number of the IP address is the ID that is used in the VLT® Servo Toolbox software to identify the device.

  NOTICE

l IP addresses and subnets can also be added using PRONETA.

6.15.4.4 Direct Communication

6.15.4.4.1 Overview

For Ethernet-based fieldbus communication (direct communication), the VLT® Servo Toolbox must use a dedicated network interface on

the VLT® Servo Toolbox host system. Do not use this network interface simultaneously for any other communication.
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Figure 88: Logical View of Direct Ethernet-based Fieldbus Communication

A Ethernet-based fieldbus communication B VLT® Servo Toolbox host system

  NOTICE

l The logical view only shows the connectivity from a high-level software perspective and does not reflect the actual physical

topology of the network.

6.15.4.4.2 Network Settings for Direct Communication with Ethernet POWERLINK®

Disable all network protocols except TCP/IPv4 on the network interface used for direct Ethernet POWERLINK® communication. This

prevents other PC software or the operating system using this network interface for other tasks, such as file and printer sharing and

network discovery. Disabling these protocols reduces the number of non-relevant packets sent over the network interface and thus

reduces the overall network load.

6.15.4.4.3 Disabling Unused Protocols on the Network Interface on the PC

Procedure

1. Open the Network and Sharing Center.

126 | Danfoss A/S © 2024.11                                                                                                                                                                     AQ441543733781en-000101 / 130R1298

Operating Guide | VLT Servo Drive System ISD 520/DSD 520                                                                                                                     Commissioning



Operating Guide | VLT Servo Drive System ISD 520/DSD 520                                                                                                                     Commissioning

2. On the left, click on Change adapter settings.

3. Right-click on the network interface used for fieldbus communication and select Properties.

4. Uncheck all checkboxes except the one for Internet Protocol Version 4 (TCP/IPv4).

5. Disable the IPv4 Checksum offload on the network interfaces as described in 6.15.4.3.3 Enabling Indirect Communication.
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Figure 89: Disabling Unused Protocols on the Network Interface

6.15.4.4.4 Setting the Correct Ethernet POWERLINK® Master IP Address

Procedure

1. Open the Network and Sharing Center.

2. On the left, click on Change adapter settings.

3. Right-click on the network interface used for fieldbus communication and select Properties.

4. Click on Internet Protocol Version 4 (TCP/IPv4) (the checkbox must be checked) and then click on Properties.

5. Select Use the following IP address and use 192.168.100.240 as the IP address and 255.255.255.0 as the subnet mask. Leave all

other fields empty.
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Figure 90: Internet Protocol Version 4 (TCP/IPv4) Properties

6.15.4.4.5 Network Settings for Direct Communication with EtherCAT®

Disable all network protocols except TCP/IPv4 on the network interface used for direct EtherCAT® communication. This prevents other

PC software or the operating system using this network interface for other tasks, such as file and printer sharing and network discovery.

Disabling these protocols reduces the number of non-relevant packets sent over the network interface and thus reduces the overall

network load.

6.15.5 VLT® Servo Toolbox Commissioning

6.15.5.1 Step 1: Opening the Main Window

The Main Window is the basis for all VLT® Servo Toolbox functionalities. It consists of the following components:
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Figure 91: Main Window
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Table 34: Main Window Description

Legend number Name Description

1 Menu bar Contains the general functionalities for saving and loading projects, managing connections,
showing and changing settings, managing open subtools, and showing help contents.

2 Tool bar Contains shortcuts for saving and loading projects, connecting to and disconnecting from net-
works, automatic searching for online devices, and manually adding devices.

Online status and
state information

Online devices are indicated by a glowing light bulb next to the device ID.

• An online device is a logical device for which a physical device exists that the VLT® Servo
Toolbox is connected to.

• The color indicates the state of the device and is device-specific.

3

Offline status and
state information

Offline devices are indicated by a gray light bulb next to the device ID.

• An offline device is a logical device without a corresponding physical device. An offline
device can represent a saved device configuration or state, for example for offline analysis or
troubleshooting. It also contains pre-configured parameter values to be written to a physical
device.

4 Subtools A subtool is opened by double-clicking its name in the Device Environment, or by selecting the
entry and pressing the Enter key on the keyboard.

5 Device environ-
ment

The Device Environment section of the Main Window lists all logical devices managed by the
VLT® Servo Toolbox, visualizes their states, and serves as the user interface for accessing the de-
vice functionalities.

The Device Environment window lists all available subtools for each added device.

See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT®FlexMotion™) Programming Guide
for further information on the subtools.

6 Workspace This is the space for hosting the subtools and its size depends on the Main Window size. The
subtools can be maximized, minimized, horizontally or vertically aligned, or cascaded.

7 Watchlist win-
dow

Evaluates the parameter values of 1 or more devices by cyclically reading them from the de-
vices. Allows parameter values to be logged and saved to a text file. It is also possible to modify/
write values in the watchlist.

8 Output window Shows operating information, warnings, and errors. Depending on the user settings, shows
messages of up to 3 different logging levels (high, medium, and low). Used for showing ad-
vanced error and warning information.

9 Status strip Shows the communication state of the VLT® Servo Toolbox. If connected to a network, it shows
the used hardware interface (for example, network adapter) and the network name.

6.15.5.2 Step 2: Connecting to Network

Pre-configure the appropriate communication settings to connect to a network (see 6.15.4.1 Overview).

Procedure

1. In the Main Window toolbar, click on the Connect to bus icon to open the Connect to Network window.

2. Select the fieldbus type and the network interface to connect to.

3. Click on OK to connect.

4. Verify that the connection is successful by checking the status strip at the bottom of the Main Window.
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Figure 92: Connect to Network Window (Ethernet POWERLINK®)

6.15.5.3 Step 3: Scanning for Devices

Procedure

1. After verifying that the VLT® Servo Toolbox is connected to the selected network, click on the Scan for Devices icon in the toolbar

to trigger the device scan procedure.

  NOTICE

l If connected to an Ethernet POWERLINK® network in cyclic mode, select the scan range (minimum and maximum IDs) in the

next window to reduce the time needed for scanning. In all other cases, the complete ID range is scanned.

2. When the scan is complete, a list of available devices is shown in the Select Devices window. Select the devices to be added to

the Device Environment and click on OK.

3. All selected devices appear in the Device Environment window and automatically go online (indicated by a glowing light bulb

next to each device name).

6.16 Simple Programming Template

TwinCAT®

A basic sample PLC application for starting up the servo system with 1 Power Supply Module (PSM 510), 1 Decentral Access Module

(DAM 510), and 2 axes is provided. The project DDS_ServoMotion_SampleProject can be downloaded from the Danfoss website (http://

drives.danfoss.com).

Automation Studio™:

Detailed information on how to open the sample project within the ISD package in Automation Studio™ can be found in the Automation

Studio™ Help. Open the B&R Help Explorer and go to Programming → Examples → Adding sample programs and follow the instructions for

library samples.

PROFINET®

The project DDS_ServoMotion_SampleProject is a basic sample PLC (C240PN) application for starting up the servo system with 1 Power

Supply Module (PSM 510), 1 Decentral Access Module (DAM 510), and 2 axes.

6.17 Function Blocks

The PLC library provides function blocks that support the functionality of the servo system and comply with this standard: PLCopen®

Technical Specification Function blocks for motion control (Formerly Part 1 and Part 2) Version 2.0 March 17, 2011.

In addition to the PLCopen® functionality, Danfoss offers further functions for the servo system.
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The following PLCopen® characteristics apply to all function blocks:

l Commanding (using the inputs)

l Signaling (behaviour of the outputs)

l General calling conventions

  NOTICE

l See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT®FlexMotion™) Programming Guide for further information on

the available function blocks and their behavior.
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7 Operation

7.1 DS402 Operating Modes

The ISD 520/DSD 520 servo drives implement several modes of operation. The behavior of the servo drive depends on the activated

mode of operation. It is possible to switch between the modes while the servo drive is enabled. The supported modes of operation are

according to CANopen® CiA DS 402 and there are also ISD-specific modes of operation. All supported modes of operation are available

for EtherCAT®, Ethernet POWERLINK®, and PROFINET®. The various modes of operation are described in detail in the VLT® Servo Drive

System ISD 520, DSD 520, MSD 520 (VLT®FlexMotion™) Programming Guide.

Table 35: Operating Modes

Mode Description

Inertia and friction measurement mode This mode measures the inertia of an axis. It is used to measure the inertia of
the servo drive and the external load, and to optimize the control loop set-
tings. The friction effects are identified automatically.

Profile velocity mode In Profile velocity mode, the servo drive is operated under velocity control
and executes a movement with constant speed. Additional parameters,
such as acceleration and deceleration, can be parameterized.

Profile position mode In Profile position mode, the servo drive is operated under position control
and executes absolute and relative movements. Additional parameters,
such as velocity, acceleration, and deceleration, can be parameterized.

Profile torque mode In Profile torque mode, the servo drive is operated under torque control and
executes a movement with constant torque. Linear ramps are used. Addi-
tional parameters, such as torque ramp and maximum velocity, can be para-
meterized.

Homing mode In Homing mode, the application reference position of the servo drive can be
set. Several homing methods, such as homing on actual position, homing
on block, limit switch, or home switch, are available.

CAM mode In CAM mode, the servo drive executes a synchronized movement based on
a master axis. The synchronization takes place with a CAM profile that con-
tains slave positions corresponding to master positions. CAMs can be de-
signed graphically with the DDS Toolbox software, or can be parameterized
via the PLC. The guide value can be provided by an external encoder, virtual
axis, or the position of another axis.

Gear mode In Gear mode, the servo drive executes a synchronized movement based on
a master axis by using a gear ratio between the master and the slave posi-
tion. The guide value can be provided by an external encoder, virtual axis, or
the position of another axis.

Cyclic synchronous position mode In Cyclic synchronous position mode, the trajectory generator of the position
is located in the control device, not in the servo drive.

Cyclic synchronous velocity mode In Cyclic synchronous velocity mode, the trajectory generator of the velocity is
located in the control device, not in the servo drive.

7.2 PROFIdrive Application Classes

For PROFINET® the only supported profile is PROFIdrive with its own specific application classes (for example, AC1, AC4, AC4-DSC)

determined by the Standard Telegram selected via the PLC.
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Table 36: PROFIdrive Application Classes

Class Description

AC 1 In application class 1 (AC1) mode a main setpoint (for example, speed setpoint) is used
to control the servo drive in PROFINET® I/O. Speed control is handled entirely within the
servo drive.

AC 4 Application class 4 (AC4) defines an interface between the speed setpoint interface and
the actual position value interface, where speed control is executed on the servo drive
and position control on the controller. The motion control for multiple axes is performed
centrally, for example, by numerical control (NC). The position control loop is closed by
the fieldbus. Clock synchronization is required to synchronize the clocks for the position
control in the controller and for the speed control in the drives (PROFINET® with IRT).

AC4-DSC Extension of AC4. Dynamic Servo Control functionality can be used to increase the rigid-
ity and dynamic response of the control loop. PROFINET® with IRT is required.

7.3 Motion Functions

Table 37: Motion Functions

Function Description

Digital CAM switch This functionality controls whether the digital output is enabled or disabled, depending
on the axis position. It performs a function comparable to switches on a motor shaft. For-
ward and backward movements of the axis position are allowed. On and off compensa-
tion and hysteresis can be parameterized.

Touch probe This functionality stores the position actual value at a rising or falling edge of the config-
ured digital input.

Guide value The guide value is used in all synchronous modes of operation (CAM mode and Gear
mode). It is used as the master position within the synchronous modes.

7.4 Operating Indicator Lights (LEDs)

The operating status of the servo drives, PSM 510, DAM 510, and ACM 510 is indicated via the indicator lights (LEDs) on each device.

7.4.1 Operating Indicator Lights (LEDs) on the ISD 520/DSD 520 Servo Drives
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Figure 93: Operating Indicator Lights (LEDs) on ISD 520/DSD 520
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Table 38: Operating Indicator Lights (LEDs) on ISD 520/DSD 520

LED Color Flash status Description

On Servo drive is in state Operation
enabled.

Green

Flashing Auxiliary voltage is applied.

On Servo drive is in Fault or Fault re-
action active state.

DEV ST

Red

Flashing DC-link voltage is not applied.

On 24 V safety supply is applied.SVS ST Green

Off 24 V safety supply is not ap-
plied.

NET ST Green/red Fieldbus dependent Network status of the device
(see the corresponding fieldbus
standard).

On Ethernet link established.

Flashing Ethernet link established and
active.

LINK/ACT X1

(Link/activity status of Hybrid In
(X1))

Green

Off No link.

On Ethernet link established.

Flashing Ethernet link established and
active.

LINK/ACT X2

(Link/activity status of Hybrid
Out (X2))

Green

Off No link.

On Ethernet link established.

Flashing Ethernet link established and
active.

LINK/ACT X3

(optional)

Green

Off No link.

7.4.2 Operating Indicator Lights (LEDs) on PSM 510
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Figure 94: Operating Indicator Lights (LEDs) on PSM 510
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Table 39: Operating Indicator Lights (LEDs) on PSM 510

LED Color Flash status Description

On Device is in state Operation en-
abled.

Green

Flashing Device is in state Standby or
Power-up.

On Device is in state Fault or Fault
reaction active.

DEV

Red

Flashing Input mains is not applied.

On 24 V safety supply is applied.SVS ST Green

Off 24 V safety supply is not ap-
plied.

NET ST Green/red Fieldbus dependent Network status of the device
(see the corresponding fieldbus
standard).(1)

On Ethernet link established.

Flashing Ethernet link established and
active.

LINK/ACT X1

(Link/activity status of In)

Green

Off No link.

On Ethernet link established.

Flashing Ethernet link established and
active.

LINK/ACT X2

(Link/activity status of Out)

Green

Off No link.

1) POWERLINK® and EtherCAT®: Refer to the corresponding fieldbus standard. For PROFINET®: Green = communication with master established; Orange = device is online and can be

reached via the network; Blinking red = communication initialization is completed; Solid red = communication error.

7.4.3 Operating Indicator Lights (LEDs) on DAM 510
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Figure 95: Operating Indicator Lights (LEDs) on DAM 510
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Table 40: Operating Indicator Lights (LEDs) on DAM 510

LED Color Flash status Description

On Device is in state Operation en-
abled.

Green

Flashing Device is in state Standby or
Power-up.

On Device is in state Fault or Fault
reaction active.

DEV

Red

Flashing DC link is not applied at the in-
put.

On 24 V safety supply is applied.SVS ST Green

Off 24 V safety supply is not ap-
plied.

NET ST Green/red Fieldbus dependent Network status of the device
(see the corresponding fieldbus
standard).(1)

On Auxiliary voltage is applied to
the output connector.

Green

Off Auxiliary voltage is not applied
to the output connector.

AUX

(State of the auxiliary voltage)

Red On Auxiliary voltage undervoltage
detected in the hardware.

On Ethernet link established.

Flashing Ethernet link established and
active.

LINK/ACT X1

(Link/activity of In)

Green

Off No link.

On Ethernet link established.

Flashing Ethernet link established and
active.

LINK/ACT X2

(Link/activity status of Hybrid
Out)

Green

Off No link.

On Ethernet link established.

Flashing Ethernet link established and
active.

LINK/ACT X3

(Link/activity status of Out)

Green

Off No link.

1) POWERLINK® and EtherCAT®: Refer to the corresponding fieldbus standard. For PROFINET®: Green = communication with master established; Orange = device is online and can be

reached via the network; Blinking red = communication initialization is completed; Solid red = communication error.
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7.4.4 Operating Indicator Lights (LEDs) on ACM 510

STATUS ACM

LINK/ACT

DEV

CAP ST

NET ST

X1

X2

e3
0b

g5
78

.1
0

Figure 96: Operating Indicator Lights (LEDs) on ACM 510

Table 41: Operating Indicator Lights (LEDs) on ACM 510

LED Color Flash status Description

On Device is in state Operation en-
abled.

Green

Flashing Device is in state Standby or
Power-up.

On Device is in state Fault or Fault
reaction active.

DEV

Red

Flashing DC link is not applied at the in-
put.

On Capacitors fully charged.

Flashing Capacitors charging/discharg-
ing.

CAP ST Green

Off Capacitors discharged.

NET ST Green/red Fieldbus dependent Network status of the device
(see the corresponding fieldbus
standard).(1)

On Ethernet link established.

Flashing Ethernet link established and
active.

LINK/ACT X1

(Link/activity of In)

Green

Off No link.
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Table 41: Operating Indicator Lights (LEDs) on ACM 510 (continued)

LED Color Flash status Description

On Ethernet link established.

Flashing Ethernet link established and
active.

LINK/ACT X2

(Link/activity status of Out)

Green

Off No link.

1) POWERLINK® and EtherCAT®: Refer to the corresponding fieldbus standard. For PROFINET®: Green = communication with master established; Orange = device is online and can be

reached via the network; Blinking red = communication initialization is completed; Solid red = communication error.
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8 Functional Safety Concept

8.1 Functional Description

The servo system integrates the safety function safe torque off (STO). The safety function is available in daisy-chain format, which

is possible between all system modules except ACM 510 (cables are not included). The hybrid cable passes the STO signal from the

Decentral Access Module (DAM 510) to all ISD 520/DSD 520 servo drives in the chain. Once STO is activated (safe state), no torque is

generated on the ISD 520 servo drives, or on any motors connected to DSD 520, SDM 511 or SDM 512. Reset of the safety function and

diagnostics can be carried out via the PLC.

  NOTICE

l Use STO shielded wiring.

l Use the STO function when performing mechanical work on the servo system or affected area of a machine to avoid a

mechanical hazard. However, the STO function does not provide electrical safety.

  NOTICE

l The ISD 520/DSD 520 servo drives can also be ordered with the VLT® FlexSafety™ option, implementing advanced functional

safety. See the Advanced Functional Safety for VLT® FlexMotion™ Operating Guide for the available safety functions and related

safety capability.

l For VLT® FlexSafety™, the HMI of the device requires a password to inhibit unauthorized access.

8.2 Safety Precautions

  WARNING

UNCONTROLLED MOVEMENT

External forces on the motor could cause an uncontrolled and hazardous movement that could result in death or serious injury.

l Equip the motor with additional measures for preventing uncontrolled and hazardous movement, for example, mechanical

brakes.

  WARNING

RISK OF ELECTRIC SHOCK

The STO function does not isolate mains voltage to the servo system or auxiliary circuits. Failure to isolate the mains voltage

supply and wait for the specified discharge time to elapse could result in death or serious injury.

l Only perform work on electrical parts of the servo system or the ISD 520/DSD 520 servo drives after isolating the mains

voltage supply and waiting for the discharge time to elapse.

  WARNING

RISK OF RESIDUAL ROTATION

Due to failures in the power semiconductor of the drive, a residual rotation can result from a fault that could result in death or

serious injury. The rotation can be calculated to angle = 360°/(number of poles).

l Take this residual rotation into consideration and ensure that it does not pose a safety risk.
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  WARNING

INDICATOR LIGHT (LED) STATUS RELIABILITY

Status indicator lights (LEDs) are not reliable for safety functions.

l Only use status indicator lights for general diagnostics during commissioning and troubleshooting.

  NOTICE

l After installing the STO function, perform a commissioning test. A passed commissioning test is mandatory after initial

installation and after each change to the safety installation (see 8.8 Commissioning Test).

l For advanced functional safety, perform a commissioning test to validate the safety functions and their safety properties for

the whole system. See the Advanced Functional Safety for VLT® FlexMotion™ Operating Guide.

  NOTICE

l If required, implement a manual reset function according to EN ISO 13849-1. For automatic restart without manual reset,

observe the requirements detailed in paragraph 6.3.3.2.5 of EN ISO 12100:2010 or equivalent standard.

  NOTICE

l Carry out a risk assessment to select the correct stop category for each stop function in accordance with EN 60204-1.

l When designing the machine application, consider the timing and distance for coast to stop (Stop Category 0 or STO). See

EN 60204-1 for further information.

l All signals connected to the STO must be supplied by a PELV supply.

8.3 Qualified Personnel for Working with Functional Safety

The STO function can only be installed, programmed, commissioned, maintained, and decommissioned by qualified personnel. Qualified

personnel for the functional safety concept are qualified electrical engineers, or persons who have received training from qualified

electrical engineers and are suitably experienced to operate devices, systems, plant, and machinery in accordance with the general

standards and guidelines for safety technology.

Furthermore, they must:

l Be familiar with the basic regulations concerning health and safety/accident prevention.

l Have read and understood the safety guidelines given in this guide.

l Have a good knowledge of the generic and specialist standards applicable to the specific application.

Users of power drive systems (safety-related) (PDS(SR)) are responsible for:

l Hazard and risk analysis of the application.

l The overall safety of the application.

l Identifying safety functions required and allocating SIL or PL to each of the functions, other subsystems, and the validity of signals

and commands from them.

l Designing appropriate safety-related control systems, such as hardware, software, and parameterization.

8.4 Applied Standards and Compliance

Use of the STO function requires that all provisions for safety, including relevant laws, regulations, and guidelines, are satisfied.
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The integrated STO function complies with the following standards:

l IEC 61508-1 to 2: 2010 SIL 2

l EN 61508-1 to 2: 2010 SIL 2

l IEC 61800-5-2: 2016 SIL 2

l EN 61800-5-2: 2017 SIL 2

l EN ISO 13849-1: 2015, PL d, Cat. 3

l EN ISO 13849-2: 2012, PL d, Cat. 3

The ISD 520/DSD 520 servo drives can be used in the application area of EN IEC 62061:2021 and where Stop Category 0 (uncontrolled

stop), according to IEC 60204-1:2016 or EN 60204-1:2018, is needed.

8.5 Abbreviations and Conventions

Table 42: Safety-related Abbreviations and Conventions

Abbreviation Reference Description

Cat. EN ISO 13849-1 Category B, 1–4

DC – Diagnostic coverage

FIT – Failure in time

Failure rate: 1E-9/hour

HFT EN IEC 61508 Hardware fault tolerance

HFT = n means that n + 1 faults may lead to
a loss of the safety function.

MTTFD EN ISO 13849-1 Mean time to failure – dangerous

Unit: years

PFH EN IEC 61508 Probability of dangerous failures per hour

Take this value into account if the safety de-
vice is operated in high demand mode or in
continuous operating mode, where the fre-
quency of demands for operation made on
a safety-related system occurs more than
once per year.

PL EN ISO 13849-1 Performance level

A discrete level used to specify the capa-
bility of safety-related parts of a system to
perform safety-oriented functions under
foreseeable conditions. Levels: a–e.

SFF EN IEC 61508 Safe failure fraction [%]

Proportion of safe failures and detected
dangerous failures of a safety function or a
subsystem as a percentage of all possible
failures.

SIL EN IEC 61508 Safety integrity level

STO EN IEC 61800-5-2 Safe torque off
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8.6 Installation

Only Danfoss cables can be used for the installation of the servo system, however, cables from other suppliers can be used for the user

connection to the STO terminal STO DAM (Pins 3 and 4) on the Decentral Access Module (DAM 510).

Safety relays that have a plus and minus switching output signal can be directly connected to the servo system to activate STO.

The example in Figure 97 shows the basic connection to be made for the STO function. A suitable safety device to switch it off is not

supplied by Danfoss. The STO is activated by opening STO+ and STO–.

Table 43: Activation of STO Function

STO+ STO– STO function

24 V GND STO deactivated

Open Open STO activated

  NOTICE

l Do not exceed 30 V at the STO inputs.

l STO is activated if the plus input is between –3 V and +3 V.

l STO is deactivated if the plus input is between +21.6 V and +26.4 V.

Figure 97: Safety Relay with Plus and Minus Switching Output

Signals with test pulses must not have test pulses of >1 ms. Longer pulses may lead to reduced availability of the servo system.

8.6.1 Protective Measures

l Install the system modules in an IP54 cabinet as per IEC 60529 or in an equivalent environment. A higher IP protection may be

necessary for certain applications.

If external influences can affect the motor axis, for example, suspended loads, use additional measures, such as a safety holding brake, to

eliminate hazards.

8.7 Application Example

An example of an application that can be put in safe torque off (STO) mode by a safety circuit is shown in Figure 98.

Select the safety switch devices in accordance with the requirements of the application.
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+24 V DC

GND
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0b

g2
73

.1
0

8a

8b

53

42

1

X1

X2

X1

X2

9

7
6

1 24 V DC supply 2 Safety device

3 Emergency stop button 4 Safety device contacts

5 Decentral Access Module (DAM 510) 6 Hybrid cable

7 Feed-in cable 8a Servo drive

8b Servo drive 9 Loop cable

Figure 98: Application Example: Safe Torque Off Function

8.8 Commissioning Test

  NOTICE

l Perform a commissioning test according to standard EN/ISO 13849-1 for the whole servo system after installation of the STO

function, after every change to the installed function, or after a safety fault.

There are 2 ways to implement the commissioning test depending on the method used to program the PLC, however, the steps of the

test are the same:

l Using the Danfoss Library or the TwinCAT® Library.

l Bit-wise readout of the status.

8.8.1 Commissioning Test using Libraries

Depending on the application, 1 or both of the following libraries are required to program the commissioning test:

l Danfoss Library

¢ MC_ReadAxisInfo_DDS

¢ MC_ReadStatus_DDS

¢ MC_ReadAxisError_DDS

¢ MC_Reset_DDS

l TwinCAT® Library

¢ MC_ReadStatus

¢ MC_ReadAxisError

¢ MC_Reset
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Table 44: Commissioning Test using Libraries

Test steps Reason for the test step Expected result for
Danfoss library

Expected result for
TwinCAT® library

1 Run the application (all
the servo drives are en-
abled).

Check that the applica-
tion can run.

Application runs as ex-
pected.

Application runs as ex-
pected.

2 Stop the application. – All servo drives are at
speed 0 RPM.

All servo drives are at
speed 0 RPM.

3 Disable all the servo dri-
ves.

– All servo drives are dis-
abled.

All servo drives are dis-
abled.

4 Enable STO. Check that STO can be
activated without error.

MC_ReadAxisInfo_DDS
output SafeTorqueOff =
True for all servo drives
on the corresponding
line.

–

5 Disable STO. Check that STO can be
deactivated without er-
ror. No reset is required.

MC_ReadAxisInfo_DDS
output SafeTorqueOff =
False for all servo drives
on the corresponding
line.

–

6 Run the application (all
the servo drives are en-
abled).

– Application runs as ex-
pected.

Application runs as ex-
pected.

7 Enable STO. Check that errors are
generated correctly
when STO is activated
while the servo drives are
running.

Motors are torque free.
Motors coast and stop af-
ter some time.

MC_ReadAxisInfo_DDS
output SafeTorqueOff =
True

and

MC_ReadStatus_DDS
output ErrorStop = True

and

MC_ReadAxisError_DDS
output AxisErrorID =
0xFF80 on all enabled
servo drives.

Motors are torque free.
Motors coast and stop af-
ter some time.

For enabled motors:

MC_ReadAxisInfo_DDS
output SafeTorqueOff =
True

and

MC_ReadStatus output
ErrorStop = True

and

MC_ReadAxisError output
AxisErrorID = 0xFF80 on
all enabled servo drives.

8 Try to run the application
(enable 1 or more servo
drives).

Checks that the STO
function is working cor-
rectly.

Application does not run. Application does not run.

9 Disable STO. Check that the STO start
is still inhibited by the er-
ror signal.

MC_ReadAxisInfo_DDS
output SafeTorqueOff =
False

and

MC_ReadStatus_DDS
output ErrorStop = True

MC_ReadStatus output Er-
rorStop = True
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Table 44: Commissioning Test using Libraries (continued)

Test steps Reason for the test step Expected result for
Danfoss library

Expected result for
TwinCAT® library

10 Try to run the application
(enable 1 or more servo
drives).

Check whether reset is
required.

Application does not run. Application does not run.

11 Send a reset signal via
MC_Reset(_DDS).

– MC_ReadAxisInfo_DDS
output SafeTorqueOff =
False

and

MC_ReadStatus_DDS
output ErrorStop = False

MC_ReadStatus output Er-
rorStop = False

12 Try to run the application
(all servo drives are en-
abled).

– Application runs as ex-
pected.

Application runs as ex-
pected.

8.8.2 Commissioning Test using PROFINET® Devices

Table 45: Commissioning Test using PROFINET® Devices

Test steps Reason for the test step Expected result

1 Run the application (all the
servo drives are enabled).

Check that the application can
run.

Application runs as expected.

2 Stop the application. – All servo drives are at speed 0
RPM.

3 Disable all the servo drives. – All servo drives are disabled.

4 Enable STO. Check that STO can be activated
without error.

No errors are present. The suc-
cessful STO activation can be
checked on the indicator lights
(LEDs) on the devices.

5 Disable STO. Check that STO can be deacti-
vated without error. No reset is
required.

No errors are present. The STO
status can be checked on the in-
dicator lights (LEDs) on the de-
vices.

6 Run the application (all the
servo drives are enabled).

– Application runs as expected.

7 Enable STO. Check that errors are generated
correctly when STO is activated
while the servo drives are run-
ning.

Motors are torque free. Motors
coast and stop after some time.

Error 0x11E is shown in object
0x603F on all servo drives.

8 Try to run the application (en-
able 1 or more servo drives).

Checks that the STO function is
working correctly.

Application does not run.

9 Disable STO. Check that the STO start is still
inhibited by the error signal.

Error 0x11E is shown in object
0x603F on all servo drives.

10 Try to run the application (en-
able 1 or more servo drives).

Check whether a reset is re-
quired.

Application does not run.
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Table 45: Commissioning Test using PROFINET® Devices (continued)

Test steps Reason for the test step Expected result

11 Send a reset signal via the PLC. – STO error 0x11E is cleared in all
servo drives.

12 Try to run the application (all
servo drives are enabled).

– Application runs as expected.

8.9 Operation of the STO Function

The STO function does not require any parameterization and is always enabled.

The ISD 520/DSD 520 servo drive provides STO status signals via the fieldbus.

All signals transmitted via the fieldbus are not part of the safety function and can only be used for operational purposes.

See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT® FlexMotion™) Programming Guide for:

l General information on how to access and map data objects.

l Information on a library provided to simplify the use of the fieldbus functions.

If the servo drive is enabled and STO is activated, an error code is issued.

If the drive is not enabled and STO is activated, it is not necessary to reset any STO error. It is sufficient to reapply the supply voltage to

the STO terminals, before enabling the drive.

8.9.1 Error Codes

If bit 3 of the statusword is set, this indicates any faults that occur on the servo drive. If the fault occurred because of the STO circuit, the

cause of the fault can be found in object 0x603F.

Table 46: Error Codes

Error code PROFINET® error code Classification Description Reset

0xFF80 0x11E Fault STO activated while the
servo drive was enabled,
or an attempt to en-
able the servo drive was
made while STO was acti-
vated.

Reset via the PLC.

0xFF81 0x11F Safety fault Servo drive internal diag-
nostic fault.

Carry out a power cycle.

0xFF85 0x120 Safety fault Internal STO supply on
the power card is not
within limits.

Carry out a power cycle.

Error code 0xFF80/0x11E can be a normal status of the application. In this case, the servo drive requires a reset signal from the PLC.

To use the STO function in an application that requires a control guard (see ISO 12100 for details), this reset information can be given

automatically by the PLC. All servo drives on the same line will show this fault at the same time. Carry out a check on the PLC to compare

the fault of all servo drives on 1 line.
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Error code 0xFF81/0x11F means that there is a fault on the servo drive that can only be reset by carrying out a power cycle. Complete

the commissioning test after the power cycle. Operation of the servo system can only be resumed if the test is completed successfully. If

error code 0xFF81/0x11F or 0xFF85/0x120 is issued again, contact Danfoss Service.

8.9.2 Fault Reset

To reset faults, change bit 7 of the controlword from 0 to 1. See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT® FlexMotion™)

Programming Guide for further information.

8.10 Functional Safety Characteristic Data

Table 47: Functional Safety Characteristic Data

Data ISD 520/DSD 520 PSM 510 DAM 510

General information

Response time (from switching
on the input until torque gener-
ation is disabled)

<100 ms

Lifetime 20 years

Data for EN/ISO 13849-1

Performance level (PL) d – –

Category 3 – –

Mean time to dangerous failure
(MTTFD)

>100 years – –

Diagnostic coverage (DC) Low – –

Data for IEC 61508

Safety integrity level (SIL) 2 – –

Probability of failure per hour
(PFH)

<4 x 10-9/h 0 /h 0 /h

Subsystem classification Type A

Diagnostic test interval 1 year

  NOTICE

l The PSM 510, DAM 510, and ACM 510 do not contribute to the dangerous failure rate of the servo system and can therefore

be excluded from safety-related calculations.

l Compliance to the claimed SIL and PL is only possible if the diagnostic test is executed once per year.

8.11 Maintenance, Security, and User Accessibility

Maintenance: Test the STO safety function at least once per year as follows:

1. Start the motor.

2. Remove the STO input voltage.

3. Verify that the motors stop running.

4. Verify that no unexpected error codes appear.

Danfoss A/S © 2024.11                                                                                                                                                                     AQ441543733781en-000101 / 130R1298 | 147



Security: If security risks exist, take suitable measures to prevent them.

User accessibility: Restrict access to the ISD 520/DSD 520 servo drives and other system components if access to them could result in

safety risks.
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9 Diagnostics

9.1 Faults

If faults occur during operation, check:

l The indicator lights (LEDs) on the servo drives for general problems relating to communication or device status.

l The indicator lights (LEDs) on the PSM 510 and DAM 510 for general problems with communication, auxiliary supply, or STO voltage.

l The error codes.

The error codes can be read using the VLT® Servo Toolbox software, the LCP, or the PLC. The LCP only shows faults relating to the device it

is connected to.

  NOTICE

l If the fault cannot be eliminated by 1 of the measures listed in the troubleshooting tables, notify Danfoss Service.

Have the following information available to enable Danfoss to provide help quickly and effectively:

l Type number

l Error code

l Firmware version

l System setup (for example, number of servo drives, system modules, and lines).

l System status when the fault occurred.

l Ambient conditions.

9.2 Troubleshooting

9.2.1 Troubleshooting for the Servo Drives (ISD 520/DSD 520)

9.2.1.1 Drive not Running/Starting Slowly

Possible cause

l Bearing wear.

l Incorrect parameter settings.

l Incorrect control loop parameters.

l Incorrect torque settings.

l Mechanical brake still engaged.

Troubleshooting

l Check the bearings and the shaft.

l Check the parameter settings.

l For ISD 520 check the mechanical brake, for DSD 520 check the mechanical brake parameters.

9.2.1.2 Drive Hums and Draws High Current

Possible cause

l ISD 520: Drive defective.

l DSD 520:

¢ Incorrect motor parameter settings.

¢ Feedback offset adjustment procedure not executed.
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¢ Incorrect wiring of motor phases (U, V, W are swapped or not connected).

Troubleshooting

l ISD 520: Contact Danfoss.

l DSD 520:

¢ Check the motor parameters settings.

¢ Perform the commissioning procedure Feedback offset adjustment.

9.2.1.3 Drive Stops Suddenly and Restart is not Possible

Possible cause

l No drive communication.

l Servo drive in error mode.

Troubleshooting

l Check the fieldbus connection and the indicator lights (LEDs) on the servo drive.

9.2.1.4 Motor Rotating in Wrong Direction

Possible cause

l Mirror mode activated.

Troubleshooting

l Check the parameter settings.

9.2.1.5 Motor not Generating Expected Torque

Possible cause

l ISD 520:

¢ Drive defective.

l DSD 520:

¢ Incorrect motor parameter settings.

¢ Feedback offset adjustment procedure not executed.

¢ Partial (incorrect) opening of mechanical brake.

Troubleshooting

l ISD 520: Contact Danfoss.

l DSD 520:

¢ Check the motor parameter settings.

¢ Perform the commissioning procedure Feedback offset adjustment.

9.2.1.6 Drive Screaming

Possible cause

l Incorrect calibration.

l Faulty current measurement.

l Incorrect control loop parameters.

Troubleshooting

l Check the parameter settings.

l Contact Danfoss.
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9.2.1.7 Uneven Running

Possible cause

l Defective bearing.

Troubleshooting

l Check the shaft.

9.2.1.8 Vibration

Possible cause

l Defective bearing.

l Incorrect control loop parameters.

Troubleshooting

l Check the shaft.

l Check the parameter settings.

9.2.1.9 Unusual Running Noises

Possible cause

l Defective bearing.

l Defects on connected mechanics.

l Incorrect control loop parameters.

Troubleshooting

l Check the shaft.

l Check for loose mechanical components on the connected mechanics.

l Check the parameter settings.

9.2.1.10 Drive Speed Drops Sharply under Load

Possible cause

l Drive is running at current limit.

l Drive is running with incorrect parameters.

l Speed control loop bandwidth is too low.

Troubleshooting

l Check the application.

l Check the parameter settings.

l Modify the speed control loop parameters.

9.2.1.11 Brake not Releasing

Possible cause

l Defective brake control.

l Incorrect mechanical brake parameters.

Troubleshooting

l Check the parameter settings.

l Contact Danfoss.
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9.2.1.12 Holding Brake not Holding the Servo Drive

Possible cause

l Mechanical brake defective.

l Shaft load exceeds the holding torque of the brake.

Troubleshooting

l Contact Danfoss.

9.2.1.13 Delayed Brake Engagement

Possible cause

l Software error.

l Issues with auxiliary voltage.

Troubleshooting

l Contact Danfoss.

l Ensure the UAUX is 48 V if the ISD 520 has the optional mechanical brake.

9.2.1.14 Noises when Power-Off Brake is Engaged

Possible cause

l Mechanical brake damaged.

Troubleshooting

l Contact Danfoss.

9.2.1.15 Indicator Lights (LEDs) not Lighting Up

Possible cause

l No power supply.

Troubleshooting

l Check the power supply.

9.2.1.16 Drive Protection Trips Immediately

Possible cause

l Short circuit.

l Incorrect control loop parameters.

Troubleshooting

l Check the parameter settings.

l Check the wiring.

l Contact Danfoss.

9.2.2 Troubleshooting for the Servo System

9.2.2.1 LCP Display is Dark/Not Functioning

This fault applies to the ISD 520/DSD 520 servo drives, PSM 510, DAM 510, and ACM 510.

Possible causes and troubleshooting
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Table 48: Possible Causes and Troubleshooting

Possible cause Possible solution

Missing input power. Check the input power source.

Missing or open fuses, or circuit breaker tripped. Check the fuses and circuit breaker.

No power to the LCP. • Check the LCP cable for proper connection or damage.

• Replace any faulty LCP or connection cables.

Incorrect contrast setting. Press [Status] + [▲]/[▼] to adjust the contrast.

Display is defective. Replace the faulty LCP or connection cable.

9.2.2.2 Open Power Fuses or Circuit Breaker Trip

This fault applies to the PSM 510 and DAM 510.

Possible causes

l Phase-to-phase short.

l Short on backlink.

l Short on hybrid cable.

l Short on EXM 510 connector or cable.

l Short on ISD 520/DSD 520 connector.

Troubleshooting

l Check the cabling.

l Check for loose connections.

9.2.2.3 DC-link Voltage Too Low (Error 0x3220/0x104)

This fault applies to all system modules.

Possible cause

l Incorrect mains input supply.

Troubleshooting

l Check that the supply voltage matches the allowed specification.

9.2.2.4 Current Overload Trip (Error 0x2396/0x15C)

This fault applies to the PSM 510 and the DAM 510.

Possible causes

l The sum of the servo drive current exceeds the maximum rating of the DAM 510.

l The sum of the system modules' current exceeds the maximum rating of the PSM 510.

l Short on backlink.

Troubleshooting

l Check the servo drive current consumption.

l Avoid simultaneous acceleration of all servo drives.

l Decrease the acceleration value.

9.2.2.5 High Cont. Power Overload (Error 0x2313/0x161)

This fault applies to the PSM 510.
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Possible causes

l The PSM 510 was operating at over 140% of the nominal power rating for too long.

Troubleshooting

l Check the current consumption.

9.2.2.6 Continuous Power Overload (Error 0x2314/0x162)

This fault applies to the PSM 510.

Possible causes

l The PSM 510 was operating at 100–140% of the nominal power rating for too long.

Troubleshooting

l Check the current consumption.

9.2.2.7 AUX Overcurrent (Error 0x2391/0x125)

This fault applies to the DAM 510.

Possible causes

l The servo drives are consuming more power on the UAUX line than allowed.

Troubleshooting

l Check the number of attached servo drives with the shell diagrams in the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT®

FlexMotion™) Design Guide.

l Avoid simultaneous lifting of the servo drive brakes.

9.2.2.8 AUX Overvoltage (Error 0x3292/0x133)

This fault applies to the DAM 510.

Possible causes

l Incorrect UAUX supply.

Troubleshooting

l Check that the supply matches the auxiliary supply requirements.

9.2.2.9 AUX Undervoltage (Error 0x3294/0x135)

This fault applies to the PSM 510, DAM 510, and ACM 510.

Possible causes

l Incorrect UAUX supply.

l Incorrect current dimensioning of the supply equipment.

Troubleshooting

l Check that the supply matches the auxiliary supply requirements.

l Check that the output power of the supply is sufficient.

9.2.2.10 Mains Phase Loss (Error 0x3130/0x12F)

This fault applies to the PSM 510.

Possible causes

l A phase is missing on the supply side.

l The voltage imbalance is too high.
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Troubleshooting

l Check the supply voltages and supply currents to the device.

9.2.2.11 Generic Application Error (Error 0x1000/0x100)

This error is valid for PSM 510, DAM 510, ACM 510, and ISD 520/DSD 520.

Possible causes

l A generic error has occurred in the application.

Troubleshooting

l Contact Danfoss.

9.2.2.12 Grounding Fault

This fault applies to the PSM 510, DAM 510, and ACM 510.

Possible causes

l Grounding fault.

l When 2 PSM 510 modules are mounted in parallel and the maximum delay time for power-up is exceeded.

Troubleshooting

l Check for proper grounding and loose connections.

l Check the hybrid cables for short circuits or leakage currents.

l Check the EXM 510 connection and cable.

9.2.2.13 Brake Resistor Error

This fault applies to the PSM 510.

Possible causes

l Faulty brake resistor.

l Internal/external brake resistor not connected.

Troubleshooting

l Remove the power to the device, wait for the discharge time to elapse, then replace the brake resistor.

9.2.2.14 Brake Chopper Error

This fault applies to the PSM 510.

Possible causes

l Faulty brake chopper.

l Brake chopper power exceeds the power cycle limit.

l Incorrect parameterization.

Troubleshooting

l Check the parameterization of the brake chopper.

l Check the brake chopper connection.

l Measure the resistance of the brake chopper and compare it with the parameter settings.

9.2.2.15 Internal Fan Error

This fault applies to PSM 510.
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Possible causes

l Fan is not mounted.

l Fan is blocked.

Troubleshooting

l Check if the fan is blocked.

l Check the fan cables for proper connection or damage.

9.3 Error Codes for ISD 520/DSD 520 Servo System

9.3.1 No error (0x0000 / 0x0)

This error code is valid for PSM 510, DAM 510, ACM 510, and ISD 520/DSD 520.

Table 49: No error (0x0000 / 0x0)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x0000 0x0 No error Error No error. –

9.3.2 Generic application error (0x1000 / 0x100)

This error is valid for PSM 510, DAM 510, ACM 510, and ISD 520/DSD 520.

Table 50: Generic err (0x1000 / 0x100)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x1000 0x100 Generic application
error

Error Generic application
error.

generic err

9.3.3 Overcurrent Trip (0x2310 / 0x101)

Table 51: Overcurr out (0x2310 / 0x101)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2310 0x101 Overcurrent trip Error Overcurrent trip on
output.

overcurr trip

9.3.4 High cont. current overload (0x2311 / 0x15F)

Table 52: High cont. current overload (0x2311 / 0x15F)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2311 0x15F High cont. current
overload

Error High continuous
current overload er-
ror.

high curr ovld
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9.3.5 Continuous current overload (0x2312 / 0x160)

This error is valid for DAM 510 and ISD 520/DSD 520.

Table 53: Continuous current overload (0x2312 / 0x160)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2312 0x160 Continuous current
overload

Error Continuous current
overload error.

cont curr ovld

9.3.6 High cont. power overload (0x2313 / 0x161)

This error is valid for PSM 510.

Table 54: High cont. power overload (0x2313 / 0x161)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2313 0x161 High cont. power
overload

Warning, error High continuous
power overload er-
ror.

high pwr ovld

9.3.7 Continuous power overload (0x2314 / 0x162)

This error is valid for PSM 510.

Table 55: Continuous power overload (0x2314 / 0x162)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2314 0x162 Continuous power
overload

Warning, error Continuous power
overload error.

cont pwr ovld

9.3.8 Overcurrent short circuit (0x2320 / 0x163)

This error is valid for PSM 510 and DAM 510.

Table 56: Overcurrent short circuit (0x2320 / 0x163)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2320 0x163 Overcurrent short
circuit

Trip lock Overcurrent short
circuit error.

over curr short

9.3.9 Ground fault (0x2330 / 0x151)

This error is valid for PSM 510, DAM 510, and ISD 520/DSD 520.
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Table 57: Ground fault (0x2330 / 0x151)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2330 0x151 Ground fault Warning, error Discharge from
output phases to
ground.

ground fault

9.3.10 AUX overcurrent (0x2391 / 0x125)

This error is valid for DAM 510.

Table 58: AUX overcurr (0x2391 / 0x125)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2391 0x125 AUX overcurrent Error Current on the AUX
line has reached the
overcurrent limit.

AUX overcurr

9.3.11 AUX user limit current (0x2393 / 0x127)

This error is valid for DAM 510.

Table 59: AUX user limit current (0x2393 / 0x127)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2393 0x127 AUX user limit cur-
rent

Error Current on the AUX
line has reached the
user-defined limit
for fault.

AUX curr limit

9.3.12 AUX user limit current warning (0x2394 / 0x128)

This error is valid for PSM 510 and DAM 510.

Table 60: AUX user limit current warning (0x2394 / 0x128)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2394 0x128 AUX user limit cur-
rent warning

Warning Current on the AUX
line has reached the
user-defined limit
for warning.

AUX curr warn

9.3.13 AUX supply failure (0x2395 / 0x129)

This error is valid for DAM 510.
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Table 61: AUX supply failure (0x2395 / 0x129)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2395 0x129 AUX supply failure Error AUX supply failure
indicated by hard-
ware circuit

AUX supply fail

9.3.14 Current overload trip (0x2396 / 0x15C)

This error is valid for DAM 510 and ISD 520/DSD 520.

Table 62: Current overload trip (0x2396 / 0x15C)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2396 0x15C Current overload
trip

Error Current overload
trip error.

curr ovld trip

9.3.15 Power overload trip (0x2397 / 0x12B)

This error is valid for PSM 510.

Table 63: Power overload trip (0x2397 / 0x12B)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x2397 0x12B Power overload trip Error Power overload trip
error.

pwr ovld trip

9.3.16 Thermal overload motor (0x239B / 0x102)

This error is valid for ISD 520/DSD 520.

Table 64: Thermal overload motor (0x239B / 0x102)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x239B 0x102 Thermal overload
motor

Warning, error Thermal overload
motor error.

therm ovld motor

9.3.17 DC Short Circuit (0x239C / 0x16F)

This error is valid for ISD 520/DSD 520.

Table 65: Thermal overload motor (0x239C / 0x16F)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x239C 0x16F DC short circuit Error Short circuit on DC
link.

DC short
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9.3.18 Overcurrent motor (0x239D / 0x170)

This error applies to ISD 520/DSD 520.

Table 66: Overcurrent motor (0x239D / 0x170)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x239D 0x170 Overcurrent motor Error Motor overcurrent
fault. The threshold
value defined by ob-
ject 0x2395 is ex-
ceeded.

overcurr motor

9.3.19 Mains phase loss (0x3130 / 0x12F)

This error is valid for PSM 510.

Table 67: Mains phase loss (0x3130 / 0x12F)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3130 0x12F Mains phase loss Error Mains phase loss de-
tected.

This occurs when a
phase on mains is
missing, or when the
mains is imbalanced.

phase loss

9.3.20 DC link overvoltage (0x3210 / 0x103)

This error is valid for PSM 510, DAM 510, ACM 510, and ISD 520/DSD 520.

Table 68: DC link overvoltage (0x3210 / 0x103)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3210 0x103 DC link overvoltage Error DC-link voltage ex-
ceeds limit.

UDC overvolt

9.3.21 DC link undervoltage (0x3220 / 0x104)

This error is valid for PSM 510, DAM 510, ACM 510, and ISD 520/DSD 520.

Table 69: DC link undervoltage (0x3220 / 0x104)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3220 0x104 DC link undervolt-
age

Error DC-link voltage be-
low limit in Opera-
tion enabled state

UDC undervolt
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9.3.22 DC link charging error (0x3230 / 0x152)

This error is valid for PSM 510, DAM 510, ACM 510, and ISD 520/DSD 520.

Table 70: DC link charging error (0x3230 / 0x152)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3230 0x152 DC link charging er-
ror

Error The maximum time
limit to charge the
DC link has been ex-
ceeded.

UDC charging

9.3.23 DC Link unbalanced (0x3280 / 0x153)

Table 71: DC Link unbalanced (0x3280 / 0x153)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3280 0x153 DC Link unbalanced Trip lock DC-link voltage is
unbalanced. This
fault indicates an in-
ternal malfunction
of the DC link.

UDC unbalance

9.3.24 UAUX high voltage (0x3291 / 0x132)

This error is valid for PSM 510, DAM 510, and ACM 510.

Table 72: UAUX high voltage (0x3291 / 0x132)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3291 0x132 UAUX high voltage Warning UAUX above warning
limit.

UAUX high volt

9.3.25 UAUX overvoltage (0x3292 / 0x133)

This error is valid for DAM 510.

Table 73: UAUX overvoltage (0x3292 / 0x133)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3292 0x133 UAUX overvoltage Error UAUX above overvolt-
age limit.

UAUX overvolt

9.3.26 UAUX low voltage (0x3293 / 0x134)

This error is valid for PSM 510, DAM 510, and ACM 510.
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Table 74: UAUX low voltage (0x3293 / 0x134)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3293 0x134 UAUX low voltage Warning UAUX below warning
limit.

UAUX low volt

9.3.27 UAUX undervoltage (0x3294 / 0x135)

This error is valid for PSM 510, DAM 510, and ACM 510.

Table 75: UAUX undervoltage (0x3294 / 0x135)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3294 0x135 UAUX undervoltage Error UAUX below under-
voltage limit.

UAUX undervolt

9.3.28 DC link high voltage (0x3295 / 0x136)

This error is valid for PSM 510, DAM 510, and ACM 510.

Table 76: DC link high voltage (0x3295 / 0x136)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3295 0x136 DC link high voltage Warning The DC-link voltage
is higher than the
high-voltage warn-
ing limit.

UDC high volt

9.3.29 DC link low voltage (0x3296 / 0x137)

This error is valid for PSM 510, DAM 510, and ACM 510.

Table 77: DC link low voltage (0x3296 / 0x137)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3296 0x137 DC link low voltage Warning The DC-link voltage
is lower than the
low voltage warning
limit.

UDC low volt

9.3.30 UAUX charging error (0x3297 / 0x154)

This error is valid for DAM 510.
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Table 78: UAUX charging error (0x3297 / 0x154)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3297 0x154 UAUX charging error Error Load error when
UAUX is charging. The
maximum time limit
to charge the AUX
line has been ex-
ceeded.

UAUX charg err

9.3.31 DC link shutdown error (0x3298 / 0x165)

This error is valid for DAM 510.

Table 79: DC link shutdown error (0x3298 / 0x165)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3298 0x165 DC link shutdown
error

Error Error when UDC is in
shutdown phase.

UDC shutdwn err

9.3.32 UAUX shutdown error (0x3299 / 0x155)

This error is valid for DAM 510.

Table 80: UAUX shutdown error (0x3299 / 0x155)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x3299 0x155 UAUX shutdown error Error Error when UAUX is in
shutdown phase.

UAUX shtdwn err

9.3.33 UAUX undervoltage hardware (0x329A / 0x156)

This error is valid for PSM 510, DAM 510, and ACM 510.

Table 81: UAUX undervoltage hardware (0x329A / 0x156)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x329A 0x156 UAUX undervoltage
hardware

Error UAUX undervoltage
detected by hard-
ware circuit.

AUX undervol HW

9.3.34 Automated fault reset failure (0x329B / 0x168)

This error is valid for PSM 510, DAM 510, and ACM 510.
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Table 82: Automated fault reset failure (0x329B / 0x168)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x329B 0x168 Automated fault re-
set failure

Trip lock Too many auto fault
resets have been
executed in the in-
tended time interval.

autoreset fail

9.3.35 Device overtemperature (0x4210 / 0x157)

This error is valid for PSM 510, DAM 510, and ACM 510.

Table 83: Device overtemperature (0x4210 / 0x157)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x4210 0x157 Device overtemper-
ature

Warning, error Triggered when the
maximum tempera-
ture of the main de-
vice component is
exceeded.

PSM 510: Thyristor
rectifier module.

DAM 510: Maximum
temperature of both
high side and low
side IGBTs.

overtemp device

9.3.36 Device under temperature (0x4220 / 0x138)

This error is valid for PSM 510, DAM 510, and ACM 510.

Table 84: Device under temperature (0x4220 / 0x138)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x4220 0x138 Device under tem-
perature

Error The device is too
cold to operate.

undertemp device

9.3.37 Overtemperature: Control card (0x4291 / 0x106)

This error is valid for PSM 510, DAM 510, ACM 510, and ISD 520/DSD 520.

Table 85: Overtemperature: Control card (0x4291 / 0x106)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x4291 0x106 Overtemperature:
Control card

Error Maximum temper-
ature of the control
card exceeded.

overtemp CC
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9.3.38 Overtemperature: Power card (0x4292 / 0x107)

This error is valid for PSM 510, DAM 510, and ACM 510.

Table 86: Overtemperature: Power card (0x4292 / 0x107)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x4292 0x107 Overtemperature:
Power card

Warning, error Maximum tempera-
ture of power card
exceeded.

overtemp PC

9.3.39 Inrush overtemperature DC link (0x4293 / 013C)

This error is valid for PSM 510, DAM 510, and ACM 510.

Table 87: Inrush overtemperature DC link (0x4293 / 0x13C)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x4293 0x13C Inrush overtempera-
ture: DC link

Error Inrush fault.

Too many transitions
into state Operation
enabled in a short
time period.

UDC inrush

9.3.40 Inrush overtemperature AUX line (0x4294 / 0x13D)

This error is valid for DAM 510.

Table 88: Inrush overtemperature AUX line (0x4294 / 0x13D)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x4294 0x13D Inrush overtempera-
ture AUX line

Error Inrush fault.

Too many power-
ups of the AUX volt-
age have occurred
within a short time
period.

UAUX inrush

9.3.41 Overtemperature: Motor (0x4310 / 0x108)

This error is valid for ISD 520/DSD 520.

Table 89: Overtemperature: Motor (0x4310 / 0x108)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x4310 0x108 Overtemperature:
Motor

Error Overtemperature on
motor.

overtemp motor
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9.3.42 AUX undervoltage (0x5112 / 0x135)

This error is valid for ISD 520/DSD 520.

Table 90: AUX undervoltage (0x5112 / 0x135)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x5112 0x135 AUX undervoltage Error UAUX below under-
voltage limit.

UAUX undervolt

9.3.43 Charge switch failure voltage (0x5121 /0x158)

This error is valid for PSM 510.

Table 91: Charge switch failure voltage (0x5121 / 0x158)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x5121 0x158 Charge switch fail-
ure voltage

Trip lock Indicates a malfunc-
tion of the internal
charge circuit.

Chg switch fail

9.3.44 Failure on output phase U (0x5411 / 0x123)

This error is valid for ISD 520/DSD 520

Table 92: Failure on output phase U (0x5411 / 0x123)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x5411 0x123 Failure on output
phase U

Trip lock Failure on output
phase U.

output phase U

9.3.45 Failure on output phase V (0x5412 / 0x124)

This error is valid for ISD 520/DSD 520

Table 93: Failure on output phase V (0x5412 / 0x124)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x5412 0x124 Failure on output
phase V

Trip lock Current offset on
output phase V out-
side limit.

output phase V

9.3.46 Failure on output phase W (0x5413 / 0x125)

This error is valid for ISD 520/DSD 520
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Table 94: Failure on output phase W (0x5413 / 0x125)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x5413 0x125 Failure on output
phase W

Trip lock Current offset on
output phase W out-
side limit.

output phase W

9.3.47 EE Checksum Error (parameter missing) (0x5530 / 0x10A)

This error is valid for ISD 520/DSD 520.

Table 95: EE Checksum Error (parameter missing) (0x5530 / 0x10A)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x5530 0x10A EE Checksum Error
(parameter missing)

Trip lock EEPROM checksum
error or missing de-
vice parameter. Con-
tact Danfoss.

eeprom err

9.3.48 Parameter error (0x6320 / 0x10B)

This error is valid for PSM 510, DAM 510, ACM 510, and ISD 520/DSD 520.

Table 96: Param err (0x6320 / 0x10B)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x6320 0x10B Parameter error Trip lock A parameter has an
invalid value.

param err

9.3.49 Parameter Configuration: Previous configuration restored (0x6321 / 0x171)

This error is valid for ISD 520/DSD 520.

Table 97: Parameter Configuration: Previous configuration restored (0x6321 / 0x171)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x6321 0x171 Parameter Configu-
ration: Previous con-
figuration restored

Error The previous stored
configuration has
been reloaded be-
cause something
went wrong with
the latest configura-
tion.

prev config restored

9.3.50 Parameter Configuration: Power cycle needed (0x6322 / 0x172)

This error is valid for ISD 520/DSD 520.
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Table 98: Parameter Configuration: Power cycle needed (0x6322 / 0x172)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x6322 0x172 Parameter Configu-
ration: Power cycle
needed

Warning, error Power cycle or reset
is needed to apply
the new configura-
tion.

power cycle

9.3.51 Parameter Configuration: Wrong thermal sensor configuration (0x6323 / 0x0173)

This error is valid for ISD 520/DSD 520.

Table 99: Parameter Configuration: Wrong thermal sensor configuration (0x6323 / 0x173)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x6323 0x173 Parameter Configu-
ration: Wrong ther-
mal sensor configu-
ration

Error Wrong configura-
tion of parameters
0x2350 and 0x2361.
At least one of them
must be set to no
sensor.

wrong thermal sens

9.3.52 Conf par ver (0x6382 / 0x15D)

This error is valid for PSM 510, DAM 510, ACM 510, and ISD 520/DSD 520.

Table 100: Configuration parameters version error (0x6382 / 0x15D)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x6382 0x15D Configuration para-
meters version error

Trip lock Configuration pa-
rameter set version
mismatch: parame-
ter set is not valid for
this device.

Check the configura-
tion file sent to the
device and replace
it. If the error per-
sists, contact Dan-
foss.

conf par ver

9.3.53 Configuration parameters limits error (0x6383 / 0x164)

This error is valid for PSM 510, DAM 510, and ACM 510.
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Table 101: Configuration parameters limits error (0x6383 / 0x164)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x6383 0x164 Configuration para-
meters limits error

Trip lock ≥1 parameter in the
configuration para-
meter set is out of
limits.

conf par lim

9.3.54 Power EEprom configuration error (0x6384 / 0x166)

This error is valid for PSM 510, DAM 510, ACM 510, and ISD 520/DSD 520.

Table 102: Power EEprom configuration error (0x6384 / 0x166)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x6384 0x166 Power EEprom con-
figuration error

Trip lock The power device
EEprom is corrupt or
incompatible with
this control board.
Contact Danfoss.

conf par EEPROM

9.3.55 Brake chopper failure (0x7111 / 0x141)

This error is valid for PSM 510.

Table 103: Brake chopper failure (0x7111 / 0x141)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x7111 0x141 Brake chopper fail-
ure

Warning, error The brake chopper
is monitored during
operation.

A brake failure has
been detected by
the brake check
function.

brake ch fail

9.3.56 Brake chopper overcurrent (0x7112 / 0x167)

This error is valid for PSM 510.

Table 104: Brake chopper overcurrent (0x7112 / 0x167)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x7112 0x167 Brake chopper over-
current

Trip lock The brake chopper
current exceeds the
limit.

brake ch overcurr
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9.3.57 Brake chopper module overload (0x7181 / 0x142)

This error is valid for PSM 510.

Table 105: Brake resistor maximum power limit (0x7181 / 0x142)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x7181 0x142 Brake chopper mod-
ule overload

Warning, error The power load of
the brake chopper
is monitored during
operation. This error
appears when the
maximum power
limit of the brake
chopper module is
reached.

mod ovl

9.3.58 External brake chopper overload (0x7182 / 0x143)

This error is valid for PSM 510.

Table 106: External brake chopper overload (0x7182 / 0x143)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x7182 0x143 External brake chop-
per overload

Warning, error The power load of
the brake chopper
is monitored during
operation.

Depending on the
configuration of ex-
ternal brake chop-
per power monitor-
ing this warning or
fault appears when
the configured nom-
inal external brake
chopper power is
reached.

ext brake ch ovl

9.3.59 Brake mains voltage too high (0x7183 / 0x159)

This error is valid for PSM 510.
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Table 107: Brake mains voltage too high (0x7183 / 0x159)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x7183 0x159 Brake mains voltage
too high

Warning The mains voltage
is too high. Due to
this, the brake chop-
per could be acti-
vated continuously
depending on the
value entered in pa-
rameter brake chop-
per start level.

brake ch high volt

9.3.60 Internal position sensor error (0x7320 / 0x10C)

This error is valid for ISD 520/DSD 520.

Table 108: Internal position sensor error (0x7320 / 0x10C)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x7320 0x10C Internal position
sensor error

Trip lock Absolute position
sensor error.

If the error persists,
contact Danfoss.

int sensor err

9.3.61 External position sensor error (0x7380 / 0x10D)

This error is valid for DAM 510 and ISD 520/DSD 520.

Table 109: External position sensor error (0x7380 / 0x10D)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x7380 0x10D External position
sensor error

Error External encoder
data could not be
read.

ext sensor err

9.3.62 Communication error (0x7500 / 0x169)

This error is valid for ISD 520/DSD 520.

Table 110: Communication error (0x7500 / 0x169)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x7500 0x169 Communication er-
ror

Error Communication er-
ror, connection lost.

comm err
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9.3.63 Following error (0x8611 / 0x10E)

This error is valid for ISD 520/DSD 520.

Table 111: Following error (0x8611 / 0x10E)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x8611 0x10E Following error Warning, error A following error has
occurred.

The error notifica-
tion feature can be
disabled via object
0x2055.

following err

9.3.64 Homing error on entering homing mode (0x8693 / 0x10F)

This error is valid for ISD 520/DSD 520.

Table 112: Homing error on entering homing mode (0x8693 / 0x10F)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x8693 0x10F Homing error on en-
tering homing mode

Warning Could not enter
homing mode (for
example velocity
not 0).

Homing mode fail

9.3.65 Homing error on start homing method (0x8694 / 0x110)

This error is valid for ISD 520/DSD 520.

Table 113: Homing error on start homing method (0x8694 / 0x110)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x8694 0x110 Homing error
on start homing
method

Warning Could not start hom-
ing method (for ex-
ample drive not in
standstill).

Homing method fail

9.3.66 Homing error distance (0x8695 / 0x111)

This error is valid for ISD 520/DSD 520.

Table 114: Homing error distance (0x8695 / 0x111)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0x8695 0x111 Homing error dis-
tance

Warning Homing distance
reached.

Homing distance
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9.3.67 Mechanical brake failure (0xFF01 / 0x112)

This error is valid for ISD 520/DSD 520.

Table 115: Mechanical brake failure (0xFF01 / 0x112)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF01 0x112 Mechanical brake
failure

Trip lock No brake or wire fail-
ure.

brake mech fail

9.3.68 Short circuit in mechanical brake control (0xFF02 / 0x113)

This error is valid for ISD 520/DSD 520.

Table 116: Short circuit in mechanical brake control (0xFF02 / 0x113)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF02 0x113 Short circuit in me-
chanical brake con-
trol

Trip lock Short circuit in brake
control.

brake mech short

9.3.69 External interface power failure (0xFF0A / 0x114)

This error is valid for ISD 520/DSD 520.

Table 117: External interface power failure (0xFF0A / 0x114)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF0A 0x114 External interface
power failure

Error External interface
power supply fail-
ure.

ext IF pwr fail

9.3.70 Fan feedback inconsistent (0xFF21 / 0x145)

This error is valid for PSM 510.

Table 118: Fan feedback inconsistent (0xFF21 / 0x145)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF21 0x145 Fan feedback incon-
sistent

Warning Internal fan fault.

Internal fan not
running/mounted.

fan feedback

9.3.71 Fan lifetime critical (0xFF22 / 0x15A)

This error is valid for PSM 510.
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Table 119: Fan lifetime critical (0xFF22 / 0x15A)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF22 0x15A Fan lifetime critical Warning The theoretical life-
time of the fan has
been exceeded.

fan lifetime

9.3.72 Timing violation 1 (0xFF60 / 0x115)

This error is valid for ISD 520/DSD 520.

Table 120: Timing violation 1 (0xFF60 / 0x115)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF60 0x115 Timing violation 1 Trip lock Contact Danfoss. timing err 1

9.3.73 Timing violation 2 (0xFF61 / 0x116)

This error is valid for ISD 520/DSD 520.

Table 121: Timing violation 2 (0xFF61 / 0x116)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF61 0x116 Timing violation 2 Trip lock Contact Danfoss. timing err 2

9.3.74 Timing violation 3 (0xFF62 / 0x117)

This error is valid for ISD 520/DSD 520.

Table 122: Timing violation 3 (0xFF62 / 0x117)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF62 0x117 Timing violation 3 Trip lock Contact Danfoss. timing err 3

9.3.75 Timing violation 4 (0xFF63 / 0x118)

This error is valid for ISD 520/DSD 520.

Table 123: Timing violation 4 (0xFF63 / 0x118)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF63 0x118 Timing violation 4 Trip lock Contact Danfoss. timing err 4

9.3.76 Timing violation 5 (0xFF64 / 0x119)

This error is valid for ISD 520/DSD 520.
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Table 124: Timing violation 5 (0xFF64 / 0x119)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF64 0x119 Timing violation 5 Trip lock Contact Danfoss. timing err 5

9.3.77 Timing violation 6 (0xFF65 / 0x11A)

This error is valid for ISD 520/DSD 520.

Table 125: Timing violation 6 (0xFF65 / 0x11A)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF65 0x11A Timing violation 6 Trip lock Contact Danfoss. timing err 6

9.3.78 Timing violation 7 (0xFF66 / 0x168)

This error is valid for ISD 520/DSD 520.

Table 126: Timing violation 7 (0xFF66 / 0x168)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF66 0x168 Timing violation 7 Trip lock Contact Danfoss. timing err 7

9.3.79 Timing violation 8 (0xFF67 / 0x16B)

This error is valid for ISD 520/DSD 520.

Table 127: Timing violation 8 (0xFF67 / 0x16B)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF67 0x16B Timing violation 8 Trip lock Contact Danfoss. timing err 8

9.3.80 Timing violation 9 (0xFF68 / 0x16C)

This error is valid for ISD 520/DSD 520.

Table 128: Timing violation 9 (0xFF68 / 0x16C)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF68 0x16C Timing violation 9 Trip lock Contact Danfoss. timing err 9

9.3.81 Firmware: Package description mismatch (0xFF70 / 0x11B)

This error is valid for PSM 510, DAM 510, ACM 510, and ISD 520/DSD 520.
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Table 129: Firmware: Package description mismatch (0xFF70 / 0x11B)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF70 0x11B Firmware: Package
description mis-
match

Trip lock The firmware found
does not match the
package description.

FW pack err

9.3.82 Firmware: Power cycle needed (0xFF71 / 0x11C)

This error is valid for PSM 510, DAM 510, ACM 510, and ISD 520/DSD 520.

Table 130: Firmware: Power cycle needed (0xFF71 / 0x11C)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF71 0x11C Firmware: Power cy-
cle needed

Warning, error The firmware up-
date transfer is com-
pleted but a power
cycle is required
before the new
firmware is active.

need powercycle

9.3.83 Firmware: Update started (0xFF72 / 0x11D)

This error is valid for PSM 510, DAM 510, ACM 510, and ISD 520/DSD 520.

Table 131: Firmware: Update started (0xFF72 / 0x11D)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF72 0x11D Firmware: Update
started

Warning, error Firmware update is
in progress.

Warning changes
to error when an at-
tempt is made to en-
able the device in
this state.

FW update

9.3.84 Firmware: Update invalid (0xFF73 / 0x15B)

This error is valid for PSM 510 and DAM 510.
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Table 132: Firmware: Update invalid (0xFF73 / 0x15B)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF73 0x15B Firmware: Update
invalid

Error Invalid or corrupted
firmware package
update.

Last valid firmware
package has been
loaded.

FW upd invalid

9.3.85 STO active while drive enabled (0xFF80 / 0x11E)

This error is valid for ISD 520/DSD 520.

Table 133: STO active while drive enabled (0xFF80 / 0x11E)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF80 0x11E STO active while
drive enabled

Error STO activated while
drive was enabled or
tried to enable the
drive while STO ac-
tive.

STO active

9.3.86 STO mismatch (0xFF81 / 0x11F)

This error is valid for ISD 520/DSD 520.

Table 134: STO mismatch (0xFF81 / 0x11F)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF81 0x11F STO mismatch Trip lock Dual diagnosis of
STO voltage not
plausible.

STO mismatch

9.3.87 Guide value reversed (0xFF90 / 0x121)

This error is valid for ISD 520/DSD 520.

Table 135: Guide value reversed (0xFF90 / 0x121)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF90 0x121 Guide value re-
versed

Error Position guide value
went backwards
while the servo drive
was in CAM mode.

guide val rev
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9.3.88 Guide value implausible (0xFF91 / 0x122)

This error is valid for ISD 520/DSD 520.

Table 136: Guide value implausible (0xFF91 / 0x122)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF91 0x122 Guide value implau-
sible

Error Increments between
succeeding values
too large.

guide val impl

9.3.89 UDU Guide Value out of range (0xFF92 / 0x126)

This error is valid for ISD 520/DSD 520.

Table 137: UDU Guide Value out of range (0xFF92 / 0x126)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF92 0x126 UDU Guide Value
out of range

Error UDU Position Guide
Value is outside the
allowable range
[Gmin, Gmax].

UDU GV out of
range

9.3.90 UDU Guide Value Offset out of range (0xFF93 / 0x12A)

This error is valid for ISD 520/DSD 520.

Table 138: UDU Guide Value Offset out of range (0xFF93 / 0x12A)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF93 0x12A UDU Guide Value
Offset out of range

Error UDU Position Guide
Value offset is out-
side the allowable
range [Gmin, Gmax].

UDU GV offset out of
range

9.3.91 UDU Min Blending distance out of range (0xFF94 / 0x12C)

This error is valid for ISD 520/DSD 520.

Table 139: UDU Min Blending distance out of range (0xFF94 / 0x12C)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF94 0x12C UDU Min Blend-
ing distance out of
range

Error UDU Min Blending
distance is outside
the allowable range
[Gmin, Gmax].

UDU Min Blend-
ing distance out of
range
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9.3.92 Sign of life error (0xFF95 / 0x14E)

This error is valid for ISD 520/DSD 520.

Table 140: Sign of life error (0xFF95 / 0x14E)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

PROFINET® sign of
life error.

PNIO SOL error0xFF95 0x14E Sign of life error Error

Sign of life error. SOL error

9.3.93 Safe Drive Internal Failure (0xFF96 / 0x150)

This error is valid for ISD 520/DSD 520.

Table 141: Safe Drive Internal Failure (0xFF96 / 0x150)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF96 0x150 Safe Drive Internal
Failure

Trip lock Safe drive internal
failure

Safe drv fail

9.3.94 SIM Internal Failure (0xFF97 / 0x16E)

This error is valid for ISD 520/DSD 520.

Table 142: Safe Drive Internal Failure (0xFF97 / 0x16E)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF97 0x16E SIM Internal Failure Trip lock SIM internal failure SIM fail

9.3.95 SIM Internal Failure Resettable (0xFF98 / 0x174)

This error is valid for ISD 520/DSD 520.

Table 143: Safe Internal Failure Resettable (0xFF98 / 0x174)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF98 0x174 SIM Internal Failure
Resettable

Error SIM internal failure
resettable.

SIM fail res

9.3.96 Safe Position Procedure Failed (0xFF99 / 0x175)

This error is valid for ISD 520/DSD 520.
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Table 144: Safe Position Procedure Failed (0xFF99 / 0x175)

Code PROFINET® code Name Severity (warning/
error/trip lock)

Description LCP name

0xFF99 0x175 Safe Position Proce-
dure Failed

Warning, error Procedure for the
safe position refer-
encing failed.

Safe Proc Fail
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10 Maintenance, Decommissioning, and Disposal

10.1 Warnings

  WARNING

HIGH VOLTAGE

Potentially lethal voltage is present on the connectors that may lead to death or serious injury.

l Before working on the power or signal connectors (disconnecting or connecting the cable), or performing any maintenance

work, disconnect the Power Supply Module (PSM 510) from the mains and wait for the discharge time to elapse.

  WARNING

DISCHARGE TIME

The servo system contains DC-link capacitors that remain charged for some time after the mains supply is switched off at the

Power Supply Module (PSM 510). Failure to wait the specified time after power has been removed before performing service or

repair work could result in death or serious injury.

l To avoid electric shock, fully disconnect the Power Supply Module (PSM 510) from the mains and wait for the capacitors to

fully discharge before carrying out any maintenance work on the servo system or replacing components.

Minimum waiting time (minutes)

15

10.2 Inspection During Operation

10.2.1 ISD 520/DSD 520 Servo Drives

Carry out regular inspections during operation. Check the ISD 520/DSD 520 servo drives at regular intervals for anything unusual.

Pay particular attention to:

l Unusual noises

l Overheated surfaces (temperatures up to 100 °C can occur in normal operation)

l Uneven running

l Strong vibrations

l Loose fastenings

l Condition of electrical wiring and cables

l Poor heat dispersion

10.2.2 System Modules

Carry out regular inspections during operation.

Check:

l The cooling vents are not blocked.

l The fan is not making any unusual noises.

l The condition of electrical wiring and cables.
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10.3 Maintenance Tasks

The maintenance tasks for the ISD 520/DSD 520 servo drives are detailed in Table 145. Only the shaft seal on the ISD 520 (if used) is

subject to wear. The maintenance tasks must be performed by qualified personnel. No other tasks are required.

Table 145: Overview of Maintenance Tasks

Component Maintenance task Maintenance interval Instruction

All Carry out a visual inspection. Every 6 months Check for any abnormalities on
the surface.

Shaft seal on the ISD520 Check the condition and check
for leakage.

Every 6 months(1) If damaged or worn: Replace
the shaft seal.

Mechanical holding brake (op-
tional)

Check the brake. Every 6 months Ensure that the brake can
achieve the holding torque.

Flange connection on the
ISD 520 servo drive

Measure the resistance. Every 12 months. Measure the resistance of
the flange connection on the
ISD 520.

System modules Check the fan. Every 12 months Check that the fan can turn and
remove any dust or dirt.

Hybrid cable Check for damage and wear. Every 6 months If damaged or worn: Replace
the hybrid cable.

Functional safety Perform a system power cycle
and check the STO function.

Every 12 months Activate STO and check the sta-
tus with the PLC.

1) A shorter interval may be necessary depending on the application. Contact Danfoss for more information.

10.4 Repair

Do not attempt to repair the products. Defective products must be returned to Danfoss. Contact the local Danfoss sales company for

information about returns.

10.5 ISD 520/DSD 520 Servo Drive Replacement

10.5.1 Dismounting the ISD 520/DSD 520 Servo Drive

Procedure:

1. Disconnect the supply and wait for the discharge time to elapse.

2. Disconnect the electrical cables.

3. Dismount the servo drive.

4. Replace the servo drive with a servo drive of the same type. See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT®

FlexMotion™) Design Guide for code numbers.

10.5.2 Fitting and Commissioning the ISD 520/DSD 520 Servo Drive

Procedure:

1. Check if preparation is required (see 4.6.1 Preparation for Installation of ISD 520/DSD 520 Servo Drive).

2. Fit the servo drive (see 4.7.5.2 Clamping the ISD 520 Servo Drive and 4.7.6.2 Clamping the DSD 520 Servo Drive).

3. Connect the hybrid cables (see 5.10.3 Connecting Hybrid Cables).

4. Connect the I/O and/or encoder cables (see 5.10.5.2 Connecting I/O Cables to Ports X3 and X4).
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5. Configure the servo drive parameters according to the fieldbus used (see 6.3 EtherCAT® ID Assignment, and POWERLINK® ID

Assignment (6.4.2 Single Device ID Assignment and 6.4.3 Multiple Device ID Assignment).

6. Conduct a test run.

10.6 System Module Replacement

10.6.1 Dismounting the System Modules

1. Disconnect the mains and all auxiliary supplies from the PSM 510 and wait for the discharge time to elapse.

2. Disconnect the EMC plate on the bottom of the system modules. Do not dismount the connectors from the EMC plate.

1
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Figure 99: Disconnecting the EMC Plate

– Unplug the RJ45 connector [2] (only on DAM 510).

– Unscrew the screw [4] on the EMC plate.

– Press the clip [3] to release the EMC plate.

– Unscrew the PE screw [1].

3. Disconnect the I/O shielding plate on the top of the system modules:
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Figure 100: Disconnecting the I/O Shielding Plate

– Unplug the top connectors [1].

– Unscrew the screw [2] on the I/O shielding plate [3].

– Pull the I/O shielding plate upwards to remove it.

4. Release the securing clamp [1] at the top of the module.
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Figure 101: Releasing the Securing Clamp

5. Tilt the module forward and remove it from the backplate.
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Figure 102: Removing the Module

10.6.2 Fitting and Commissioning the System Modules

1. Check if preparation is required (see 4.6.2 Preparation for Installation of System Modules).

2. Fit the system modules (see 4.7.7 Fitting Instructions for System Modules).

3. Connect the electrical cables (see chapter Electrical Installation).

4. Switch the system on (see 6.8 Switching on the ISD 520/DSD 520 System).

5. Configure the parameters of the system module according to the fieldbus used (see 6.3 EtherCAT® ID Assignment, 6.5

PROFINET® ID Assignment ) and for Ethernet POWERLINK: 6.4.2 Single Device ID Assignment and 6.4.3 Multiple Device ID

Assignment.

6. Conduct a test run.

10.7 Cable Replacement

10.7.1 Overview

Replace the cables when the rated number of bending cycles has been reached or the cable is damaged.

  NOTICE

l Do not forcefully connect or fit the connectors. Incorrect connection causes permanent damage to the connectors.

10.7.2 Feed-in Cable Replacement

10.7.2.1 Disconnecting the Feed-in Cable

1. Disconnect the Power Supply Module (PSM 510) from its power source (mains network and all auxiliary supplies).

2. Wait for the necessary discharge time to elapse.
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3. Disconnect any cables connected to the X3, X4, or X5 ports on the ISD 520/DSD 520 servo drive for easier access to the feed-in

cable.

4. Disconnect the PE wire from the PE screw on the Decentral Access Module (DAM 510).

5. Disconnect the Ethernet connector.

6. Remove the EMC plate from the DAM 510.

7. Open the cable binder holding the STO cable.

8. Open the cable binder holding the feed-in cable on the DAM 510.

9. Loosen the feed-in cable connectors on the DAM 510.

10. Disconnect the feed-in cable from the DAM 510.

11. Loosen the threaded ring of the connector on the servo drive.

12. Disconnect the feed-in cable from the servo drive.

10.7.2.2 Replacing the Feed-in Cable

Replace the feed-in cable with a cable of identical type and length. See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT®

FlexMotion™) Design Guide for code numbers.

10.7.2.3 Connecting the Feed-in Cable

Procedure:

1. Connect the female connector of the feed-in cable to the male connector of the 1st servo drive.

2. Turn the threaded rings of the connectors hand tight.

3. Ensure that there is no mechanical tension on the cables.

4. Insert the feed-in cable wires into the correct connector on the EMC plate at the bottom of the Decentral Access Module

(DAM 510).

5. Secure the feed-in cable with a cable binder.

6. Secure the STO cable with a cable binder.

7. Mount the EMC plate on the DAM 510.

8. Connect the Ethernet connector to the DAM 510.

9. Connect the PE wire to the PE screw on the DAM 510.

10. Reconnect any cables that were connected to the X3, X4, or X5 ports.

10.7.3 Loop Cable Replacement

10.7.3.1 Connecting the Loop Cable

Procedure:

1. Connect the male connector of the loop cable to the female connector on the servo drive.

2. Connect the female connector of the loop cable to the male connector on the adjacent servo drive.

3. Turn the threaded rings hand tight on both servo drives.

4. Ensure that there is no mechanical tension on the cables.

5. Tighten the threaded rings of the connectors on both servo drives.

6. Reconnect any cables that were connected to the X3, X4, or X5 ports on both servo drives.
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10.7.3.2 Replacing the Loop Cable

Replace the loop cable with a cable of identical type and length. See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT®

FlexMotion™) Design Guide for code numbers.

10.7.3.3 Disconnecting the Loop Cable

1. Disconnect the Power Supply Module (PSM 510) from its power source (mains network) and all auxiliary supplies.

2. Wait for the necessary discharge time to elapse.

3. Disconnect any cables connected to the X3, X4, or X5 ports on both ISD 520/DSD 520 servo drives for easier access to the loop

cable.

4. Loosen the threaded rings of the loop cable connectors on both servo drives.

5. Disconnect the loop cable from the servo drives.

10.8 Fuse Replacement in Decentral Access Module (DAM 510)
If a single fuse blows, replace all the fuses with fuses from the same batch (fuse CAT number 5012006.25, SIBA).

Procedure

1. Remove the screws [1] and remove the cover.
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Figure 103: Opening the Cover on DAM 510

2. Use a screwdriver to remove the fuses and replace them with the same number of identical type fuses.
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Figure 104: Removing the Fuse

3. Replace the cover and tighten the screws. The tightening torque is 2 Nm.

10.9 Fan Replacement
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0

Figure 105: Fan Replacement on 50 mm Modules
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Figure 106: Fan Replacement on 100 mm Modules

  NOTICE

l See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT® FlexMotion™) Design Guide for further information on fan

types.

Procedure

1. Use a screwdriver as a lever to release the fan holder.

2. Remove the fan.

3. Replace the fan with an identical type fan.

10.10 Product Returns

Danfoss products can be returned for disposal at no charge. A prerequisite for this is that they are free of deposits, such as oil, grease, or

other types of contamination that hampers disposal. Furthermore, foreign materials or third-party components cannot be included with

the returned product.

Ship the products free on board to the local Danfoss sales company.

10.11 Recycling

Take metals and plastics to recycling stations.

The servo drives and system modules are classified as electronic waste, and the packaging is classified as packaging waste.

10.12 Disposal

Devices containing electronic components cannot be disposed of as normal domestic waste.

Dispose of the servo drives and system modules as hazardous waste, electrical waste, recyclable waste, and so on, in accordance with

applicable local regulations.
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11 Specifications

11.1 Product Labels

11.1.1 Product Labels on the ISD 520/DSD 520 Servo Drive

Check the product label and compare it with the order data. Use the part number for reference. The part number uniquely identifies the

drive type.

Ensure that the nameplate is clearly legible.

The servo drives can be identified externally only by the original Danfoss product label.

The following data is shown on the servo drive product label:

S/N: 123401Q123
P/N: 123A1234

Ambient: 5...40°C / 41...104°F

Input1: 565-680VDC 0.30A
Input2: 24-48VDC 0.40A

VLT® ISD® 520

Mnom: 3.3Nm Nnom: 3000rpm
Mmax: 11.3Nm Nmax: 6600rpm

Enclosure: IP67 HW: E0, FS, SO

ISD-520D6-03T5PL

MAC: 00-1B-08-0E-XX

1
2
3
4
5
6

7
8

10 11

12
13
14
15 e3

0b
l1

27
.1

0

9

i = 3.14

1 Supply voltage 2 Auxiliary input voltage

3 Nominal torque 4 Maximum torque

5 Ambient temperature range 6 Protection rating

7 Rated speed 8 Maximum speed

9 With gear unit 10 Hardware configuration

11 With mechanical brake 12 Short model code

13 Part number 14 Serial number

15 MAC address

Figure 107: Example of a Product Label on the ISD 520 Servo Drive

Type 4X Indoor use only
Internal Motor Overload Protection 120%
E171278 Industrial Control Equipment

Danfoss Ltd., 22 Wycombe End, HP9 1NB, GB

VLT® ISD 520

Danfoss A/S 6430 Nordborg, Denmark

e3
0b

l1
28

.1
0

Made in Italy

P/N: 137N1991
S/N: 100100-344

Figure 108: Example of a Tracing and Conformity Label on ISD 520
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S/N: 123401Q123
P/N: 123B1234

Ambient: 5...40°C / 41...104°F

Input1: 565-680VDC 5.0A
Input2: 24-48VDC 0.50A

VLT® DSD 520

Uout: 3x 0-Input1 Inom: 5A
Umax: 3x 0-Input1 Imax: 16A

Enclosure: IP67 HW: E0, FS, SO

DSD-520D6-05A0EC

MAC: 00-1B-08-0E-XX

1
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1 Supply voltage 2 Auxiliary input voltage

3 Output voltage 4 Maximum voltage

5 Ambient temperature range 6 Protection rating

7 Hardware configuration 8 Type code

9 Part number 10 Serial number

11 MAC address

Figure 109: Example of a Product Label on the DSD 520 Servo Drive

VLT® DSD 520

e3
0b

l1
30

.1
0

Made in Italy

Type 4X Indoor use only
Internal Motor Overload Protection 120%
E171278 Industrial Control Equipment

Danfoss Ltd., 22 Wycombe End, HP9 1NB, GB
Danfoss A/S 6430 Nordborg, Denmark

P/N: 137N2183
S/N: 100200-344

Figure 110: Example of a Tracing and Conformity Label on DSD 520

11.1.2 Product Labels on the System Modules

The following data is shown on the product label on the front of PSM 510.

Part no: 175GXXXX
Serial no: 002901Q092

Output: Pnom: 10kW

00:1B:08:33:2C:3D
00:1B:08:33:2C:3E
00:1B:08:33:2C:3F

DANGER
15 MIN

Motor over-temperature sensing is required

Cust. no: 0906279896

VLT® PSM 510

MAC PSM
X1 IN:

X2 OUT:

e3
0b

k0
57

.1
0

Notes:

1
2
3
4

5

6

7

8

1 Part number 2 Serial number

3 Customer part number 4 Output

5 Data matrix 6 Notes

7 MAC addresses 8 Warning

Figure 111: Product Label on the Front of PSM 510

The following data is shown on the product label on the front of DAM 510.
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Part no: 175GXXXX
Serial no: 018301Q052

Output: Inom: 15.0A

00:1B:08:32:E7:02
00:1B:08:32:E7:03
00:1B:08:32:E7:04
00:1B:08:32:E7:05

DANGER
15 MIN

Motor over-temperature sensing is required

Cust. no: 0906280073

e3
0b

k0
56

.1
0

MAC DAM
Notes:

X1 IN:
X2 OUT:
X3 OUT:

VLT® DAM 510
1
2
3
4

5

6

7

8

1 Part number 2 Serial number

3 Customer part number 4 Output

5 Data matrix 6 Notes

7 MAC addresses 8 Warning

Figure 112: Product Label on the Front of DAM 510
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k2
01

.1
1VLT DAM 510

Input1: 565-680VDC 15.0A                                Input2: 24-48VDC 0.5A

Ambient: 5... 40˚C / 41...104˚F

PART NO: 175GXXXX
SERIAL NO: 018301Q052

MAC DAM: 00:1B:08:32:E7:02

175GXXXX018301Q052
Made in Italy

Danfoss A/S 6430 Nordborg, Denmark
Danfoss Ltd. Oxford Road, UB9 4LH Denham, UK

Accept. for field wiring - Min. 75dC, Cu
Internal Overload Protection 105%
E171278 Industrial Control Equipment

Uout

Input1 VDC  Imax: 15.0A
: Input1 VDC    Inom: 15.0A

MSD510DAM510F1C015AD6E20PLL01XXXXXXXXXXX
1

2

4
3

5

6

Umax:

1 Type code 2 Supply voltage

3 Output voltage 4 Maximum power

5 Ambient temperature range 6 UAUX supply

Figure 113: Example Product Label on the Side of the System Modules

192 | Danfoss A/S © 2024.11                                                                                                                                                                     AQ441543733781en-000101 / 130R1298

Operating Guide | VLT Servo Drive System ISD 520/DSD 520                                                                                                                        Specifications



Operating Guide | VLT Servo Drive System ISD 520/DSD 520                                                                                                                        Specifications

11.2 Characteristic Data

11.2.1 Characteristic Data for ISD 520 Servo Drive

11.2.1.1 Common Technical Data for ISD 520 Servo Drives

Table 146: Common Technical Data for ISD 520 Servo Drives

Specification Value/Information

Rated voltage 565–680 V ±10% V DC

UAUX rated voltage 24/48 V ±10% V DC

Protective measure Overload, short-circuit, and ground fault protection

Maximum output frequency 590 Hz

Functional safety STO

Cooling Natural convection

Mounting Via flange

11.2.1.2 Characteristic Data for Drive Sizes 1–2 in Normal Speed Range (2000–3000 RPM)

Table 147: Characteristic Data for ISD 520 Servo Drive Sizes 1–2 in Normal Speed Range

Data Unit Drive size

– – 1 2

Torque
category

Nm 1.5

(+1T5)

2.5

(+2T5)

2.5

(+2T5)

3.5

(+3T5)

4.0

(+4T0)

4.5

(+4T5)

Speed
category

– +FN30 +FN20 +FN30

Flange size mm 70 87 91

Shaft size mm 11 19 14 19

Rated speed
nNOM

RPM 3000 2000 3000

DC-link capaci-
tance

μF 3.6 4.0 3.6

UAUX power
consumption
(at 24 V)

W 8.64 9.60 8.64

UAUX power
consumption
(at 24 V with
brake)

W 19.76 Not applicable 19.76 29.14

UAUX current
consumption
(at 24 V)

A DC 0.36 0.40 0.36

UAUX current
consumption
(at 48 V)

A DC 0.22 0.20 0.22
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Table 147: Characteristic Data for ISD 520 Servo Drive Sizes 1–2 in Normal Speed Range (continued)

Data Unit Drive size

– – 1 2

Torque
category

Nm 1.5

(+1T5)

2.5

(+2T5)

2.5

(+2T5)

3.5

(+3T5)

4.0

(+4T0)

4.5

(+4T5)

Speed
category

– +FN30 +FN20 +FN30

Flange size mm 70 87 91

Shaft size mm 11 19 14 19

UAUX current
consumption
(at 24 V with
brake)

A DC 0.82 Not applicable 0.82 1.21

UAUX current
consumption
(at 48 V with
brake)

A DC 0.46 Not applicable 0.46 0.65

UDC input cur-
rent (at 560 V
DC)

V DC 0.8 0.224 1.6 2.0 2.4 2.8

Drive rated
torque MNOM

Nm 1.65 2.5 3.3 4.1 4.4

Drive rated
current INOM

A DC 1.1 1.7 2.4 2.9 3.2

Drive rated
power PNOM

kW 0.518 0.65 0.8 1.2 1.4 1.5

Drive stall
torque M0

Nm 1.8 2.6 3.5 4.5 5.0

Drive stall cur-
rent I0

A DC 1.2 1.1 1.8 2.5 3.2 3.6

Drive peak
torque MMAX

Nm 6.3 11.0 7.5 11.3 14.3 15.5

Drive peak cur-
rent IMAX

A DC 6.2 6.0 7.6 11.1 12.5

Pole pairs – 4 5
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11.2.1.3 Characteristic Data for Drive Sizes 3–5 in Normal Speed Range (2000–3000 RPM)

Table 148: Characteristic Data for ISD 520 Servo Drive Sizes 3–5 in Normal Speed Range

Data Unit Drive size

– – 3 4 5

Torque category – +5T0 +6T5 +9T0 +12T0 +14T0 +16T5

Speed category – +FN30 +FN22

Flange size mm 100 116 142

Shaft size mm 19 24

Torque category Nm 5.0 6.5 9.0 12.0 14.0 16.5

Rated speed nNOM RPM 3000 2200

DC-link capacitance μF 3.6 13.2

UAUX power consumption
(at 24 V)

W 8.64 9.36

UAUX power consumption
(at 24 V with brake)

W 29.14 29.86 28.62 34.08

UAUX current consump-
tion (at 24 V)

A DC 0.36 0.39

UAUX current consump-
tion (at 48 V)

A DC 0.22 0.23

UAUX current consump-
tion (at 24 V with brake)

A DC 1.21 1.24 1.19 1.42

UAUX current consump-
tion (at 48 V with brake)

A DC 0.65 0.67 0.64 0.76

UDC input current (at
560 V DC)

V DC 3.0 3.7 5.2 6.5 5.9 6.5

Drive rated torque MNOM Nm 5.2 –(1) 8.2 –(1) 13.8 –(1)

Drive rated current INOM A DC 3.3 –(1) 5.2 –(1) 6.6 –(1)

Drive rated power PNOM kW 1.7 –(1) 2.7 –(1) 3.3 –(1)

Drive stall torque M0 Nm 6.4 –(1) 11.2 –(1) 16.0 –(1)

Drive stall current I0 A DC 3.9 –(1) 7.0 –(1) 7.0 –(1)

Drive peak torque MMAX Nm 16.0 –(1) 29.0 –(1) 39.0 –(1)

Drive peak current IMAX A DC 12.5 –(1) 22.0 –(1) 22.0 –(1)

Pole pairs – 5

1) Available on request.
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11.2.1.4 Characteristic Data for Drive Sizes 1–2 in High Speed Range (4500–6000 RPM)

Table 149: Characteristic Data for ISD 520 Servo Drive Sizes 1–2 in High Speed Range

Data Unit Drive size

– – 1 2

Torque category Nm 1.5

(+1T5)

2.0

(+2T0)

2.5

(+2T5)

3.0

(+3T0)

Speed category – +FN60

Flange size mm 70 91

Shaft size mm 11 19 14

Rated speed nNOM RPM 6000

DC-link capacitance μF 3.6

UAUX power consumption (at
24 V)

W 8.64

UAUX power consumption (at 24 V
with brake)

W 19.76

UAUX current consumption (at
24 V)

A DC 0.36

UAUX current consumption (at
48 V)

A DC 0.22

UAUX current consumption (at
24 V with brake)

A DC 0.82 1.21

UAUX current consumption (at
48 V with brake)

A DC 0.46 0.65

UDC input current (at 560 V DC) V DC 1.37 2.5 –(1) –(1)

Drive rated torque MNOM Nm 1.5 2.1 –(1) –(1)

Drive rated current INOM A DC 2.1 2.9 –(1) –(1)

Drive rated power PNOM kW 0.94 1.3 –(1) –(1)

Drive stall torque M0 Nm 1.8 2.6 –(1) –(1)

Drive stall current I0 A DC 2.5 3.6 –(1) –(1)

Drive peak torque MMAX Nm 6.3 7.0 –(1) –(1)

Drive peak current IMAX A DC 12.5 –(1) –(1)

Pole pairs – 5 5 5

1) Available on request.
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11.2.1.5 Characteristic Data for Drive Sizes 3–5 in High Speed Range (4500–6000 RPM)

Table 150: Characteristic Data for ISD 520 Servo Drive Sizes 3–5 in High Speed Range

Data Unit Drive size

– – 3 4 5 4 5

Torque category Nm 3.5

(+3T5)

4.0

(+4T0)

4.5

(+4T5)

5.0

(+5T0)

6.0

(+6T5)

8.0

(+8T0)

8.5

(+8T5)

12.0

(+12T0)

Speed category – +FN60 +FN45

Flange size mm 100 116 142 116 142

Shaft size mm 19 24

Rated speed nNOM RPM 6000 4500

DC-link capacitance μF 13.2

UAUX power con-
sumption (at 24 V)

W 8.64 9.36

UAUX power con-
sumption (at 24 V
with brake)

W 29.14 29.86 28.62 34.08

UAUX current con-
sumption (at 24 V)

A DC 0.36 0.39

UAUX current con-
sumption (at 48 V)

A DC 0.22 0.23

UAUX current con-
sumption (at 24 V
with brake)

A DC 1.21 1.24 1.19 1.42

UAUX current con-
sumption (at 48 V
with brake)

A DC 0.65 0.67 0.64 0.76

UDC input current
(at 560 V DC)

V DC –(1) –(1) –(1) –(1) –(1) –(1) –(1) –(1)

Drive rated torque
MNOM

Nm –(1) –(1) –(1) –(1) –(1) –(1) –(1) –(1)

Drive rated current
INOM

A DC –(1) –(1) –(1) –(1) –(1) –(1) –(1) –(1)

Drive rated power
PNOM

kW –(1) –(1) –(1) –(1) –(1) –(1) –(1) –(1)

Drive stall torque
M0

Nm –(1) –(1) –(1) –(1) –(1) –(1) –(1) –(1)

Drive stall current I0 A DC –(1) –(1) –(1) –(1) –(1) –(1) –(1) –(1)

Drive peak torque
MMAX

Nm –(1) –(1) –(1) –(1) –(1) –(1) –(1) –(1)

Danfoss A/S © 2024.11                                                                                                                                                                     AQ441543733781en-000101 / 130R1298 | 197



Table 150: Characteristic Data for ISD 520 Servo Drive Sizes 3–5 in High Speed Range (continued)

Data Unit Drive size

– – 3 4 5 4 5

Torque category Nm 3.5

(+3T5)

4.0

(+4T0)

4.5

(+4T5)

5.0

(+5T0)

6.0

(+6T5)

8.0

(+8T0)

8.5

(+8T5)

12.0

(+12T0)

Speed category – +FN60 +FN45

Flange size mm 100 116 142 116 142

Shaft size mm 19 24

Drive peak current
IMAX

A DC –(1) –(1) –(1) –(1) –(1) –(1) –(1) –(1)

Pole pairs – 5

1) Available on request.

11.2.1.6 Mechanical Data for ISD 520 Servo Drive Sizes 1–2 in Normal Speed Range (2000–3000 RPM)

Table 151: Mechanical Data for ISD 520 Servo Drive Sizes 1–2 in Normal Speed Range

Data Unit Drive size

– – 1 2

Torque
category

Nm 1.5

(+1T5)

2.5

(+2T5)

2.5

(+2T5)

3.5

(+3T5)

4.0

(+4T0)

4.5

(+4T5)

Speed
category

– +FN30 +FN20 +FN30

Flange size mm 70 87 91

Shaft size mm 11 19 14 19

Rated speed
nNOM

RPM 3000 2000 3000

Brake inertia kgcm2 0.4 Not applicable 0.4 0.7

Brake weight kg 0.35 Not applicable 0.6 1.1

Brake power W 10.8 Not applicable 10.8 19.9

Brake holding
torque

Nm 3.2 Not applicable 3.2 8.0

Flange thick-
ness

mm 9 42.5 11

Bolt circle Ø mm 75 95 100

Mounting hole Ø mm 5.8 6.0 6.5

Centering ring Ø mm 60 j6 80 j6

Shaft length mm 23 40 30 40

Inertia J 10–4 Kgm2 0.63 1.6 0.80 1.10 1.50 1.80

Weight (with-
out brake)

kg 3.9 4.1 3.8 4.5 5.2 5.7
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Table 151: Mechanical Data for ISD 520 Servo Drive Sizes 1–2 in Normal Speed Range (continued)

Data Unit Drive size

– – 1 2

Torque
category

Nm 1.5

(+1T5)

2.5

(+2T5)

2.5

(+2T5)

3.5

(+3T5)

4.0

(+4T0)

4.5

(+4T5)

Speed
category

– +FN30 +FN20 +FN30

Flange size mm 70 87 91

Shaft size mm 11 19 14 19

Key dimen-
sions

mm 4 x 4 x 15 6 x 6 x 32 5 x 5 x 22 6 x 6 x 32

Shaft hole – M4 M6 M5 M6

Axial forces N 17 45 22 24 58 66

Radial forces N 168 450 220 235 580 660

11.2.1.7 Mechanical Data for ISD 520 Servo Drive Sizes 3–5 in Normal Speed Range (2000–3000 RPM)

Table 152: Mechanical Data for ISD 520 Servo Drive Sizes 3–5 in Normal Speed Range

Data Unit Drive size

– – 3 4 5

Torque
category

– +5T0 +6T5 +9T0 +12T0 +14T0 +16T5

Speed
category

– +FN30 +FN22

Flange size mm 100 116 142

Shaft size mm 19 24

Rated speed
nNOM

RPM 3000 2200

Brake inertia kgcm2 0.7 3.6 1.7

Brake weight kg 1.1 1.5 1.4

Brake power W 19.9 18.7 24.0

Brake holding
torque

Nm 8.0 17.0 15.0

Flange thick-
ness

mm 10 12

Bolt circle Ø mm 115 130 165

Mounting hole Ø mm 9.0 12.5

Centering ring Ø mm 95 j6 110 j6 130 j6

Shaft length mm 40 50

Inertia J 10–4 Kgm2 2.6 3.2 5.10 7.3 9.8 12.9
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Table 152: Mechanical Data for ISD 520 Servo Drive Sizes 3–5 in Normal Speed Range (continued)

Data Unit Drive size

– – 3 4 5

Torque
category

– +5T0 +6T5 +9T0 +12T0 +14T0 +16T5

Speed
category

– +FN30 +FN22

Flange size mm 100 116 142

Shaft size mm 19 24

Weight (with-
out brake)

kg 6.6 8.2 9.2 11.1 11.9 13.7

Key dimen-
sions

mm 6 x 6 x 32 8 x 7 x 40

Shaft hole – M6 M8

Axial forces N 58 60 64 68 70 73

Radial forces N 580 600 640 675 695 725

11.2.1.8 Mechanical Data for ISD 520 Servo Drive Sizes 1–2 in High Speed Range (4500–6000 RPM)

Table 153: Mechanical Data for ISD 520 Servo Drive Sizes 1–2 in High Speed Range

Data Unit Drive size

– – 1 2

Torque category Nm 1.5 Nm

(+1T5)

2.0 Nm

(+2T0)

2.5 Nm

(+2T5)

3.0 Nm

(+3T0)

Speed category – +FN60

Flange size mm 70 91

Shaft size mm 11 19 14

Rated speed nNOM RPM 6000

Brake inertia kgcm2 0.4 0.7

Brake weight kg 0.35 0.6 1.1

Brake power W 10.8 19.9

Brake holding
torque

Nm 3.2 8.0

Flange thickness mm 9 11

Bolt circle Ø mm 75 100

Mounting hole Ø mm 5.8 6.5

Centering ring Ø mm 60 j6 80 j6

Shaft length mm 23 30 40

Inertia J 10–4 Kgm2 0.63 0.80 1.10 1.50
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Table 153: Mechanical Data for ISD 520 Servo Drive Sizes 1–2 in High Speed Range (continued)

Data Unit Drive size

– – 1 2

Torque category Nm 1.5 Nm

(+1T5)

2.0 Nm

(+2T0)

2.5 Nm

(+2T5)

3.0 Nm

(+3T0)

Speed category – +FN60

Flange size mm 70 91

Shaft size mm 11 19 14

Weight (without
brake)

kg 3.9 3.8 4.5 5.2

Key dimensions mm 4 x 4 x 15 5 x 5 x 22 6 x 6 x 32

Shaft hole – M4 M5 M6

Axial forces N 17 13 14 31

Radial forces N 168 130 140 310

11.2.1.9 Mechanical Data for ISD 520 Servo Drive Sizes 3–5 in High Speed Range (4500–6000 RPM)

Table 154: Mechanical Data for ISD 520 Servo Drive Sizes 3–5 in High Speed Range

Data Unit Drive size

– – 3 4 5 4 5

Torque
category

Nm 3.5 Nm

(+3T5)

4.0 Nm

(+4T0)

4.5 Nm

(+4T5)

5.0 Nm

(+5T0)

6.0 Nm

(+6T5)

8.0 Nm

(+8T0)

8.5 Nm

(+8T5)

12.0 Nm

(+12T0)

Speed
category

– +FN60 +FN45

Flange size mm 100 116 142 116 142

Shaft size mm 19 24

Rated
speed nNOM

RPM 6000 4500

Brake iner-
tia

kgcm2 0.7 3.6 1.7 3.6 1.7

Brake
weight

kg 1.1 1.5 1.4 1.5 1.4

Brake
power

W 19.9 18.7 24.0 18.7 24.0

Brake hold-
ing torque

Nm 8.0 17.0 15.0 17.0 15.0

Flange
thickness

mm 10 12

Bolt circle Ø mm 100 115 130 165

Mounting
hole

Ø mm 6.5 9.0 12.5
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Table 154: Mechanical Data for ISD 520 Servo Drive Sizes 3–5 in High Speed Range (continued)

Data Unit Drive size

– – 3 4 5 4 5

Torque
category

Nm 3.5 Nm

(+3T5)

4.0 Nm

(+4T0)

4.5 Nm

(+4T5)

5.0 Nm

(+5T0)

6.0 Nm

(+6T5)

8.0 Nm

(+8T0)

8.5 Nm

(+8T5)

12.0 Nm

(+12T0)

Speed
category

– +FN60 +FN45

Flange size mm 100 116 142 116 142

Shaft size mm 19 24

Centering
ring

Ø mm 80 j6 95 j6 110 j6 130 j6

Shaft
length

mm 40 50

Inertia J 10–4 Kgm2 1.8 2.6 3.2 2.8 5.1 7.3 9.8

Weight
(without
brake)

kg 6.4 7.3 8.2 7.3 9.2 10.1 11.1

Key dimen-
sions

mm 6 x 6 x 32 8 x 7 x 40

Shaft hole – M6 M8

Axial forces N 34 40 41 49 51 57 53 59

Radial
forces

N 340 395 410 490 510 565 530 590

11.2.2 Characteristic Data for DSD 520 Servo Drive

Table 155: Characteristic Data for DSD 520

Specifications Unit DSD 520, E1, 5 A

Input

UDC rated voltage V DC 565–680 ±10%

UDC input current (at 560 V DC) A DC 5.0

DC-link capacitance μF 3.6

UAUX rated voltage V DC 24/48 ±10%

UAUX power consumption (at 24 V) W 12.0

UAUX current consumption (at 24 V) A DC 0.5

UAUX current consumption (at 48 V) A DC 0.25

Output

Output number of phases – 3

Output voltage V AC VIN PSM

Drive rated current INOM A rms 4.5
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Table 155: Characteristic Data for DSD 520 (continued)

Specifications Unit DSD 520, E1, 5 A

Drive rated power PNOM kW 2.3

Drive peak current IMAXmax A rms 12.5

Nominal switching frequency fsw kHz 8/10

Possible switching frequency fsw kHz 4/5

Protective measures – Overload, short-circuit, and
ground fault protection.

Maximum output frequency Hz 590

Functional safety – STO (standard)/VLT® FlexSafety™ (optional)

Cooling – Natural convection

Mounting – Screw-mounted via base and side

Number of motor connectors – 1

Weight kg 1.7

Dimensions

(W x H x D)

mm 95.1 x 153.5 x 150

11.2.3 Characteristic Data for Power Supply Module (PSM 510)

Table 156: Characteristic Data for PSM 510

Definition Unit Power size 1 Power size 2 Power size 3

Input

Mains input voltage V AC 400–480 ±10%, 3-phase (see 5.2 Electrical Environmental Conditions)

Input current @ UMIN A 20 34 50

Input power kVA 12.5 22 32

UAUX input voltage V DC 24/48 ±10%

UAUX current consump-
tion at 24 V DC

A DC 2.0

UAUX current consump-
tion at 48 V DC

A DC 1.0

Output

DC-link voltage V DC 565–680 ±10%

DC-link capacitance µF 1800

Rated current IN A 20 40 60

Rated power PN kW 10 20 30

Peak power Pmax t <3.0 s) kW 20 40 60

Internal brake resistor(1)

Peak power Pmax kW 8

Rated power PN W 150
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Table 156: Characteristic Data for PSM 510 (continued)

Definition Unit Power size 1 Power size 2 Power size 3

Nominal resistance Ω 15

External brake resistor

Peak power Pmax kW 60

Rated power PN kW 7.5

Minimum resistance Ω 10

General

Protective measures – Overload, short-circuit, and ground fault protection

Line filter in accordance
with EN 61800-3

– Category C3

Cooling – Integrated fan

Mounting – Wall-mounted on backplate using backlink connector

Weight kg 6

Dimensions (W x H x D) mm 137.3 x 406.3 x 270

1) An external brake resistor can be connected.

11.2.4 Characteristic Data for Decentral Access Module (DAM 510)

Table 157: Characteristic Data for DAM 510

Definition Unit Power size 1 Power size 2

Input

DC link V DC 565–680 ±10%

DC-link capacitance µF 660

Maximum input current A DC 15 25

UAUX V DC 24/48 ±10%

UAUX current consumption at
24 V DC

A DC 0.5

UAUX current consumption at
48 V DC

A DC 0.3

Output

Output voltage V DC VOUT PSM

Output current DC link A DC 15 25

Peak current DC link (rms value)
t <1.0 s

Arms 30 for <1 s 48 for <1 s

Output current UAUX A DC 15

General

Protective measures – Overload, short-circuit, and ground fault protection

Cooling – Natural convection

Mounting – Wall-mounted on backplate using backlink connector

204 | Danfoss A/S © 2024.11                                                                                                                                                                     AQ441543733781en-000101 / 130R1298

Operating Guide | VLT Servo Drive System ISD 520/DSD 520                                                                                                                        Specifications



Operating Guide | VLT Servo Drive System ISD 520/DSD 520                                                                                                                        Specifications

Table 157: Characteristic Data for DAM 510 (continued)

Definition Unit Power size 1 Power size 2

Weight kg 3.05

Dimensions (W x H x D) mm 84.3 x 471 x 270

11.2.5 Characteristic Data for Auxiliary Capacitors Module (ACM 510)

Table 158: Characteristic Data for ACM 510

Definition Unit Value

DC link V DC 565–680 ±10%

DC-link capacitance µF 2750

UAUX V DC 24/48 ±10%

UAUX current consumption at 24 V DC A DC 0.5

UAUX current consumption at 48 V DC A DC 0.3

Cooling – Natural convection

Mounting – Wall-mounted on backplate using backlink
connector

Weight kg 3.54

Dimensions (W x H x D) mm 84 x 371 x 270

11.2.6 Characteristic Data for Expansion Module (EXM 510)

Table 159: Characteristic Data for Expansion Module (EXM 510)

Definition Unit Value

DC link V DC 565–680 ±10%

Maximum current A DC 62

Mounting – Wall-mounted on backplate using backlink
connector

Weight kg 0.6

Dimensions (W x H x D) mm 87 x 380 x 145

11.3 Dimensions

11.3.1 Dimensions of ISD 520 Servo Drive

All dimensions are in mm [in].
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Figure 114: Dimensions of ISD 520, Size 1, E0

Ø 75
[2.95]

Ø 60 j6
 [2.36]

   
70

[2
.7

6]   1
47

[5
.7

9]

Ø
 5

.8
 (x

4)
   

[0
.2

3]

 70.8
[2.79]

 92.7
[3.65]  2.5

[0.10]

 290.7
[11.44]

  141
[5.55]

   23
[0.91]

  4
7.

9
[1

.8
9]

Ø
 1

1 
j6

 [0
.4

3]

  9
9.

1
[3

.9
0]

e3
0b

l1
23

.1
0

Figure 115: Dimensions of ISD 520, Size 1, E1
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Figure 117: Dimensions of ISD 520, Size 3
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Figure 118: Dimensions of ISD 520, Size 4
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Figure 119: Dimensions of ISD 520, Size 5
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11.3.2 Dimensions of DSD 520 Servo Drive

All dimensions are in mm [in].
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Figure 120: Dimensions of DSD 520
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11.3.3 Dimensions of Power Supply Module (PSM 510)

All dimensions are in mm [in].
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Figure 121: Dimensions of PSM 510
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11.3.4 Dimensions of Decentral Access Module (DAM 510)

All dimensions are in mm [in].
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Figure 122: Dimensions of DAM 510
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11.3.5 Dimensions of Auxiliary Capacitors Module (ACM 510)

All dimensions are in mm [in].
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Figure 123: Dimensions of ACM 510
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11.3.6 Dimensions of Expansion Module (EXM 510)

All dimensions are in mm [in].

87.3
[3.43]

144.75
[5.70]50

[1.97]

16

[0.62]

21.3

[0.84]

36
7

[1
4.

44
]

38
0

[1
4.

96
]

25
[0.98]

25
[0.98]

Ø5.2
[0.2]

Ø5.2
[0.2]

6
[0

.2
4]

7
[0

.2
7]

e3
0b

i3
30

.1
0

Figure 124: Dimensions of EXM 510

11.4 Motor Overload Protection

  NOTICE

l Internal motor overload protection operates at 120% of the motor full load current.

l Instruct DSD 520 with nominal motor current (full load current according to the motor technical label) to use the protection

properly.

ISD 520/DSD 520 servo drives incorporate internal overload protection in the following multiples of current setting:

Table 160: Multiples of Current Setting

Multiple of current setting Maximum trip time

7.2 20 seconds

1.5 8 minutes

1.2 2 hours

11.5 Motor Overtemperature Protection

The internal motor overload protection implemented does not have thermal memory retention or speed sensitivity.

  NOTICE

l A temperature sensor is integrated in ISD 520.

l Internal motor overtemperature protection is not incorporated in DSD 520, so motor overtemperature sensing is required.

DSD 520 has an input for motor temperature sensor.
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11.6 Allowed Forces on the ISD 520 Servo Drive Shaft
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Figure 125: Allowed Forces

The maximum axial and radial load, while assembling the motor and for any mechanical device connected to the shaft, must not exceed

the values specified (see 11.2.1 Characteristic Data for ISD 520 Servo Drive ). The shaft must be loaded slowly and in a constant manner:

Avoid pulsating loads.

  NOTICE

l The bearing could be permanently damaged if the maximum allowed forces are exceeded.

l Avoid axial loads on the motor shaft. Axial loading significantly shortens the life of the motor.

11.7 Connectors on the ISD 520/DSD 520 Servo Drives

11.7.1 X1 and X2 Hybrid Connectors

The hybrid cable provides the supply (mains and auxiliary), the communication lines, and the safety supply for each line of servo drives.

Input and output connectors are connected inside the servo drive.
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Figure 126: Pin Assignment of X1 Male Hybrid Connector (M23)
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Figure 127: Pin Assignment of X2 Female Hybrid Connector (M23)

Danfoss A/S © 2024.11                                                                                                                                                                     AQ441543733781en-000101 / 130R1298 | 213



Table 161: Pin Assignment of X1 and X2 Hybrid Connectors (M23)

Pin Description Notes Rating/parameter

A UDC– Negative DC supply Operating voltage: 565–
680 V DC, maximum 778 V

Negative DC supply (maximum
–15 A/25 A)

B UDC+ Positive DC supply Operating voltage: 565–
680 V DC, maximum 778 V

Positive DC supply (maximum
15 A/25 A)

C AUX+ Auxiliary supply

D AUX– Auxiliary supply ground

24–48 V DC ±10%, 15 A

Absolute maximum 55 V DC

PE PE PE connector 15 A

2 STO+ Safety supply

3 STO– Safety supply ground

24 V DC ±10%, 1 A

5 TD+ Positive Ethernet transmit

6 RD– Positive Ethernet receive

7 TD– Negative Ethernet transmit

8 RD+ Negative Ethernet receive

According to standard
100BASE-T

11.7.2 X3: I/O Connector for Channel A (M12, 8 pole)

The X3 connector is available on the ISD 520/DSD 520 servo drives. It is equipped with a Safe I/O option and can be configured as:

l Digital output

l Digital input
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Figure 128: X3 I/O Connector for Channel A
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Table 162: Pin Assignment of X3 Safe I/O Connector for Channel A

Pin Description Notes Rating/parameter

1 IN 1A Input 1, channel A

2 GND 1 GND for input 1

3 IN 1B Input 1, channel B

4 24 V 24 V output

5 GND GND

6 OUT 1A Output 1, channel A

7 OUT 1B Output 1, channel B

8 GND GND

See 11.10 Safe Digital Inputs
and Outputs.

Table 163: Pin Assignment of X3 Standard I/O Connector for Channel A

Pin Description Notes Rating/parameter

1 DO 1 Switched 24 V as digital output
or supply (24 V/150 mA)

Nominal voltage: 24 V ±15%

Maximum current: 150 mA

Maximum switching frequency:
100 Hz

2 GND Ground –

3 AI 1 Analog input 1 (voltage) Nominal voltage: 0–24 V

Bandwidth: ≤25 kHz

4 CLK– External encoder negative clock
signal

Protocol: BiSS, SSI

5 DATA+ External encoder positive data
signal

Protocol: BiSS, SSI

6 CLK+ External encoder positive clock
signal

Protocol: BiSS, SSI

7 AI 2 Analog input 2 (current) Nominal voltage: 0–20 V

Bandwidth: ≤25 kHz

8 DATA– External encoder negative data
signal

Protocol: BiSS, SSI

11.7.3 X4: I/O Connector for Channel B (M12, 8 pole)

The X4 connector is available on the ISD 520/DSD 520 servo drives. It is equipped with a Safe I/O option and can be configured as:

l Digital output

l Digital input
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Figure 129: X4 I/O Connector for Channel B

Table 164: Pin Assignment of X4 Safe I/O Connector for Channel B

Pin Description Notes Rating/parameter

1 IN 2 A Input 2, Channel A

2 GND2 GND for input 1

3 IN 2 B Input 2, Channel B

4 24 V 24 V output

5 GND GND

6 OUT 2 A Output 2, Channel A

7 OUT 2 B Output 2, Channel B

8 GND GND

See 11.10 Safe Digital Inputs
and Outputs.

Table 165: Pin Assignment of X4 Standard I/O Connector for Channel B

Pin Description Notes Rating/parameter

1 DO 2 Switched 24 V as digital output
or supply (24 V/150 mA)

Nominal voltage: 24 V ±15%

Maximum current: 150 mA

Maximum switching frequency:
100 Hz

2 GND Ground –

3 DI 1 Digital input 1 Nominal voltage: 0–24 V

Bandwidth: ≤100 kHz

4 TD– Negative Ethernet transmit According to standard
100BASE-T

5 RD+ Positive Ethernet receive According to standard
100BASE-T

6 TD+ Positive Ethernet transmit According to standard
100BASE-T

7 DI 2 Digital input 2 Nominal voltage: 0–24 V

Bandwidth: ≤100 kHz

8 RD– Negative Ethernet transmit According to standard
100BASE-T

11.7.4 X5: LCP Connector (M8, 6 pole)

The X5 connector is used to connect the LCP directly to the ISD 520/DSD 520 servo drives via a cable.
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Figure 130: Pin Assignment of X5 LCP Connector (M8, 6 Pole)

Table 166: Pin Assignment of X5 LCP Connector

Pin Description Notes Rating/parameter

1 Not connected – –

2 /LCP RST Reset Active at ≤0.5 V

3 LCP RS485 Positive RS485 signal

4 /LCP RS485 Negative RS485 signal

Speed:

38.4 kBd

The levels fulfill the RS485 spec-
ification.

5 GND GND –

6 VCC 5 V supply for LCP 5 V ±10% at 120 mA maximum
load

11.8 Connectors on the DSD 520 Servo Drives

11.8.1 Digital Motor Feedback Connector

Table 167: Pin Assignment for Digital Motor Feedback Connector

Pin Description Rating/parameter

VCC Encoder supply +5 V/+11 V(1)

GND Ground –

DATA+ Encoder positive data signal –

DATA– Encoder negative data signal –

CLK+ Encoder positive clock signal –

CLK– Encoder negative clock signal –

1) The supply switches automatically between 5 V and 11 V depending on which feedback type is selected.

The conductor cross-section range is 0.2–1.5 mm2, solid or flexible (AWG 24–AWG 16).

  NOTICE

l Only PELV potential can be connected to the digital motor feedback connector.
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11.8.2 Analog Motor Feedback Connector

Table 168: Pin Assignment for Analog Motor Feedback Connector

Pin Description Rating/parameter

EX+ Resolver positive exciter output –

EX– Resolver negative exciter output –

SIN+ Resolver positive sine input –

SIN– Resolver negative sine input –

COS+ Resolver positive cosine input –

COS– Resolver negative cosine input –

The conductor cross-section range is 0.2–1.5 mm2, solid or flexible (AWG 24–AWG 16).

  NOTICE

l Only PELV potential can be connected to the analog motor feedback connector.

11.8.3 Thermistor, Mechanical Brake, and HIPERFACE® DSL Connector

Table 169: Pin Assignment for Thermistor, Mechanical Brake, and HIPERFACE® DSL Connector

Pin Description Notes Rating/parameter

DSL+ HIPERFACE® DSL positive line – –

DSL– HIPERFACE® DSL negative line – –

TEMP+ Temperature sensor, positive in-
put

TEMP– Temperature sensor, negative
input

Used to connect the motor's
temperature sensor (if present).

KTY83–110

KTY84–130

PT1000

BRK+ Mechanical brake, positive

BRK– Mechanical brake, negative

Used to connect the motor's
mechanical brake (if present).

Nominal voltage: 24 V

Maximum (peak) voltage:
48 V ±10%

Maximum brake current: 2.5 A

The conductor cross-section range is 0.2–1.5 mm2, solid or flexible (AWG 24–AWG 16).

  NOTICE

l Only PELV potential can be connected to the thermistor, mechanical brake, and HIPERFACE® DSL connector.

11.8.4 Motor Phase Connector

Table 170: Pin Assignment for Motor Phase Connector

Pin Description Rating/parameter

U Motor phase U

V Motor phase V

W Motor phase W

Nominal voltage: 400–480 V ±10% (see
11.2.2 Characteristic Data for DSD 520
Servo Drive)
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The conductor cross-section range is 0.2–4 mm2, solid or flexible (AWG 24–AWG 12).

11.8.4.1 Cable Cross-sections for the Motor Phases

Table 171: Cable Cross-sections for the Motor Phases

Description Value

Minimum cable cross-section for CE (minimum 70 °C, Cu) 1.5 mm2

Minimum cable cross-section for UL (minimum 60 °C, Cu) 14 AWG

11.9 Connectors on the System Modules

11.9.1 Backlink Connector

The backlink connector is at the top of the backside of all the system modules.
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Figure 131: Pin Assignment of Backlink Connector

Table 172: Pin Assignment of Backlink Connector

Pin Description

1 24/48 V

2 GND

3 FE: Functional earth

4 DC–

5 DC+
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11.9.2 Brake Connectors

There are brake connectors on the Power Supply Module (PSM 510).

11.9.2.1 Brake Resistor Connector on PSM 510
e3

0b
g4

50
.1

0

Figure 132: Brake Connector on PSM 510

Table 173: Pin Assignment of Brake Connector on PSM 510

Pins (left to right) Pins (left to right) Notes Ratings

1 DC+/R+

2 R–

Used for connecting a brake re-
sistor.

Nominal voltage: 565–800 V DC

Maximum brake current: 80 A

Conductor cross-section range:
0.75–16 mm2 (AWG 18–AWG 4)

  NOTICE

l The maximum length of the brake cable is 30 m (shielded).

11.9.3 Ethernet Connectors

There are Ethernet connectors on all the system modules.
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Figure 133: Ethernet Connector

  NOTICE

l Only PELV potential can be connected to the digital inputs and outputs.
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11.9.3.1 Ethernet Connectors on PSM 510 and ACM 510

Table 174: Ethernet Connectors on PSM 510 and ACM 510

Connector name Description Pins Ratings

X1 IN Ethernet IN

X2 OUT Ethernet OUT1

1: TX+

2: TX–

3: RX+

4: –

5: –

6: RX–

7: –

8: –

According to standard
100BASE-T.

11.9.3.2 Ethernet Connectors on DAM 510

Table 175: Ethernet Connectors on DAM 510

Connector name Description Pins Ratings

X1 IN Ethernet IN

X2 OUT Ethernet OUT1 (connection to
hybrid cable)

X3 OUT Ethernet OUT2

1: TX+

2: TX–

3: RX+

4: –

5: –

6: RX–

7: –

8: –

According to standard
100BASE-T.

11.9.4 I/O Connectors

11.9.4.1 I/O Connector on PSM 510/ACM 510
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Figure 134: I/O Connector on PSM 510 (I/O PSM) and ACM 510 (I/O ACM)
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Table 176: Pin Assignment of I/O Connector on PSM 510/ACM 510

Pins Description Notes Rating/parameter

1 DIN1–

2 DIN1+

Digital input Galvanic isolated

Input voltage: 0–30 V DC

High (logic "1") voltage: 15–
30 V DC

Low (logic "0") voltage: <5 V DC

Maximum input signal fre-
quency: 50 Hz

Maximum input current at 48 V:
11 mA

Maximum input resistance:
4.5 KΩ

3 DIG_OUT–

4 DIG_OUT+

Digital output Galvanic isolated

Maximum voltage between ter-
minals: 24 V DC or AC

Maximum current: 1 A

Maximum output switching fre-
quency: 50 Hz

The conductor cross-section range is 0.2–1.5 mm2 (AWG 24–AWG 16).

  NOTICE

l Only PELV potential can be connected to the digital inputs and outputs.

11.9.5 UAUX Connector

The UAUX connector is on the Power Supply Module (PSM 510).
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Figure 135: UAUX Connector
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Table 177: Pin Assignment of UAUX Connector

Pins

(left to right)

Description Notes Rating/parameter

1 24 V AUX

2 GND

Used for 24–48 V DC input
to the Power Supply Module
(PSM 510).

Nominal input voltage:
24 V/48 V DC ±10%

Maximum current: 50 A

Maximum cross-section:
16 mm2

Maximum cable length: 3 m

Conductor cross-section range
0.75–16 mm2, solid or flexible
(AWG 18–AWG 4)

  NOTICE

l Only PELV potential can be connected to the UAUX input.

  CAUTION

POSSIBLE LOSS OF FUNCTIONAL SAFETY PROTECTION

The functional safety feature may be affected if the UAUX input exceeds 60 V.

l Ensure that the UAUX input remains below 60 V.

11.9.5.1 24/48 V Cable Cross-sections for PSM 510

Table 178: 24/48 V Cable Cross-sections for PSM 510

Description Value

Minimum cable cross-section for CE (minimum 70 °C, Cu) 16 mm2

Minimum cable cross-section for UL (minimum 60 °C, Cu) 4 AWG

11.9.6 LCP Connector (M8, 6 Pole)

There is an LCP connector on the front of all the system modules. It is used to connect the LCP directly via a cable.
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Figure 136: LCP Connector (M8, 6 Pole)
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Table 179: Pin Assignment of LCP Connector

Pins Description Notes Rating/parameter

1 Not connected – –

2 /LCP RST Reset Active at ≤0.5 V

3 LCP RS485 Positive RS485 signal

4 /LCP RS485 Negative RS485 signal

Speed:

38.4 kBd

The levels fulfill the RS485 spec-
ification.

5 GND GND –

6 VCC 5 V supply for LCP 5 V ±10% at 120 mA maximum
load

  NOTICE

l Only PELV potential can be connected to the LCP input.

11.9.7 AC Mains Connector

The AC mains connector is on the bottom of the Power Supply Module (PSM 510).
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Figure 137: AC Mains Connector

Table 180: Pin Assignment of AC Mains Connector

Pins

(left to right)

Description Notes Rating/parameter

1 L3

2 L2

3 L1

Used to connect L1/L2/L3 Nominal voltage: 400–
480 V AC ±10%

Nominal power: 30 kW

Maximum cross-section:
16 mm2 (AWG 4)

Conductor cross-section range
0.75–16 mm2, solid or flexible
(AWG 18–AWG 4)
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11.9.7.1 Mains Cable Cross-sections for PSM 510

Table 181: Mains Cable Cross-sections for PSM 510 

PSM 510 (10 kW) PSM 510 (20 kW) PSM 510 (30 kW)

Minimum cable cross-section
for CE

4 mm2

(minimum 70 °C, Cu)

16 mm2

(minimum 70 °C, Cu)

16 mm2

(minimum 90 °C, Cu)

Minimum cable cross-section
for UL

AWG 10

(minimum 60 °C, Cu)

AWG 6

(minimum 60 °C, Cu)

AWG 4

(minimum 75 °C, Cu)

11.9.8 Relay Connector

  NOTICE

l Only PELV potential can be connected to the relay outputs.

11.9.8.1 Relay Connector on PSM 510/ACM 510

11 12 13
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Figure 138: Relay Connector on PSM 510/ACM 510

Table 182: Pin Assignment of Relay Connector on PSM 510 (REL PSM) and ACM 510 (REL ACM)

Pins Description Notes Rating/parameter

11 NC Normally closed, 24 V DC

12 NO Normally open, 24 V DC

13 COM Common

Nominal current: 2 A

Conductor cross-section range:
0.2–1.5 mm2 (AWG 24–AWG 16)

11.9.9 STO Connectors

11.9.9.1 STO Connectors on PSM 510

There is 1 input and 1 output STO connector on the Power Supply Module (PSM 510).
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Figure 139: STO Output Connector on PSM 510
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Figure 140: STO Input Connector on PSM 510

Table 183: Pin Assignment of STO Connectors on PSM 510

Connector name Pins Description Notes Rating/parameter

1 STO–

2 STO+

Used for STO output volt-
age to the input of the
other system modules.

3 STO–

STO PSM

4 STO+

Used for STO input volt-
age.

Nominal voltage:
24 V DC ±10%

Nominal current: De-
pends on the number of
servo drives in the appli-
cation.

Maximum current: 1 A

Conductor cross-sec-
tion range: 0.2–1.5 mm2

(AWG 24–AWG 16)

  NOTICE

l Only PELV potential can be connected to the STO inputs.
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11.9.9.2 STO Connectors on DAM 510

11.9.9.2.1 STO Connectors on the Top of DAM 510

There is 1 input and 1 output STO connector on the top of the Decentral Access Module (DAM 510).
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Figure 141: STO Output Connector on the Top of DAM 510
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Figure 142: STO Input Connector on the Top of DAM 510

Table 184: Pin Assignment of STO Connectors on the Top of DAM 510

Connector name Pins Description Notes Rating/parameter

1 STO–

2 STO+

Used for STO output volt-
age to the input of the
other system modules.

3 STO–

STO DAM

4 STO+

Used for STO input volt-
age.

Nominal voltage:
24 V DC ±10%

Nominal current: De-
pends on the number of
servo drives in the appli-
cation.

Maximum current: 1 A

Conductor cross-sec-
tion range: 0.2–1.5 mm2

(AWG 24–AWG 16)
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  NOTICE

l Only PELV potential can be connected to the STO inputs.

11.9.9.2.2 STO Connector on the Bottom of DAM 510

There is 1 output STO connector on the bottom of the Decentral Access Module (DAM 510). The output is for the hybrid cable.
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Figure 143: STO Connector on the Bottom of DAM 510

Table 185: Pin Assignment of STO Connector on the Bottom of DAM 510

Connector name Pins

(left to right)

Description Notes Rating/parameter

1 STO+STO DAM

2 STO–

Used for the STO output
from the DAM to the hy-
brid cable.

Nominal voltage:
24 V DC ±10%

Nominal current: De-
pends on the number of
servo drives in the appli-
cation.

Maximum current: 1 A

Conductor cross-sec-
tion range: 0.2–1.5 mm2

(AWG 24–AWG 16)

Plug terminal tighten-
ing torque: 0.22–0.25 Nm
(1.95–2.21 in-lb)

11.9.10 UDC Connector

The UDC connector is on the bottom of the Decentral Access Module (DAM 510).
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Figure 144: UDC Connector
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Table 186: Pin Assignment of UDC Connector

Pins

(left to right)

Description Notes Rating/parameter

1 UDC+

2 UDC–

Used to connect the DC-link
voltage from the Decentral ac-
cess Module (DAM 510) to the
hybrid cable for the ISD line.

Nominal voltage: 565–800 V DC

Nominal current: Depends on
the number of servo drives in
the application.

Maximum current: 25 A

Conductor cross-section range:
0.2–6 mm2 (AWG 24–AWG 10)

Plug terminal tightening
torque: 0.5–0.8 Nm (4.43–
7.08 in-lb)

11.9.11 AUX Connector

The AUX connector is on the bottom of the Decentral Access Module (DAM 510).
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Figure 145: AUX Connector

Table 187: Pin Assignment of AUX Connector

Pins

(left to right)

Description Notes Rating/parameter

1 AUX+ (24/48 V)

2 AUX– (GND)

Used to connect the AUX out-
put from the Decentral access
Module (DAM 510) to the hy-
brid cable for the line of drives.

Nominal voltage:
24/48 V DC ±10%

Nominal current: Depends on
the number of servo drives in
the application.

Maximum current: 15 A

Conductor cross-section range:
0.2–2.5 mm2 (AWG 24–AWG 12)

Plug terminal tightening
torque: 0.5–0.6 Nm (4.43–
5.31 in-lb)

  NOTICE

l Only PELV potential can be connected to the AUX output.
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11.9.12 External Encoder Connectors

This connector is used to connect an external encoder to DAM 510. It provides a guide value for CAM mode and Gear mode. The external

encoder connector is located on the Decentral Access Module (DAM 510) as follows:

l DAM 510: E DAM

5 1
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Figure 146: External Encoder Connector

Table 188: External Encoder Connectors

Connector name Description Pins Ratings/Notes

E DAM Used to connect the external
encoder to DAM 510.

See Table 189. Nominal voltage: 24 V DC, iso-
lated (see Table 189)

Nominal current: Depends on
the number of servo drives in
the application.

Maximum current: 150 mA (see
Table 189)

Fulfill the following specifica-
tions:

• BISS/SSI

Table 189: Pin Assignment of External Encoder Connectors (X1/X2)

Pins Description Notes

SSI/BiSS

Notes

1 24 V 24 V DC ±10% (used for power-
ing the encoder)

Maximum current: 150 mA

2 – – –

3 – – –

4 RS422 RXD Positive data

5 RS422 TXD Positive data

Bus speed:

SSI: Up to 10 Mhz clock fre-
quency with 30 m cable.

BiSS: Fulfills the RS485 specifica-
tion.

6 GX Isolated ground.

If encoders are powered exter-
nally, the ground of the exter-
nal supply must be connected
to GX.

–

7 – – –
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Table 189: Pin Assignment of External Encoder Connectors (X1/X2) (continued)

Pins Description Notes

SSI/BiSS

Notes

8 /RS422 RXD Negative data

9 /RS422 TXD Negative data

Bus speed:

SSI: 0.5 Mbit with 25 m cable.

BiSS: Fulfills the RS485 specifica-
tion.

  NOTICE

l Only PELV potential can be connected to the external encoder.

11.9.13 Expansion Module Connector
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Figure 147: Expansion Module Connector

Table 190: Pin Assignment of Expansion Module Connector

Pins

(left to right)

Description Note Rating/parameter

1

2

DC+

3

4

DC–

Shield the DC cables using the
cable tie on the EXM 510 EMC
plate.

5 FE (functional earth) –

6 GND –

7 24/48 V –

Nominal voltage: 565–800 V DC

Nominal current: Depends on
the number of servo drives in
the application.

Maximum current: 62 A(1)

Conductor cross-section range:
0.75–16 mm2, solid or flexible
(AWG 18–AWG 4)

Only use with ferrule without
plastic sleeve with CRIMPFOX
16 S.

Use shielded conductors for
UDC (DC+, DC–).

Plug terminal tightening
torque: 1.7–1.8 Nm (15.05–
15.93 in-lb)

1) The maximum current rating for 1 pair of EXM is 62 A. In systems with 2 PSM 510 modules, 2 pairs of EXM 510 modules can be used to achieve a maximum current rating of 124 A.
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11.9.13.1 Cable Cross-sections for EXM 510

Table 191: Minimum Cable Cross-sections for EXM 510 Cables

Cable CE UL

DC+/DC– 16 mm2 (minimum 70 °C, Cu) 6 AWG (minimum 75 °C, Cu)

24 V, functional PE 16 mm2 (minimum 70 °C, Cu) 6 AWG (minimum 90 °C, Cu)(1)

1) Minimum 75 °C is allowed if less than 45 A is measured on the cable.

11.10 Safe Digital Inputs and Outputs

These safe digital inputs and outputs apply to connectors X3 and X4 when using the Safe I/O option.

Table 192: Digital Input Characteristics Supported by the Safe I/O Board

Type Value

Number of safe digital inputs 4 (2 x dual channel)

Nominal input voltage range 0–24 V DC

Input voltage range, logic 0 0–5 V DC

Input voltage range, logic 1 >10 V DC

Input voltage maximum 30 V

Maximum input current at low level 5 mA

Minimum input current at high level 1.5 mA

Maximum input current at high level 15 mA

Typical input current at high level (24 V) 3.5 mA

Galvanic isolation Yes

Minimum recognition test pulse time 300 µs

Discrepancy time Configurable 1–200 ms

Filter time Configurable 2–60 ms

Cable length Maximum 30 m (shielded)

Table 193: Digital Output Characteristics Supported by the Safe I/O Board

Characteristic Value

Number of safe digital outputs 4 (2 x dual channel)(1)

Nominal output voltage high 24 V DC ±15%

Nominal output voltage low <5 V DC

Maximum output current at low level 100 µA

Maximum output current at high level 100 mA

Galvanic isolation No

Short circuit protected Yes

Diagnostic test pulse time 1 ms

Danfoss A/S © 2024.11                                                                                                                                                                     AQ441543733781en-000101 / 130R1298 | 233



Table 193: Digital Output Characteristics Supported by the Safe I/O Board (continued)

Characteristic Value

Diagnostic test pulse frequency 1 Hz

Cable length Maximum 30 m (shielded)

1) The time and frequency of the diagnostic test pulses are not configurable.

11.11 General Specifications and Environmental Data

11.11.1 ISD 520/DSD 520 Servo Drive

Table 194: General Specifications and Environmental Conditions for ISD 520/DSD 520

Specification Value

Protection ratings IP65/IP67 according to EN 60529

Type 4X indoor use only

See 11.12.1 Protection Ratings for ISD 520 Servo Drive and 11.12.2
Protection Ratings for DSD 520 Servo Drive.

Vibration test Class 3M7 according to IEC 60721-3-3

Storage/transport: 5–95% (non-condensing)Maximum relative humidity

Stationary use: 5–95% (non-condensing)

Operating: 5–40 °C

Transport: –25 to +55 °C

Ambient temperature

Storage: –25 to +55 °C

Installation altitude Nominal current up to 1000 m above sea level.

Derating of output current (1%/100 m) at 1000–3000 m.

Operation above 3000 m is not allowed.

EMC standard for emission and immunity EN 61800-3 (second environment)

EMC immunity functional safety EN 61800-5-2 Annex E

Pollution degree 2

Overvoltage category III
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11.11.2 System Modules

Table 195: General Specifications and Environmental Conditions for System Modules

Specification Value

Protection rating IP20 according to IEC/EN 60529 (except connectors, which are
IP00).

  WARNING

RISK OF ELECTRIC SHOCK

The IP20 rating of the PSM 510, DAM 510, and ACM 510

modules is not fulfilled if the modules are not connected to

the backplate. This may result in death or serious injury.

l Do not touch the backplate when a module is

removed from the backplate.

Random vibration: 1.14 g (2h/axis according to EN 60068-2-64)Vibration test

Sinusoidal vibration: 1.0 g (2h/axis according to EN 60068-2-6)

Storage/transport: 5–95% (non-condensing)Maximum relative humidity

Stationary use: 5–93% (non-condensing)

Operating: 5–40 °C nominal, up to 55 °C with derating (see Figure
148)

Transport: –25 to +55 °C

Ambient temperature range

Storage: –25 to +55 °C

Installation altitude Nominal current up to 1000 m above sea level.

Derating of output current (1% / 100 m at 1000–3000 m).

Operation above 3000 m is not allowed.

EMC standard for emission and immunity EN 61800-3 (second environment)

EMC immunity for functional safety EN 61800-5-2 Annex E

Degree of pollution according to EN 60664-1 2

Overvoltage category according to EN/IEC 61800-5-1 III
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Figure 148: Derating

11.12 Protection Ratings

11.12.1 Protection Ratings for ISD 520 Servo Drive
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Figure 149: Mounting Positions for ISD 520

Table 196: Protection ratings for ISD 520 Servo Drive

Mounting position of servo drive
(according to DIN 42 950)

Protection rating (according to EN 60529)

Housing (excluding shaft) All positions IP67

IM B5 & IM V1 IP65Shaft with shaft seal

IM V3 IP65

  NOTICE

l Install and connect the ISD 520 servo drives as described in this guide to achieve the ratings detailed in Table 196 in the final

application.

11.12.2 Protection Ratings for DSD 520 Servo Drive

All DSD 520 variants have a protection rating of IP67.

  NOTICE

l Install and connect the DSD 520 servo drives as described in this guide to achieve the IP67 rating in the final application.

11.13 Cables

  NOTICE

l See the VLT® Servo Drive System ISD 520, DSD 520, MSD 520 (VLT® FlexMotion™) Design Guide for cable dimensions and drawings.

11.13.1 Hybrid Cable PE

Table 197: Hybrid Cable PE

Item Description Cross-section

Hybrid cable PE Used to connect the PE wire from the hy-
brid cable to the PE screw on the Decentral
Access Module (DAM 510).

Maximum cross-section:

2.5 mm2/4.0 mm2

11.14 Storage

Store the servo system components in a dry, dust-free location with low vibration (veff ≤0.2 mm/s).

The storage location must be free from corrosive gases.

Avoid sudden temperature changes.
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Long-term storage

To recondition the electrolytic capacitors, servo drives and system components that are not in service must be connected to a supply

source once per year to allow the capacitors to charge and discharge. Otherwise the capacitors could suffer permanent damage.
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